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ANNOTATION 

 This educational and methodical complex corresponds to the curriculum of the course 

of the same name. The educational and methodological complex contains a syllabus, the 

structure and thematic plan of the module, as well as the texts of lectures and tasks for 

practical classes. It also provides a technological map and model of each lesson, as well as 

test questions intended for the intermediate and final survey. 

The educational and methodical complex has developed an innovative training 

technology for each lecture and practical lesson. 

This educational and methodical complex is intended for students of medical 

Universities of the 1st year of the direction of dentistry, as well as for undergraduates.  



Structure of the electronic module on the subject "Information technologies in medicine" for 

the 2021-2022 academic year: 

1.The SYLLABUS

Name and address 

of the University 

Bukhara state medical Institute Prospect Navoiy, 1 

Department 
Department of Biophysics and information 

technologies in medicine‖ 

As part of the faculty of Media 

pedagogy and MVC‖ 

Industry and areas 

of study 

910000-

health Care 

50910100-dentistry 

The teacher leading 

the subject: 

Ashurov Zhasur 

Dzhuraevich 

e-mail: 

djxp@mail.ru 

umail. uz  

clever007@umail.uz 

Time and place of 

classes 

Biological 

building 1st floor 

Course duration 2 semesters 

Working hours on 

an individual 

schedule 

Tuesday and Thursday from 14.00 to 17.0 

Number of hours on 

the subject 
Classroom hours 

Seminar 
Independent 

education 36 
Lecture 16 Practice 

Laboratory 

40 

16 

Prerequisites Computer science, biophysics, medical engineering and medical biology. 

Post-requirements All clinical subjects 

The content of the subject 

Relevance and summary of the 

subject 

This course is designed to teach first-

year students the basics of computer science 

and information technology, programming 

elements, as well as computer technologies 

for solving medical problems, both scientific 

and practical. Bachelors who have mastered 

the knowledge and skills of modern 

information technologies should be able to 

process, analyze, and also be able to 

correctly and efficiently provide a solution 

to the problem, possess the ability to use the 

Internet. 

 Graduates of medical universities 

should be ready to conduct comprehensive 

examinations of organs and systems of the 

human body using medical equipment with 

built-in computers (which is characterized 

by modern equipment of medical and 

preventive institutions), interpret the results 

of the examination, develop conclusions and 

recommendations for the prevention and 

treatment of various diseases, as well as 

formalize medical and biological data and 

procedures. 

The purpose of the module is to introduce modern 

technologies in the educational process for training 

specialists who can correctly use information technologies 

in solving problems of modern medicine, as well as for 

conducting medical and scientific practical activities at a 

high-quality level. 

Module tasks:  

-Teach students based on theoretical data step by step to 

master the initial practical skills;  

-Apply modern pedagogical technologies in the 

educational process, based on theoretical knowledge and 

practical skills, master theoretical and practical knowledge 

for the use of computer technologies in the field of 

medicine; 

- Master up-to-date theoretical knowledge of physical and 

mathematical models used in medicine; 

- Correctly analyze medical statistics and determine 

preventive measures, as well as methods of treatment of 

patients based on the results of the analysis; 

– Master the basic practical skills of using information

technologies; 

- Work on the Internet, search and use information; 

- Properties of medical information systems, creating a 

database; 

- Expert systems and fundamentals of information 

security, formation of scientific worldview. 



Requirements for 

students 

- respect for the teacher and fellow students; 

-    compliance with internal rules of conduct  BukhMI; 

-    turning off cell phones during classes; 

- Timely and high-quality completion of homework and independent work; 

-Must be present at classes, in cases of missing classes, must master the topic of 

the missed class;  

-    be prepared in advance and active to participate in the classroom; 

-    the student is not allowed to take classes after the teacher calls; 

-    if the student is not satisfied with the inserted rating score, then within one day 

they can apply to the appeal Commission within one day 

Order of 

communication via 

E-mail 

The teacher and student can also be contacted via email. In any case, you can't 

discuss your grades over the phone.the assessment is only conducted during 

classes in classrooms located on the territory of the Institute. Email viewing time 

is from 15.00 to 20.00. 

2. The structure of the module.

2.1. Load the module and forms of educational work 

2.1. Lecture notes 

№ Topics of lectures Number 

of hours 

Competence code 

1-semester 

1 Fundamentals of information technology. Concept of 

information. 

2 

2 Computer hardware and software. 2 

3 Main stages of solving problems on a computer. 2 

4 Text editors and working in them. Spreadsheet. 

Computer graphics programs. 

2 

5 Elements of mathematical statistics. 2 

6 Information storage, sorting and retrieval technology. 2 

7 Computer networks and working in them. Electronic 

document circulation. Information security. 

2 

8 Software focused on creating Web sites. 2 

Итого: 16 

2.2.  Organization of practical and laboratory classes 

№ Topics of practical and laboratory 

classes 

Number of hours Code of competencies 

Theory. Practice 

1-semester 

1 PC software. Stages of solving problems 

on the computer. 

2 2 

2 Creating programs based on linear and 

branching algorithms. 

2 2 

Semester Total 

load 

quantity 

Lecture 

(hours) 

Practical 

lesson 

(hours) 

Laboratory 

activity 

(hours) 

student's 

independent 

work 

(hours) 

Type 

and 

form of 

control 

Credit 

(volume) 

I 54 16 14 6 18 2 

II 54 26 10 18 exam 1 

Subtotal: 108 16 40 16 36 3 



3 Creating programs based on cyclic and 

generalized algorithms. 

2 2 

4 Practical skills in creating and working 

on text documents. 

2 2 

5 Using the extensive features of the MS 

Word text editor. Formatting text 

paragraphs. 

2 

6 Creating and formatting tables in the 

Word text editor. 

2 

7 Digital data processing technology. 

Extensive features of the MS Excel table 

editor. 

2 

8 working with text, formula, chart, and 

hypertext in the MS Excel spreadsheet 

editor. 

2 

9 Processing of biomedical data in MS 

Excel. 

2 

10 MS Power Point software and its 

capabilities. Ways to create presentations 

and pre-defined requirements. 

2 

A total of 1 semester: 8 40 

2nd semester 

11 Definition of elements of statistics in 

biomedical tasks. 

2 2 

12 It will teach you how to evaluate results 

with a normal distribution. 

2 

13 Determination and estimation of the 

correlation coefficient. 

2 

14 Determination and estimation of the 

regression coefficient. 

2 

15 Ways to create databases in MS Access. 2 2 

16 Registration of users on the Internet. 

Working with email. 

2 2 

17 Working with email. Sending and 

receiving information in the form of 

applications. 

2 

18 Teach you how to apply the basics of 

electronic medical history. 

2 

19 Basics of creating images and installing 

animations in Photoshop. 

2 

20 Software focused on the development of 

Web sites. 

2 2 

Total 2-semester: 8 20 

Total: 16 40 

3. Main and additional literature

3.1. Main literature 

1. Bazarbayev va  boshqalar. Тibbiyotda axborot texnologiyalari. Darslik. Toshkent. 2018 y.

2. Safarova T.S.. Informatika va axborot texnologiyalari. Darslik. Toshkent. 2006 y.

3. Кобринский Б.А., Зарубина Т.В. Медицинская информатика.Учебник. Москва. 2016 г.

4. Тишков А.В. и другие. Информационные технологии в медицине. Учебное пособие. Ташкент.

2020 г.

3.2. Additional literature 



1. Мирзиѐев Ш.М. Танқидий таҳлил, қатъий тартиб интизом ва шахсий жавобгарлик- ҳар бир

раҳбар фаолиятининг кундалик қоидаси бўлиши керак. 2017 й, 104 бет, Ўзбекистон матбуот

ва ахборот агентлигининг ―О‘zbekiston‖ нашриѐт матбаа ижодий уйи.

2. Мирзиѐев Ш.М. Буюк келажагимизнинг мард ва олижаноб халқимиз билан бирга қурамиз.

2017 й, 488 бет, Ўзбекистон матбуот ва ахборот агентлигининг ―О‘zbekiston‖ нашриѐт матбаа

ижодий уйи.

3. Мирзиѐев Ш.М. Эркин ва фаровон, демократик Ўзбекистон давлатини биргаликда барпо

этамиз. 2016 й, 56 бет, Ўзбекистон матбуот ва ахборот агентлигининг ―О‘zbekiston‖ нашриѐт

матбаа ижодий уйи.

4. Косимов С.С. Компютер олами. Тошкент. 2001 й.

5. Закирова Ф. Информатика и информационные технологии. Учебное пособие. Ташкент. 2007

й.

6. Арипов М.М. Информатика, информацион технологиялар. Ўқув қўлланма. Тошкент. 2004й

7. Нурматова Ф.Б., Касимов М.М., Абдуганиева Ш.Х., Фазилова Л.А. Тиббиѐтда ахборот

технологиялари фанидан масалалар тўплами. Тошкент. 2018 й.

8. Абдуганиева Ш.Х., Касимов М.М. MS Excel электрон жадвали дастурида ишлаш бўйича ўқув

услубий қўлланма. Тошкент. 2016 й.

9. Холматов Т.Х. Информатика и информационные технологии. Учебное пособие. Ташкент.

2003 г.

10. Sattorov А. Ma‘lumotlar bazasini boshqarish sistemasi. T.:Fan va texnologiya, 2006 й.

11. Холматов Т.Х ва бошқалар. Информатика Олий ўқув юртлари учун дарслик. Тошкент. 2003 й.

12. Сафаров Т.С. Тажрибавий маълумотларни қайта ишлаш усуллари. Самарқанд, Сам ДУ. 2001

й.

13. Омельченко В.П., Демидова А.А. Медицинская информатика. Учебник. 2-е изд., Москва. 2018

г.

14. Edward H. Shortliffe, James J. Cimino Editors Biomedical Informatics. New York. Springer. 2014 y.

15. Louise M.Abbey, John L. Zimmerman Editors. Dental Informatics. 

New York. Springer 2012 y.

16. M.Harris, J.Teylor. Madical Statistics made easy. MD MartinDunitz,   United  Kingdom, 2003 y.

17. Jennifer Peat, Belinda Barton. Medical Statistics fa Guide to Data Analysis and Critical Appraisal.

Blackwell Publishing BMJ Books, 2005 у.

3.3. Internet sites: 

1. http://www.tsdi.uz

2. http://www.tpmi.uz

3. http://www.ziyonet.uz

4. http://www.referat.uz

http://www.tsdi.uz/
http://www.tpmi.uz/
http://www.ziyonet.uz/
http://www.referat.uz/


1 - Topic fundamentals of information technology. Concept of information. 
1.1. Model of technology training 

Session of duration-2 hours        Number of students: 30-60 

Form of studies 

Plan of the lecture 

1-Safety And hygiene 

standards when working on a 

computer.  

1.General information about

information technologies. 

        For students whose activities are significantly different from any 

professional activity, it is necessary to know the best ways to work on a 

computer, as well as safety rules and sanitary and hygienic standards 

related to the use of a computer. It also discusses general information 

about information technologies and the basic concepts associated with 

them.  

The aim of the lesson: Familiarize students with the safety rules and sanitary standards when 

working on a computer to protect them from harmful and dangerous 

effects of computer technology. Provide information about modern 

information technologies. 

Teaching method Demonstration: lecture and interview 

Type of training Collective 

Means of training Tutorials, textbooks, lecture text, projector, computer 

The learning environment Methodically equipped audience. 

Monitoring and evaluation Oral survey 

1.2. Technological map of the lecture 

Stages of work and 

allotted time 

Stages of conducting a lesson by a teacher 

Preparatory stage. 

(5 min) 

1. Prepare a training component of the topic.

2. Prepares presentation slides for the topic.

3. Make a list of literature used for the development of

the subject. 

1. Introduction to

the topic 

(5 min) 

Will introduce you to the purpose and task of the topic. Listen 

2. Main stage

(55 min) 

1. Explains the topic and demonstrates the presentation.

2. Applies the posters

. 

Listen 

recording 

3. he final stage (10

min) 

Makes a final conclusion Listen 

4. Self-study tasks

(5 min) 

Declares tasks for independent work.  Records 

1. Safety and hygiene standards when working on a computer.
A computer is one of the most impressive examples of collecting, processing, storing, distributing 

and displaying information in order to reduce the complexity of processes, use information resources, and 

increase their reliability and efficiency. 

When working with various household appliances, it is necessary to comply with certain 

requirements called safety precautions. Similarly, it is necessary to comply with the safety requirements 

when working on a computer. 

Only specially trained personnel who are fit for health reasons and qualified to perform these works 

are allowed to operate the electrical equipment independently. 

Before admission to work, students must pass an introductory and initial safety briefing with a 

demonstration of safe and rational methods of work.  

Personnel operating computer equipment and peripheral equipment may be exposed to dangerous 

and harmful effects, which by their nature are divided into the following groups:: 



Before starting work, make sure that the electrical wiring, switches, and sockets that connect the 

equipment to the network are working properly, that the computer is grounded, and that it is working 

properly,  

Safety requirements during operation 

To reduce or prevent the influence of dangerous and harmful factors, it is necessary to comply with 

safety requirements, as well as sanitary rules and regulations, hygiene requirements for video display 

terminals, personal electronic computers, and work organization¦  

When using computer equipment and peripheral equipment, each employee must carefully and 

carefully handle electrical wiring, devices and devices and always remember that disregard for safety rules 

threatens both human health and life. 

To avoid electric shock, you must know and follow the following rules for the safe use of electricity: 

1. To avoid damage to the insulation of the wires and the occurrence of short circuits, it is not

allowed: 

а)   hang something on the wires; 

b) paint over and whitewash cords and wires;

d) lay wires and cords for gas and water pipes, for heating system batteries;

c) pull the plug out of the socket by the cord, force must be applied to the plug body.

2. To avoid electric shock, it is forbidden to:

а)   frequently turn your computer on and off without needing to; 

b) touch the screen and the back of the computer blocks;

d) work on computer equipment and peripherals with wet hands;

c) work on computer equipment and peripheral equipment that has violations of the integrity of the

case, violations of wire insulation, faulty power-on indication, with signs of electrical voltage on the case; 

f) put foreign objects on computer equipment and peripheral equipment.

g) clean electrical equipment from dust and contamination when energized.

3. It is forbidden to check the operability of electrical equipment in rooms that are unsuitable for

operation with conductive floors, damp, and do not allow the available metal parts to be grounded. It is 

unacceptable to repair computer equipment and trophy equipment under voltage. 

Repair of electrical equipment is performed only by technicians in compliance with the necessary 

technical requirements.  

All computer equipment and peripherals must be de-energized after the operation is complete. In the 

case of a continuous production process, only the necessary equipment must be left on. 

Safety requirements in emergency situations 

If a fault is detected, immediately disconnect the electrical equipment and notify the administration. 

You can continue working only after the problem has been resolved. 

if a broken wire is found, it is also necessary to immediately inform the administration about it, take 

measures to exclude people from contact with it. touching the wire is life-threatening. 

To avoid electric shock, when using electrical appliances, do not touch any pipelines, heating 

batteries, or metal structures connected to the ground at the same time. 

Special care should be taken when using electric power in damp areas. 

In all cases of electric shock, call a doctor immediately. Before the arrival of the doctor, you need to 

start providing first aid to the victim without wasting time. 

Artificial respiration is performed on an electrocuted person until the arrival of a doctor. 

Fire safety requirements 



It is forbidden to have flammable substances in the workplace 

It is forbidden to enter the premises: 

a) light a fire;

b) turn on electrical equipment if the room smells of gas;

C) Smoking;

e) close ventilation holes in electrical equipment

Sources of ignition are: 

a) spark when static electricity is discharged

b) sparks from electrical equipment

C) sparks from impact and friction

d) open flame

If a fire hazard or fire occurs, the personnel must immediately take the necessary measures to 

eliminate it, and at the same time notify the administration of the fire. 

Health standards and rules when working on computers 

Failure to comply with safety requirements when working at a computer also leads to the fact that 

after a while you start to experience some discomfort: headaches, pain in the eyes, back pain and in the 

joints of the hands. You get tired and irritable. Sleep may be disrupted, vision may deteriorate, and your 

hands, head, neck, and lower back may ache. 

All harms that occur when working on a computer can be divided into three groups: 

1) Parameters of working places and the working area.

2) Visual factors (brightness, contrast, image flicker, glare).

3) Radiation (x-ray, RF and microwave electromagnetic radiation, gamma radiation, electrostatic

fields). 

The working conditions of computer workers are characterized by the possibility of exposure to the 

following production factors: increased electric and electro-magnetic fields, static electricity, increased noise 

level of the system unit, low contrast of the monitor, insufficient illumination of the working area, release of 

toxic substances into the air, parameters of technological equipment and workplace. 

Often these problems are related toс: 

insufficient space and volume of the workplace; 

- non-compliance with the temperature and humidity conditions in the room; 

- low level of illumination in the room and on the working surfaces of the equipment; 

- increased level of low-frequency magnetic fields from monitors; 

- arbitrary placement of equipment and violation of the requirements of the organization of workplaces; 

- non-compliance with the requirements for work and rest regimes; 



- excessive production load of employees; 

- lack of skills to reduce the impact of psychoemotional stress. 

PCs are sources of broadband electromagnetic radiation: 

 roentgen;

 ultraviolet UV 200-400 nm;

 the visible of 400-750 nm;

 near-IR 750-2000 nm;

 radio frequency range 3kHz;

 electrostatic field.

As a precautionary measure, it is recommended to limit the duration of working with the screen, do 

not place them concentrated in the work area, and turn them off if they are not working.  

To work on a computer, we recommend rooms with one-way side, natural light with North, North-

East or North-West orientation of light openings. Artificial lighting in rooms and workplaces should create 

good visibility of information on the computer screen. At the same time, the field of view of employees 

should be provided with optimal 

Since the main load falls on the eyes when working on a computer, so there are great demands on 

screens. A flat screen is preferred, which allows you to avoid the presence of bright spots on it by reflecting 

light streams. The screen color is especially important. It should be neutral. Unsaturated light green, yellow-

green, yellow-orange, yellow-brown tones are acceptable.  

The display keyboard should not be hard-wired to the monitor. It should be located at a distance of 

600-700 mm. The keyboard must provide for the possibility of audio feedback from the inclusion of keys 

with the ability to adjust. The size of the keys - within 13-15 mm, the resistance-0.25-1.5 N. the surface of 

the keys must be concave, the distance between them-at least 3 mm. The slope of the keyboard should be in 

the range of 10-15o. The keyboard is located on the table surface at a distance of 100-300 mm from the 

edge.  

When working with text information (in the mode of data entry, text editing, and reading from the 

VDT screen), it is most physiological to present black characters on a light background.  

When the distance from the eyes to the screen is 600-700 mm, the height of the sign must be at least 

3-4 mm, the distance between the signs-15-20; from its height. The number of dots per line is at least 640. 

The mode of operation with the computer should be as follows: after every hour of intensive work, it 

is necessary to arrange a 10-15-minute break, with less intensive work every 2 hours.  

2. General information about information technologies.
Any management information processes include procedures for registering, collecting, transmitting, 

storing, processing, issuing information and making management decisions. Information technologies are the 

means and methods by which these procedures are implemented in various information systems. 

The history of information technology development can be divided into several stages. The first stage 

is a manual technology for collecting and processing information, which prevailed until the second half of 

the XIX century. The main tools at that time were pen, ink and simple counting machines, and the means of 

communication were presented in the form of courier and postal services. At the end of the XIX century, the 

stage of mechanical technology began. This time includes the creation of a typewriter, a telephone, which 

significantly changed the technology of information processing and the organizational structure of 

enterprises. The appearance of electronic typewriters, copiers, and dictaphones in the 40s and 60s of the XX 

century is associated with the stage of electronic technology. Mass production of electronic computers in the 

60s and their wide penetration into all spheres of activity are the beginning of a new computer information 

technology. This technology has been particularly successful since the 70s, when personal electronic 

computers were created. 

According to the degree of automation, we can distinguish manual, automated and automatic 

information technologies. Historically, the first were the so-called manual information technologies, in 

which all procedures for collecting, processing and transmitting information were carried out manually. 

However, the current level of business development imposes fundamentally new requirements for 

information services, including ensuring the speed of information transfer, its relevance, reliability and 



timeliness of providing to the end user. The emergence of new technologies for organizing information 

processes is primarily associated with the use of computer technologies. Information technologies used in 

the field of process control can be implemented in the form of fully automatic information systems. In this 

case, all the procedures for registering, collecting, transmitting, and processing information are automated, 

as well as the development of control actions that control the technical system. Such automatic information 

technologies are usually used in production  

In organizational management systems, automated information technologies are most common, in 

which the development of control influence is assigned to a person — a decision-maker (LPR). These 

systems include almost all information systems used in the field of social and cultural services and tourism. 

Modern information systems consist of several types of supporting subsystems, which include: 

technical, software, information, organizational, legal and ergonomic support. 

Technical support is a set of technical means that ensure the functioning of an information system. 

It includes personal computers, peripheral equipment (printers, scanners, plotters, etc.), means of 

communication and communication (modems, network cards, etc.), as well as office equipment (copiers, 

faxes, etc.). it is advisable to include office equipment in the technical support of the information system, 

since they are organically integrated into the system of collecting, transmitting and processing information 

and are an integral attribute of a modern office. In addition, a single device performs the functions of a 

printer, copier, or Fax. The choice of the necessary composition of technical means should be determined 

primarily by the functional tasks of the information system and the corresponding subject area. 

Software is a set of programs and documentation for them that implement the main functions of an 

information system. The software market designed for implementing tasks in the field of social and cultural 

services and tourism is quite extensive. The need to develop your own software arises only when solving 

unique tasks. 

Information support is a set of information base of the subject area and means and methods of its 

processing. Creating an information base in the field of social and cultural services and tourism is one of the 

most difficult problems. First of all, there are issues of designing the information base, which are the 

determining condition for the successful operation of the entire system in the future. Filling the information 

base with specific data is an equally time consuming task. 

Organizational support is a set of methods and rules for organizing work with an information 

system, as well as a description of job descriptions for users of the information system. In complex 

information systems, this type of software plays a very important role, since it determines the order of 

operation of the information system. Failure to follow the rules for using the information system and failure 

to follow job descriptions may lead to an inadequate database and, as a result, to making incorrect 

management decisions. 

Legal support includes a set of legal norms and rights of users of the information system. This 

subsystem restricts access to data for various categories of users, usually by organizing password access. In 

addition, currently one of the most important issues is the problem of protecting information from 

unauthorized access. 

Ergonomic support involves the development of recommendations and standards for the correct 

organization of the system user's workplace, including the correct location of computers in the room, 

compliance with the required level of illumination, setting standards for the user's work at the computer, and 

so on. 

Modern technical means of implementing information technologies include: personal computers; 

local and global computer networks; communication tools; telephone equipment; video information systems, 

etc. Modern information systems usually involve the integration of various software products. The 

information system includes tools for documentation support of management, information support of subject 

areas, in particular socio-cultural services and tourism, communication software, tools for organizing 

collective work of employees, and other auxiliary technological products. The introduction of information 

technologies involves not only the automation of basic information business processes, but sometimes their 

significant changes. This is due to the improvement of document flow in the system, and increasing the 

reliability and efficiency of providing information allows you to spend more time analyzing it, rather than 

routine processing. 

The introduction of modern information technologies must meet a number of requirements, including 

the availability of a convenient and friendly interface, security through various methods of control and 



differentiation of access to information resources, support for distributed information processing, the use of 

client-server architecture, the modular principle of building systems, support for Internet technologies, etc.. 

The "Problem" Method. Students are divided into subgroups. Teams are given or shown a specific 

situational problem. Team members will have to identify the problem, find out the reasons for its 

occurrence, and they will also have to find ways to solve this problem. 

Control question 

1. Why is it necessary to observe safety measures?

2. what are the harmful factors and impacts that the user is exposed to when working on a computer?

3. List the electrical safety requirements?

4. what prohibitions allow you to prevent and avoid fire situations?

5.for what purposes are sanitary and hygienic standards developed when working on a computer.

6. the Maximum duration of work on the computer?

7. What distance should be between the eye and the monitor?

8. What is technology?

9. what types of information technologies are divided according to the degree of automation?

10. Some of the subsystems consist of modern information technology?

References: 

(O: 3,4; D: 1, 2, 3, 8, 11, 12, 15, 16; IC: 2, 3) 

2-Theme computer Software. Operating system. 

1.1. The model of technology training 

Session duration-2 hours        Number of students: 30-60 

Form of studies Informational lecture 

Plan of the lecture 

1- Operating system. 

2- basic concepts of 

Windows: desktop, 

window types and options, 

menus, taskbar, icons 

The operating system is a program that loads when the computer is 

turned on, a "translator" from the program language to the language of 

machine codes. It makes a dialog with the user, manages various 

computer devices, its resources (RAM, disk space, etc.) such programs 

are called drivers, that is, "drivers" that control, and runs other 

(application) programs for execution. The operating system provides the 

user and application programs with a convenient way to communicate 

(interface) with computer devices.e 

The aim of the lesson: To acquaint students with information about operating systems and 

ways of working, the elements of the interface. 

Teaching method Demonstration: lecture and interview 

Type of training Collective 

Means of education Study guides, textbooks, lecture text, projector, computer 

Conditions of education Methodically equipped auditorium. 

Мониторинг и оценки Устный опрос 

1.2. Lecture flow chart 

Work stages and 

allotted time 

Stages of a lesson by a teacher Learners 

Preparatory stage. 

(5 minutes) 

1. Prepare an educational component of the topic.

2. Prepares presentation slides for the topic.

3. Make a list of literature used to master the subject.

1. Introduction to

the topic 

(5 minutes) 

Introduces the purpose and purpose of the topic. Listen 



2. The main stage

(55 minutes)

1.Explains the topic and demonstrates the presentation.

2. Applies posters.

Listen 

Write down 

3.The final stage

(10 min) 

Make a final conclusion. Listen 

4.Self-study

assignments (5 min) 

Announces tasks for independent work. Writes down 

1. Operating system
An operating system is a program that is loaded when the computer is turned on, a "translator" from 

a programming language into a machine code language. It carries out a dialogue with the user, manages 

various computer devices, its resources (RAM, disk space, etc.), such programs are called drivers, that is, 

"drivers" managing, launches other (application) programs for execution. The operating system provides the 

user and application programs with a convenient way to communicate (interface) with computer devices. 

The main reason for the need for an operating system is that elementary operations for working with 

computer devices and managing computer resources are very low-level operations, therefore the actions that 

the user and application programs need consist of several hundred or thousands of such elementary 

operations.. 

For example, a magnetic disk drive "understands" only such elementary operations as turning on / off 

the drive motor, installing the reading heads on a specific cylinder, selecting a specific reading head, reading 

information from a disk track into a computer, etc. And even to perform such a simple action as copying a 

file from one floppy disk to another (a file is a named set of information on a disk or other machine 

medium), it is necessary to perform thousands of operations to run drive commands, check their execution, 

search and process information in file allocation tables, etc. The task gets even more complicated by 

following them: 

• • there are about a dozen diskette formats, and the operating system should be able to work with all 

of these formats. For the user 'work with floppy disks of different formats should be carried out 

exactly the same; 

• • a file on floppy disks occupies certain areas, and the user does not need to know anything about 

which ones. All functions for maintaining file allocation tables, searching for information in them, 

allocating space for files on floppy disks are performed by the operating system, and the user may 

not know anything about them; 

•while the copying program is running, several dozen different special situations can occur, for

example, a failure to read or write information, the drives are not ready to read or write, there is no space on 

the floppy disk for the copied file, etc. All these situations need to provide appropriate messages and 

corrective actions. 

The operating system hides these complex and unnecessary details from the user and provides him with 

a convenient interface to work with. It also performs various auxiliary operations, such as copying or 

printing files. The operating system loads all programs into the RAM, transfers control to them at the 

beginning of their work, performs various actions at the request of the programs being executed, and 

releases the RAM occupied by the programs when they finish. 

Operating systems are divided into single-tasking and multitasking. Single-tasking operating systems 

can perform no more than one task at the same time, and multitasking operating systems (Windows 98 / ME 

/ 2000 / XP) are capable of simultaneously managing several processes, sharing the power of the computer 

between them. In principle, the number of tasks that the OS can perform is not limited by anything other 

than processor power and RAM capacity.. 

The operating system can be single-user (designed to serve one client) and multi-user (designed to work 

with a group of users at the same time). An example of the first is the same Windows 98 / ME, and the 

second is Windows 2000 / XP / Vista / 7/8. 

Bit OS. 16-bit operating systems (DOS, Windows 3.1, Windows 3.11) are a thing of the past with the 

advent of 32-bit Windows 2000 / XP. And modern operating systems like Windows / Vista / 7/8 are 64-bit 

OS.  



Under the name Windows XP, a whole line of operating systems was revealed to the world: the 

"corporate" OS Windows XP Server and Windows XP Professional and the "home" Windows XP Home. 

And most importantly, in addition to the usual 32-bit version of Windows, Microsoft has prepared a 64-bit 

modification for installation on servers equipped with the new 64-bit Itanium processor. Also these days 

various new versions of Windows Vista, Windows 7, Windows 8, Windows 10 are widely distributed..  

1. MS – DOS       -   1980 year 

2. WINDOWS 3.0  -   1990 year 

3. WINDOWS 95       -   1995 year 

4. WINDOWS 98       -      1998 year 

5. WINDOWS ME\2000    -     2000 year

6. WINDOWS XP        -     2001 year 

7. WINDOWS VISTA  -     2006 year 

8. WINDOWS SEVEN (7)  -     2009 year

9. WINDOWS 8         -     2012 year 

10. WINDOWS 10         -     2015 year 
Windows XP is the first Microsoft operating system with a fully customizable interface! Now users can 

radically change the appearance of their OS with the help of removable skins that have replaced simple 

screen "themes" since Windows 95. Thanks to the new "themes", you can not only change the picture on the 

Desktop, the font of the signatures icons and the appearance of the mouse cursor - the appearance of folders, 

service panels and drop-down menus does not remain aside. The advantages and disadvantages of this 

technology can be observed already today on the example of Windows Media Player, built into Windows 

ME. 

Microsoft's second "gift" to the home user was the "smart" Start menu. When you click on this button, 

Windows XP offers you a menu of only those programs that you often use, for the rest you will have to click 

on the "More Programs" button. 

Finally, the Control Panel has been radically redesigned - from now on, all icons are neatly arranged 

into groups. 

One of the innovations is support for writing CD-R and CD-RW discs at the level of the OS itself. 

For operating systems based on the Windows NT / 2000 and XP kernel, the initial set was given: the file 

system of these operating systems, first of all, had to be reliable. That is why, for these operating systems, 

not FAT32 has become the standard, but the new NTFS (NT Fail System) file system, which allows you to 

create "dynamic" hard disks on your computer that combine several pops. With such a file system, novice 

users will not be able to spoil Windows, delete installation files, delete the necessary files! 

2. Basic Windows concepts: desktop, types and options for displaying windows,

menus, taskbar, icons. 
The Windows XP interface is a graphical "shell" of Windows, with the help of which we, users, 

communicate with the operating system. What we see on the screen. The interface is a mediator, a translator 

whose task is to transform all internal "control levers" of Windows into a graphical form that people can 

understand. 

In this topic, we will get acquainted with the main components of the Windows interface: with the 

Desktop and its elements - icons, folders, shortcuts, with which we will learn how to perform a wide variety 

of operations with the Start menu, where all programs are hidden, -on your computer with the Taskbar, 

where you will find buttons for all programs currently running on your computer, with the Toolbar, where 

buttons for quick access to the most popular programs will settle, with the Notification area, which will 

allow you to work with programs residing in the memory of your computer 

The Active Desktop contains icons (shortcuts, icons) that correspond to an application, document (data 

file) or folder. The My Computer folder gives you access to all drives and other devices on your computer. 

You can ―throw away‖ unneeded files in the Recycle Bin folder. The Network Neighborhood icon provides 

access to networked computers and printers. 

Operating system Windows 10. Let's start with the fact that the inconvenient panel with tiles, which 

opened by default in Windows 8, was removed, and the popularly beloved "Start" took its rightful place. 

Here they combined what we are used to in Windows 7 with what we liked in Windows 8. The menu was 

12. WINDOWS 11      -   2021 year



divided into two parts: on the left - the shortest path to the settings and to the explorer, as well as the 

programs that you use most often; on the right - whatever you deem necessary to add here. There is a set of 

applications that are needed more often than others. They are simply pinned to the Start menu. You can 

move them, resize them, turn Live Tiles on or off, and arrange them into groups. 

The second important point is the browser. The icon with the letter ―E‖ means now not Explorer, but 

Edge. 

Files and directories. Information on magnetic disks is stored in files. A file is a named area on a disk or 

other machine medium. 

Files can store program texts, documents ready for program execution, etc. Each file on disk has a 

designation that consists of two parts: a name and an extension (often the name and extension are also called 

the name together). The file name can contain up to 255 characters. The extension starts with a dot, followed 

by 1 through 4. For example, AUTOEXEC.BAT, desktop.ini, Computer Science Lectures.docx, etc. 

The name and extension can consist of uppercase and lowercase 26 Latin letters, 33 Russian letters, 

numbers from 0 to 9, and symbols `. , '; - + = ~ _! @ # $% ^ & () {} [] 

The following characters cannot be used in the filename \ | /: *? ―<>. In file name and extension, 

uppercase and lowercase letters are equivalent because Windows translates all lowercase letters to 

corresponding uppercase letters. 

The filename extension is optional, but it usually describes the content of the file, so using the extension 

is very convenient. Many programs set the file name extension and by it you can find out which program 

created the file. 

Some file types: 

.com 

Ready-to-run programs 
.txt 

Text Document .exe .log 

.sys System files .doc 

.docx 

MS Word Document 

.hlp Reference Information .xls 

.xlsx 

MS Excel workbook 

.dll Supplier library .mdb MS Access database 

.avi Movie video files .ppt 

.pptx 

MS Power Point presentation 

.dat .inf Installation information 

.wav Winamp Player File .htm Web page 

.rar Archived files .bmp 

Bitmap .zip .gif 

File attributes. 

Hidden - files with these attributes are not visible to the user. For reinsurance - as a rule, these files are 

very important for the functioning of the system. 

Read-Only - but these files are always open to the curious eye ... But that's all. You cannot change their 

content - at least not without a special user command. 

System (System) This attribute, as a special distinction, marks the most important files in the operating 

system that are responsible for booting the computer. Their damage or removal always entails the most 

serious consequences - therefore, a generous computer, without stint, "rewards" them at the same time with 

the two previous attributes. 

Archive. This attribute is usually set when working with a file, when it changes. At the end of the 

session, he is usually removed. 

Folders (directories) File names are recorded on magnetic disks in directories (or directories). A 

directory is a special place on the disk that stores file names, information about the size of files, when they 

were last updated, attributes (properties) of files, etc. If the name of a file is stored in a directory, then this 

file is said to be in this directory. Each magnetic disk can contain several directories. Each directory can 

have many files, but each file is always registered in only one directory. 



Subdirectories and superdirectories. All directories (except for Khorium, see below) are actually special 

files. Each directory has a name and can be registered in another directory. If directory X is registered in 

directory Y, then X is said to be a subdirectory of Y and Y is a superdirectory or parent directory of X. 

Directory names. The requirements for directory names are the same as for file names. Generally, the 

name extension is not used for directories. 

Root directory. Each magnetic disk has one main or root directory. It registers files and subdirectories 

(1st level directories). The 1st level directories register files and 2nd level directories, etc. It turns out a 

hierarchical tree-like structure of catalogs on a magnetic disk. 

Mind Map method. Students are divided into subgroups. A topic is announced and each team is 

given a separate concept related to that topic. Each team will need to describe this concept in a diagram and 

one or more team members will need to explain their diagram to the auditor.. 

 Control question 

1. What is the operating system?

2. What is the difference between a single-task and multi-task operating system?

3. What is the difference between a single-user and multi-user operating system?

4. what versions of the Windows GUI do you know?

5. what is the interface?

6. what is the Difference between Windows XP and previous versions?

7. what is the Difference between Windows 10 and previous versions?

8. List the main elements of the Windows XP operating system?

9. What is a file?

10. What attributes can have the files?

11. What is a directory?

12. What are the requirements necessary to file names and directories in Windows operating system?

Lитература: 
(O: 3,4; D: 1, 2, 3, 8, 11, 12, 15, 16; IC: 2, 3) 

3-Topic: the Main stages of solving problems on the computer. Basics of algorithmization. 

1.1. The model of technology training 

Session duration-2 hours        Number of students: 30-60 

Form of studies Informational lecture 

Plan of the lecture 

1-the Main stages of solving 

problems on the computer. 

2-The concept of the 

algorithm. 

3 - properties of the 

algorithms. 

4-linear structure Algorithms 

5-branching structure 

Algorithms. 

6-cyclic structure Algorithms. 

Solving a problem on a computer is the process of automatically 

converting source data into the desired result in accordance with a given 

algorithm. One of the stages of solving problems on a computer is to 

create algorithms. 

Algorithm — a clear and precise instruction to the performer (human or 

automaton) to perform a sequence of actions aimed at achieving the 

specified goal or solving the task. 

Linear (sequential) algorithm-description of actions that are performed 

once in a given order. 

The aim of the lesson: Give information about the concept of the algorithm. Introduce students 

to the properties and main methods of describing algorithms. 

Teaching method Demonstration: lecture and interview 

Type of training Collective 

Means of training Tutorials, textbooks, lecture text, projector, computer 

The learning environment Methodically equipped audience. 

Methodically equipped 

audience 

Oral survey, task reviewers. 



1.2. Routing lectures 

Stages of work and 

allotted time 

Stages of conducting a lesson by a teacher Studying 

Preparatory stage. 

(5 min) 

1. Prepare a training program that includes the following

topics. 

2. Prepares presentation slides for the topic.

3. Make a list of literature used for mastering the subject

. 

1. Introduction to

the topic 

(5 min) 

Will introduce you to the purpose and purpose of the 

topic. 

Listen 

2. Main stage

(55 min) 

1Explains the topic and demonstrates the presentation. 

2. Applies the posters

. 

Listen 

recording 

3.The final stage

(10 min) 

Makes a final conclusion. Listen 

4. Self-study tasks

(5 min) 

Declares tasks for independent work.  Records 

1. Main stages of solving problems on a computer.
Solving a problem on a computer is the process of automatically converting source data into the 

desired result in accordance with a given algorithm. 

Main stages of computer problem solving: 

1. Problem statement.

2. Modeling and formalization of the problem.

3. Development of the algorithm

4. Testing of the algorithm. This stage involves checking the algorithm manually using previously prepared

test cases. For complex tasks, this stage can be very time-consuming, so experienced programmers skip it 

and test the program. 

5. The programming algorithm. Programming is a formal recording of an algorithm by means of a

programming language. 

6. Program testing. Testing is performed by displaying the intermediate results of the program and

comparing them with the control example. To do this, either use special program debugging tools available 

in the integrated programming language environment, or temporarily add intermediate value output 

commands to the program. You can reduce the complexity of searching for errors in the program by more 

carefully designing the algorithm and planning the testing process at the early stages of program 

development. 

7. Operation of the program and interpretation of results. In complex programs, there may not

be enough testing to fix all the errors. Very often they are found at the operational stage. 

2. Concept of the algorithm.
The emergence of algorithms is associated with the birth of mathematics. More than 1000 years ago 

(in 825), a scientist from the city of Khorezm, Abdullah (or Abu Jafar) Muhammad bin Musa al-Khwarizmi 

created a book on mathematics, which described how to perform arithmetic operations on multi-valued 

numbers. Initially, algorithms were understood only as rules for performing four arithmetic operations on 

multi-valued numbers, and later this concept was used to denote a sequence of actions that lead to the 

solution of the problem. The word "algorithm" itself originated in Europe after the translation into Latin of 

a book by this Central Asian mathematician, in which his name was written as " Algorithmi».  

Algorithm — a clear and precise instruction to the performer (human or automaton) to perform a 

sequence of actions aimed at achieving the specified goal or solving the task. 

Algorithm-description of a sequence of actions (plan), strict execution of which leads to the solution 

of the task in a finite number of steps.  



An algorithm is a specific sequence of actions that must be performed in order to get a result. The 

algorithm can be a sequence of calculations, or it can be a sequence of actions of a non - mathematical 

nature. 

An algorithm is an instruction to a certain performer to perform a final sequence of actions that 

leads to a certain result. 

An instruction to perform a separate completed action by the performer is called an algorithm command. 

The set of all commands that can be executed by some performer forms a system of commands for this 

performer - SKI.  

The performer of the algorithm is the object or subject (a person, a group of people, an animal, a 

robot, an automaton, a computer) that the algorithm is designed to control. 

All verbal algorithms are written for a person, therefore, he is the performer of such algorithms. 

Many automatic devices around us also operate according to certain algorithms. For example, the 

electric kettle turns off when a certain temperature is reached; you can set a specific procedure for a modern 

multi-program washing machine. 

The pinnacle of automatic devices are robot devices that can perform a particular job without human 

involvement. It is unlikely that a person will be able to assemble a complex electronic Board as quickly, 

accurately and efficiently as a robot manipulator does in automated production. 

The computer is one of the most impressive examples of performers. 

Algorithms are the rules of addition, subtraction, multiplication and division of numbers, 

grammatical rules, rules of geometric constructions, and so on. 

Algorithmization is the process of developing an algorithm (action plan) for solving a problem. In 

programming, the algorithm is the Foundation of the program, and the main performer is the computer. At 

the stage of testing the algorithm, the performer can be the programmer himself. 

Examples of algorithms: Any device purchased in a store is provided with instructions on how to use it. 

Recipe for cooking. 

Every driver should know the rules of the road. 

Mass production of cars became possible only when the order of Assembly of the car on the conveyor was 

invented.  

We meet algorithms at every step. Some of them we perform automatically, without even thinking 

about it. When we perform certain actions, we don't even know that we are performing a certain algorithm. 

For example, you know how to open a door with a key. However, to teach this baby, you will have to clearly 

explain the actions themselves, and the order of their implementation. Write down the algorithm for 

performing door opening.  

1. Get the key out of your pocket.

2. Insert the key into the keyhole.

3. Turn the key twice counterclockwise.

4. Remove the key.

Write down a different algorithm. You were invited to visit and explained in detail how to get there: 

1. Leave the house.

2. Turn to the right.

3. Walk two blocks to the bus stop.

4. Take the bus number 5, going to the city center.

5. Drive three stops.

6. Get off the bus.

7. Find a house and apartment at the specified address.

3. The properties of the algorithms.
       These examples are nothing more than an algorithm. Despite the significant difference in the essence 

of the actions of these examples, you can find a lot in common. These common characteristics are called 

properties of the algorithm. This means that, unlike all possible prescriptions, the algorithm has a number of 

properties that ensure its automatic execution. This is discreteness, clarity, certainty, effectiveness and mass 

character. 

1. The property of discreteness means that the way of solving the problem is divided into individual

steps (actions). Each action corresponds to an instruction (command). Only after executing one command, 



the performer can start executing the next one. 

Discreteness (from lat. discretus-divided, intermittent) is the division of the algorithm into a series of 

separate completed actions (steps). In the above algorithms, it is common to strictly follow the sequence of 

actions. Let's try to combine the second and third actions in the first example. Of course, you can perform 

this algorithm, but the door is unlikely to open. And if you swap, let's say, the fifth and second actions in the 

second example, the algorithm becomes impossible.  

Discreteness of the algorithm. Properties of the algorithm, which means that the problem-solving 

process defined by the algorithm, divided into separate elementary actions (steps) and therefore the 

algorithm is a sequence of instructions, commands that determine the order of execution of process steps. 

2. The intelligibility property means that the algorithm consists only of instructions included in the

performer's command system, that is, such instructions that the performer can perceive and perform the 

required actions on them. 

Intelligibility is a property of the algorithm in which each of these elementary actions (steps) is 

complete and understandable.  

3. The definiteness property means that there are no commands in the algorithm that make sense. it

can be interpreted ambiguously. it is unacceptable to have situations when after executing the next 

command, the performer is not clear which command should be executed at the next step. 

Determinism (from lat. determine - any action of the algorithm must be strictly and unambiguously 

defined in each case. 

For example, if buses of different routes approach the stop, the algorithm must specify a specific 

route number-5. In addition, you must specify the exact number of stops to travel-say, three.  

Determinism is a property when every action (operation, indication, step, requirement) must be 

understood in a strictly defined sense, so that there is no room for arbitrary interpretation. so that everyone 

who reads the instruction understands it clearly.  

4. The performance property means that the algorithm must be able to obtain a result after a finite,

possibly very large, number of steps. In this case, the result is not only the response due to the problem 

statement, but also the conclusion that it is not possible to continue solving this problem for any reason. 

Performance – a property in which any algorithm in the process of execution should lead to a certain 

result. A negative result is also a result.  

5. The mass property means that the algorithm must be able to be used for solving a class of similar

problems, i.e. each algorithm developed for solving a certain problem must be applicable for solving 

problems of this type for all acceptable values of the source data. 

The mass is one and the same algorithm can be used with different source data. 

There are many different forms of writing algorithms. This is due to the fact that each performer of 

algorithms "understands" only such an algorithm that is written in its "language" and according to its rules. 

There are four forms of writing algorithms:       

1. Verbal and step-by-step (text). (instructions, traffic rules, recipes)

2. Tabular. 3. Writing in

3.algorithmic language.

4. Graphic form of recording (block diagram).

Every algorithm entry starts with a header. 

Word-by-step (Text ) 

The algorithm is written as numbered stages of its execution. For example: an algorithm for adding two 

numbers ( a and b). 

1. Ask what the number a is.

2. Ask what the number b is.

3. Add a and b, assign the result to C.

4. Report the result with.

Table entry form 

This is a table entry of the algorithm. The tables used can be different. For example, we will use a 

simplified form.  

The procedure for drawing up a table of algorithms: 

1. Rewrite the expression as allowed in computer science.

2. Determine the order of actions.



3. Enter symbols for intermediate results.

4. Enter the received actions in the table.

Writing in an algorithmic language. 

The algorithm can be written in natural language as a description or in a special algorithmic language. 

Writing algorithms in your native language is accessible and convenient. There are many examples of such 

entries, even if the book of recipes is nothing more than a collection of algorithms written in their native 

language. 

A significant disadvantage of such a record is the lack of visibility, which is especially noticeable 

when the algorithm has many branches. Therefore, we will write our algorithms in the form of a block 

diagram.  

Graphic form of the inscription (Block diagram) 

The algorithm is written as a diagram consisting of blocks (geometric shapes) with actions placed in 

them. Flowcharts of algorithms are graphical descriptions of algorithms as a sequence of actions. In the 

flowchart, each geometric shape means a specific value. Blocks are connected by arrows and show the 

direction of sequential execution of actions the structure of the entire algorithm.        

When drawing up a flowchart of the algorithm, first select the source data (all variables after the 

equal sign and in the condition) and the result (the values to be found). If the task implies but does not 

specify the names of values, then they are designated independently. 

If there is no source data, the input block is not written. You can put one action in one block. 

1. The algorithm in the form of a flowchart begins with the "start" block and ends with the "end"

block. 

        beginning 

end 

2. data entry block;

3. computing unit;

 а,  в, с    

у=(а+2)   

4 . Logic block; 

yes

условие         

no      

5 . Result output block; 

 а. в. с   

The schematic diagram of the algorithm that implements the chosen numerical method for solving 

the problem should reflect the main blocks of the algorithm with maximum conciseness (without 

unnecessary detailing).  



The development of the algorithm is preceded by such stages as formalization and modeling of the 

problem. Formalization involves replacing the verbal formulation of the problem to be solved with short 

symbolic notations that are close to the notation in programming languages or mathematical ones..  

Modeling the problem is the most important stage, the purpose of which is to find a General concept 

of the solution. Usually, modeling is performed by putting forward hypotheses for solving the problem and 

testing them in any rational way (estimation calculations, physical modeling, etc.). the Result of each test is 

either acceptance of the hypothesis, or rejection of it and the development of a new one.  

When developing the algorithm, the following basic principles are used: 

1. The principle of step-by-step detailing of the algorithm (another name is "top - down design"). This

principle involves the initial development of the algorithm in the form of enlarged blocks (splitting the 

problem into subtasks) and their gradual detailing.  

2. The principle of "from the main to the secondary", which involves the creation of an algorithm, starting

with the main construction. At the same time, it is often necessary to "complete" the algorithm in the 

opposite direction, for example, from the middle to the beginning.  

3. The principle of structuring, i.e. using only typical algorithmic structures when constructing an algorithm.

Dijkstra's Theorem. An algorithm of any complexity can be implemented using only three constructs: 

following (linear), selecting (branching), and repeating (cyclic). Based on Dijkstra's theorem, there are three 

main types of algorithms: 

" Linear; 

" Branching; 

" Cyclic 

Sometimes algorithms with subroutines and mixed algorithms are also distinguished. 

4. Linear algorithm.
Linear (sequential) algorithm-a description of actions that are performed once in a given order. 

Linear algorithms are for unlocking doors, making tea, and making one sandwich. A linear algorithm is used 

when calculating an arithmetic expression if it uses only addition and subtraction actions.  

A linear algorithm is an algorithm in which all stages of solving a problem are performed strictly 

sequentially and once. The sequence and singleness of the linear algorithm commands can be seen in the 

flowchart. 

Example: Create an algorithm for calculating the value of y using the formula: y=ax+b In this 

problem, a, x, b are variables, y is the result.  

 Block diagram 

   Beginning      -  beginning of the algorithm. 

a, x, b           - the input variables 

{ entering values for variables-a, x, b } 

    y=аx+b        - vychislenie resultit have. 

  у - output the result

   { on paper or screen } 

end - end of the algorithm 

5. Branching algorithms.
Branching algorithm — an algorithm in which either one or another sequence of actions is performed 

depending on the condition.     

A branching algorithm is an algorithm that selects one of several possible paths (variants) of the 

computational process. Each such path is called a branch of the algorithm 



Examples of branching algorithms: if it rains, you need to open an umbrella; if you have a sore 

throat, you should cancel the walk; if a movie ticket costs no more than ten rubles, then buy a ticket and take 

your seat in the hall, otherwise (if the ticket price is more than 10 rubles) go home.  

There is a complete (if – otherwise) and incomplete (if - then) branching. 

In General, the scheme of the branching algorithm will look like this: "if the condition is, then..., 

otherwise...". This representation of the algorithm is called the full form. An incomplete form in which 

actions are skipped: "if a condition, then...". a Condition is an expression that is located between the word " 

if "and the word"then". It takes the values "true" or " false».  

Example: Branching algorithm (incomplete form) My friend got sick and didn't show up for class today. The 

teacher asked me to drop off his homework. If I see it, I'll pass it on.  

Example: Branching algorithm (full form)My friend got sick and didn't show up for class today. The teacher 

asked me to drop off his homework. If I see it, I'll pass it on, and if I don't, I'll go in and do what I was asked 

to do.



Example: Given two numbers a and b. 

It is obvious that to determine the branch on which the process of calculating the value of x should be 

performed , it is enough to check the fulfillment of one of the conditions, for example, a>b. If the condition 

a>b is not met, it is obvious that the condition a < b will be met without additional verification. Therefore, a 

variant of the algorithm scheme will look like this. 

 Example: Calculates the function 

a/b ,     If  a>0 

   x =           a-b,     IF a=0          

 a+b,    IF a<b         

Schemes of branching structure algorithms: 

a ) - with a complex logical condition; 

b) - when decomposing a complex logical condition into simple.



6. Cyclic algorithms.

Many processes in the world around us are based on repeated repetition of the same sequence of 

actions. Spring, summer, autumn and winter come every year. Plant life goes through the same cycles 

throughout the year. By counting the number of complete turns of the minute or hour hand, a person 

measures time.  

A cyclic algorithm is a description of actions that must be repeated a specified number of times or 

until a specified condition is met. The list of repeated actions is called the loop body. In a cyclic algorithm, 

the result is obtained by repeatedly performing the same operations.  

The cyclic structure algorithm provides for repeated actions in the same sequence for the same 

mathematical dependencies, but for different values of a specially variable value. Cyclic algorithms can 

significantly reduce the program size by repeatedly performing a group of repetitive calculations, the so-

called loop body. A parameter that is specially modified according to a given law and is included in the loop 

body is called a loop variable. 

The loop variable is used to prepare the next iteration of the loop and track its end conditions. Any 

variables, array indexes, arguments of calculated functions, and similar values are used as a loop variable. 

During the execution of the loop body, the parameters of the loop variable change in the interval from the 

initial to the final value with the specified step. Therefore, when organizing cyclic calculations, it is 

necessary to provide for setting the initial value of the loop variable, the law of its change before each new 

repetition, and its final value, when it reaches the end of the loop. 

Algorithms of a cyclic structure can be created using a logical block. 

yes 

    yes 

not 

not 

Also for the description of cyclic algorithms make use of the following schematic view (block 

modifications) where the loop is organized using a control variable.    

When you first access the loop title (hexagon), the loop parameter i takes the initial value 

(assignment) and if this value does not exceed the final value i2, actions that are in the loop body will be 

performed. Otherwise, commands that are outside the loop will be executed. When accessing the loop 

body, after performing the actions that are in it, the control is passed to the title where the loop parameter 

Initial 

assignments 

Con

ditio

n

Loop body 

Initial 

assignments 

Loop body 

Con

ditio

n

i=i1, i2, i3 

Loop body 

Here i is the variable that 

organizes the loop and is called 

the loop parameter. 

i1, i2, i3 are the initial and final 

values and the step of changing 

the loop parameter, respectively 



gets the next value by adding the initial value of the change step. And this value is compared with the final 

sign, and depending on what does not exceed or exceeds, the loop body is accessed or the loop is exited. 

The loop body is a sequence of actions that is performed repeatedly (in a loop). Loops that don't have 

branches or other loops embedded in their bodies are called simple loops. Otherwise, they are classified as 

complex. Cyclic algorithms are divided into deterministic and iterative ones.  

Cycles in which the number of repetitions is known in advance from the source data or determined 

during the solution of the problem are called deterministic. To organize deterministic loops, it is most 

appropriate to use the modification block, which specifies the loop variable, its initial and final values, and 

the step of its change (if the change step is equal to 1, then it is allowed not to specify it. 

Example: Given a natural number N. Find the sum of the first N terms of a natural series.

       а)                                                б) 

Schemes of the cyclic structure algorithm for finding the sum of The first n terms of a natural series: 

a) - using the modification block;

b) — using the condition check block

The loop body uses the assignment operation S = S + I, which is used to calculate the sum by adding 

all new values of variable I to the previous value of variable S. 

The number of repetitions m can be calculated using the following formula: 

1
3

12

I

II
m

Cycles in which the number of repetitions is unknown from the source data and is not determined in 

the course of solving the problem are called iterative. In the iterative cycles for the organization of exit from 

the body of the loop provides verification of a predetermined condition to use the unit check the conditions. 



Example: Given a series of natural numbers 1,2,3,..., ∞ and the number N. You need to find the sum of 

the first members of the series. Stop calculating the amount as soon as its value is equal to or exceeds the 

specified N.

а)                                                                    б) 

Scheme of an iterative algorithm for finding the sum of the first terms of a natural series: 

a) with a postcondition;

b) with a precondition

7. Algorithmic programming languages (basic, Pascal, C, etc.)

A program is a set (or sequence) of instructions (commands) to the performer, i.e., in our case, to the 

computer. A machine language is a set of commands recognized and executed by a computer (in particular, 

by a processor). A programming language is a set of commands( operators), rules, and conventions that are 

more understandable to the user than a machine language. Compilation (translation) - literally compose 

(translate) - the process of translating a completed program in a programming language into a machine code 

language. Reverse translation is difficult, so compilation is in some sense an irreversible process. The 

compiler (translator) is a program that produces the compilation. A linker is a program that binds a compiled 

program to library files. You can use it to get an executable file, a static library, or a dynamic library. A 

library file is a program that performs a certain (one or more) completed task (for example, taking the sine of 

an argument). if necessary, it is embedded in a compiled (executable) file at the compilation stage (static,. 

lib), at the execution stage (dynamic, .dll). In addition, the dynamic library can be used by several programs 

at the same time and is unloaded from RAM if it is not used. Object code-a program record in a form that 

can be processed by hardware. It has the .obj extension. Executable file – a program (. exe) that is ready for 

execution. 

There is a division of all programming languages into two large groups-high-level and low-level 

languages. The lowest-level language is the language of so-called machine codes. For example, low-level 

languages include the so-called Assembly languages. Their advantage is that they almost do not require 

translation for the computer, and it almost immediately executes the algorithm. There is, however, a 

significant drawback — only a very experienced programmer can write programs in such languages, and 

they turn out to be too cumbersome. On the contrary, high-level languages are quite close to human (more 

often to English) the language is both Fortran, Pascal, and C, but the execution of the algorithm by the 

computer in this case is somewhat slowed down by the preliminary translation into the language of machine 

codes. 

According to the method of obtaining machine codes, programming languages are divided into 3 types: 

1) Compiled. For example, Fortran, Pascal, and C. the compilation Steps are shown in the diagram.

2) Interpreted. For Example, Basic. The interpreter (program) reads the source program string, generates

machine codes, and executes them immediately. 

3) Interpreted by elements of the compilation. For Example, The Fort.



 Programming in machine language was very labor-intensive, and higher-level programming 

languages were developed in this regard. 

Assembler-machine-dependent 

a programming language that is more 

understandable to the programmer than a 

machine language, but at the same time 

retains the semblance of a machine 

language. Assembly language commands 

are converted to machine language 

commands almost unchanged, i.e. each 

Assembly language command is usually 

translated into exactly one machine 

language command. 

Fortran. In 1954, a team of IBM 

developers led by John beckus began 

developing Fortran. In April 1957, the 

Fortran compiler was ready for use by owners of the IBM-704 machine. Five years later, Fortran was used 

on six different models of IBM computers. The language was intended primarily for scientific computing, 

and it is still widely used in this field (in an improved version). However, the new language was not without 

drawbacks, the elimination of which led to the appearance of Fortran II, which allowed you to attach 

programs in Assembly language. In 1958. a version of Fortran III was created, and version IV, which 

expanded the language's capabilities, appeared in 1962. As Fortran repeatedly adapted to all new machine 

systems, differences gradually accumulated. To restore order, the language was standardized in 1966, and 

then in 1977, Fortran was the first widely used commercial language. 

Basic. John Kemeny and Thomas Kurtz, members of the mathematics Department at Darmouth 

College, wrote a simple and easy-to-learn language called Basic (Beginner's All-purpose Symbolic 

Instruction Code). At the end of 1975, the first Basic interpreter was created, consisting of about 20 pages of 

octal code. It was created by two Amateur programmers, dick Whipple and John Arnold. At the same time, 

the manufacturer of Altair, MITS (Micro Instrumentation and Telemetry Systems), began selling its own 

version of the basic language. This version was written in 1975 by a freshman at Harvard University, Bill 

gates, and his friend Paul Allen,a young programmer at Honeywell. Soon the most popular was M-basic, 

with the sale of which gates and Allen began the activities of the company they created Microsoft 

Corporation. Features of the language: dialog mode; line numbering; real and character data types, control 

constructs; all variables are global, arrays are available. 

Algol-60, 68. in 1965, K. A. R. hoar and the Swiss scientist Niklaus Wirth, who taught at Stanford 

University in the United States, proposed a modified version, which was named Algol-W in honor of Wirth, 

was published and became very popular on University campuses. In 1968, the Algol-68 programming 

language appeared, as predicted, which turned out to be too cumbersome and did not receive recognition in 

Europe. 

Cobol. In 1959, a conference on programming languages was held. The reason for the conference 

was the creation of a single language for business applications. By mid-autumn, the new language took on a 

certain look and name - Cobol (Common Business Oriented Language-a universal language designed for 

business). Cobol's popularity increased after its new version was published in 1962. The language was 

business-friendly, machine-independent, and easy to understand. The Cobol program consists of four 

separate sections, following in a strictly defined order: the identification section, the equipment section, the 

data section, and the procedures section. 

PL/1. With the release of more powerful computers by IBM in 1961, a more modern programming 

language was required. IBM specialists under the leadership of George Radin started working in October 

1963, and by February 1964, the language specifications were completed. The language was named PL/1 

(from programming language one), and work on the compiler was entrusted to the IBM laboratory in 

England.  

Lisp was developed at Stanford under the direction of J. McCarthy in the early 60s. Finally formed 

principles underlying the Lisp language: the use of a single list representation for programs and data; the use 
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of expressions to define functions; the language's bracket syntax. Lisp is focused on processing non-numeric 

problems and is based on the algebra of list structures, lambda calculus, and recursion theory. 

Pascal. The first version of the Pascal language was developed by the Swiss scientist Niklaus Wirth 

in 1968. Initially, the language was intended for learning purposes, because it is quite deterministic, i.e. 

everything obeys certain rules, exceptions to which are not so many. Main features: a relatively small 

number of basic concepts, simple syntax, and a fast compiler for translating source texts into machine code. 

In 1992, Borland International released two packages based on the Pascal language: Borland Pascal 7.0 and 

Turbo Pascal 7.0. The first one can work in three modes - normal and protected MS DOS modes and in 

Windows, the second only in normal MS DOS mode. 

The Ada language was developed (with the financial support of the US Department of defense) by an 

international team of programmers from Honeywell and its French subsidiary Cii-Bull, led by J. Ishbia. The 

structure of Ada is very similar to Pascal. The syntax of most operators and descriptions is almost identical 

to that of Modula. Version of Ada 1987g. it is the first object-oriented programming system in the world to 

have an international standard. 

Modula-2. The language was created By N. Wirth in 1979. Pascal was originally designed to teach 

programming and had many disadvantages as a software development language. In Modula-2, these 

shortcomings were eliminated, but the logical structure and characteristics of its predecessor were preserved. 

Modula-2 refers to machine-independent languages. N. Wirth used Modula-2 to write a complete operating 

system for minicomputers. A characteristic feature of Modula-2 is separate compilation, which allows you to 

develop and store programs in libraries that can be reused. 

Prolog (PROgramming LOGic) was introduced in 1972 and was designed by Alan Kalmari from the 

University of Luminy (Marseille). Alan Colmery compiled an algorithm for a formal way of interpreting the 

inference process and developed a system for automatic proof of theorems, which was written in Fortran. It 

was the prototype of Prolog. This language was chosen for solving problems in various fields, including: 

mathematical logic; abstract problem solving; natural language understanding; design automation; symbolic 

equation solving; and analysis of biochemical structures. Prolog is a dialog language. Its program consists of 

a set of statements, each of which is either a fact about the given information, or a rule indicating how the 

decision is related to the given facts or how it can be deduced from them.  

The C language was developed and implemented by D. Ritchie in 1972 at Bell Labs, and was used in 

a wide variety of applications, mostly running the UNIX operating system. It represented a further 

development of the Bi (B) language, which was based on the BCPL language created at the University of 

Cambridge (from Basic Combined Programming Language - basic combined programming language), 

which in turn was a descendant of ALGOL-60. During the work on creating a mobile translator from the C 

language it was redesigned to increase the mobility of programs written in it. 

Oberon. The Oberon language was created in 1987 by Niklaus Wirth, Professor at the Institute of 

computer systems of the Federal technical University (ETH, Zurich, Switzerland), author of the Pascal and 

Modula-2 languages. The language is named after a satellite of the planet Uranus. Oberon differs from 

Modula-2 in the absence of many optional constructs; object-oriented programming tools - extensible 

records-have been added to the language. Oberon is the simplest universal language.  

C++. The first versions of C++ were developed in the early 80's by Bjarne Stroustrup, an employee 

of the famous AT&T Bell Labs, where the UNIX operating system and the C programming language were 

previously developed. The design, implementation, and documentation of new features occurred virtually 

simultaneously. The sole purpose of the development was to create a language that would be convenient for 

the author and his friends to program in. It was based on the popular C programming language among 

professional developers. The first tools that extended C were tools for supporting data abstractions and 

object-oriented programming. Work on its standardization was completed in 1989, and the standardized 

version is now known as ANSI C. The final draft of the standard was adopted in April 1995 and posted on 

the Internet for public discussion. 

Perl. Perl (Practical Extraction and Report Language) was developed in 1986 by Larry Wall to 

create reports on the contents of numerous text files in the UNIX environment. Perl is a portable, interpreted 

language that is ideally suited for numerous text processing applications. Perl programs are usually called 

scripts (script-font). With the invention of the World Wide Web, Perl proved to be an excellent tool for 

interacting with web servers via the Common Gateway Interface (CGI). Perl commands can easily get data 

from an HTML form or other source and do something with it. A regular program is compiled to binary 



format, while the script is stored in the original text format (i.e. it does not need to be compiled before 

running). 

Java. Java appeared in early 1996. on the WWW Consortium home page, Java was included in the 

list of so - called Mobile Codes-one of the promising directions for the development of World Wide Web 

technology. And at the end of 1996, the Java boom began in the West, which by the time of the Unix-

Expo`96 exhibition had reached our country. Java is an object-oriented, interpreted, architecture-

independent, portable, dynamic programming language. Java-applets is a small program stored as a file (. 

class) on a Web server. When the browser detects the <APPLET> tag in the HTML page, it loads the Java 

application (bytecode) to the client's machine and uses the Java machine to check its correctness and execute 

it. 

Python (the Python). It was created by its author Guido van Rossum in the early 90's. Python is an 

interpreted (compiled on the fly (Just-In-Time compilation, JIT), when executed), initially object-oriented 

programming language. Python is an extensible language, meaning that new built-in functions or modules 

are easily added to the interpreter. 

Visual Basic 1.0 appeared in 1991. Stripped - down versions of VB built into Word, Excel, Access, 

etc. called VBA (Visual Basic for Application). Visual Basic 5 supports ActiveX controls.  

In addition to these, there are other programming languages: VBScript, JavaScript, PHP, Tcl/Tk, 

Shell, etc.; hypertext markup languages: HTML (HyperText Markup Language), DHTML, XML 

(eXtensible Markup Language), VRML (Virtual Reality modeling Language), CSS, etc., used for creating 

Web pages and based on a predefined set of "tags" that show the text-reading software ("browser") how to 

represent the page content. 

Active X*. Active X officially appeared in December 1995: it was announced by Microsoft in Seattle. 

Active X-a set of technologies that allow you to interactively distribute information in networks (including 

the Web).8. Общая характеристика языка Бэйсик. 

The basic programming language is a high-level language. It was created by John George Kemeny 

and Tom Kurtz, who worked at Dortmund College in 1964. They named their language after the first letters 

of the words "Beginner's All-purpose Symbolic Instruction Code" which means a multi-purpose language of 

symbolic instructions for beginners. In addition, there was an Association with the word "basic". The new 

language quickly gained popularity due to its ease of learning, especially among beginners. In fact, like 

Pascal, Basic was intended for teaching students.  

This may have influenced the fact that two people, now widely known, Paul Allen and William 

gates, back in 1975, began to develop a basic interpreter for the Altair personal computer, later founding 

Microsoft, which became one of the largest computer empires. In those early years, Basic was the first 

product released by this company. A great advantage of basic, because of which its study continues in 

Universities to this day — is the ability to create interactive programs. Now basic has gone beyond the 

language for beginners, and its powerful descendant — Visual Basic allows you to work wonders on your 

computer. But back to our good old Basic. Over the years, several versions of it have been created — GW-

Basic, MSX-Basic, TurboBasic, QuickBasic. 

The simplest design of the programming language basic. 

A basic program consists of a sequence of strings. Each line starts with an integer-the line number; 

the line number is followed by a basic command. (Basic rules allow multiple commands in a single line. In 

this case, the commands are separated by a colon.) 

Lines in basic don't have to be numbered in a row. All that matters is that the numbers are in ascending 

order. However, rows are usually numbered at intervals of 10: 10, 20, 30… 

Numbers, variables, standard functions, and arithmetic expressions. 

Constants and variables in basic. As in an algorithmic language, in basic, values are divided into 

variables and constants (constants); a Constant is a value that does not change during program execution. 

Each value can be an integer, real, or literal type. Constants are written in basic in the same way as in 

algorithmic language. The only difference is in the way decimal numbers are written. In basic, you can use a 

dot instead of a comma to separate an integer from a fractional part (for example, 12.5, 0.5, 3.1415926, and 

so on). This rule is accepted in almost all programming languages.  

Real constants differ from integers by the presence of a decimal point. they are stored in memory in 

floating-point form. Since a computer memory cell can only store a certain number of digits, in very large 

and very small numbers, the decimal point is moved m characters to the left (or right) and the resulting 



number is multiplied by 10m (or 10-m). For example, the number 0.0000033 contains 8 digits in normal 

form, and the same number 0.33 E-5 in floating-point form has 4 digits, including the degree. This 

conversion affects the accuracy of the number, because a limited number of significant digits are stored in 

memory, and all extra digits are discarded. For example, the number 3.141592653589793 in floating-point 

form will be stored as 3. 14159E0, the number 61232736 as 6. 12327E7, the number 1000001 as 1. 

00000E6, and the number 0.00001648974 as 1.64897 E-6. 

String. A string constant is a sequence of characters enclosed in quotation marks or apostrophes. For 

example ― "this is a string constant‖; "0.33 E-12". STRING * n% - Declaration of a fixed-length string 

variable in n % bytes. STRING-Declaration of a string variable of variable length. 

Variable-a value that changes its original value during program execution. Like constants, variables also 

come in 4 types. The variable name (ID) represents a sequence of allowed characters, and cannot contain 

Russian characters and the first digit. The case of characters does not matter. The type of a variable can be 

indicated by its suffix (see table). For example, the character variable is A$, the integer is regedit1%, and the 

real variable is dreal#. Incorrectly written variables: 8E, Y1, A*B, 05.9. 

The alphabet Basic 

        The Basic character set includes Latin alphabetic characters (A-Z, a-z), numeric characters (0-9) , and 

special characters. 
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        An expression is a compact record (formula) that specifies what operations need to be performed on 

the data. The expression is composed of operands connected by the sign of arithmetic or logical operations, 

relations, and parentheses. Operands are any variables, numeric and string (character) constants. In addition, 

the expression may contain built-in functions. 

        So, there are arithmetic, logical, and relational operations. 

In basic, you can use operation signs and parentheses to construct expressions from variables and 

constants. 

The following symbols are used to indicate arithmetic operations 

: 

+ - * / \ ^ 

Addition Subtraction 
Multiplicatio

n 
Division Integer division Exponentiation 

For Example, A + B; A-B; (A + B) * 2.1; x/(3.0*y); z ˆ2; z ˆ N%; (A(l) + B(1)) /C (3). 

For string variables in basic are allowed to use only one operation — the connection of texts. This operation 

is indicated by the +sign. For example, 



"Kolo" + "side" = "the gingerbread man". 

In basic expressions, as in algorithmic language, you can use function names, for example:

2∗SIN(X)∗COS(X), X∗ABS(A − В)  i.t.s..  

        Delimiter of multiple operators in a single stringthe priority of operations increases from left to right. in 

other words, the evaluation of an expression (without parentheses) begins with exponentiation. In the 

expression a*x^4+b*x+c, the power of x^4 is calculated first, then multiplication (a), then multiplication of 

b by x, then addition. If there are parentheses, the operations in them are performed first. For the expression 

(a+b)*c^f+f/d*(f-10), addition is performed first, then subtraction, and then exponentiation. The expression 

2*2^2/2/2 is equivalent to ((2*(2^2))/2)/2, I. e. operations of the same rank of precedence are performed 

from left to right, and exponentiation from right to left, i.e. 2^2^3=256 (not 64). Depending on the 

placement of parentheses, the result of the expression also changes, for example, k=2^8/2+2=130, 

k=2^(8/2+2)=64 and k=2^(8/(2+2))=4. the Result of integer division is an integer (the real part is discarded), 

i.e. 10\4=2. 

Operations relationships 

= <> < > <= >= 

Equally Not equal Less More 
Less than or equal 

to 

Greater than or 

equal to 

          Left-to-right relationship operations are performed and used to compare two variables. The result of 

the comparison is logical expressions that take the value "true"or " false". 

Logical operations 

№ 
Mathematica

l notation 

Notation 

in Basic 
Title Explanations 

1. NOT NOT Logical negation of an argument 
The value of the argument is 

reversed. 

2. AND AND 
Logical multiplication of two 

arguments, conjunction, And. 

An expression is true if both 

arguments are true, otherwise 

it is false. 

3. OR OR 
Logical addition of two arguments, 

disjunction, OR. 

The expression is false if both 

arguments are false. 

10. Standard Basic functions

        Basic has a set of standard (built-in) functions. A built-in function is a routine that is standardized in 

Basic. The function has a name and a list of input parameters specified in parentheses. At the same time, the 

function name is also a variable that returns its value. For example, the cosine function of COS (x) has the 

name COS and the input parameter x. Input parameters can be a numeric expression, variable, or constant. 

Mathematical function 

№ Function 
Mathematical 

notation 
Description 

1. ABS(x) x Returns the negation of the argument х**. ABS(-9.99)=9.99. 

2. ATN(x) Arctg(x) Returns the arctangent х (–1 x 1). 

3. COS(x) Cos(x) Returns the cosine of x (x is in radians). 

4. SNG(x) 
Converting x to a single-precision value. 

sng(975.3421515)=975.3422. 

5. EXP(x) Exp(x), e
x 

Returns the exponent x. Exp (1)=2.718282=e. 

6. INT(x) 
Returns the largest integer less than or equal to x. 

Int(12.54)=12, Int(-99.4)= 100, Int (100)=100 

7. LOG(x) Ln(x) Returns the natural logarithm of x. 

9 SGN(x) 
y = 1 for x>0 0 for 

x=0 -1 for x<0 
Returns +1 for positive x, -1 for negative x, and 0 for x=0. 

10 SIN(x) Sin(x) Returns the sine of x (x is in radians). 

11 SQR(x) x Returns the square root of x (x 0). 

12 TAN(x) Tg(x) Returns the tangent x (x - in radians). 



Note. ** - X is a numeric expression, variable, or constant. 

Some other mathematical functions can be calculated using well-known formulas, using standard ones. For 

example, secant – sec(x)=1/cos(x), cosecant - csc(x)=1/sin(x), cotangent – cot(x)=1/tan(x), arcsin - 

arcsin(x)=arctgx/1-x2, arccosine - -arctgx/1-x2, hyperbolic sine – sinh(x)=(ex-e x)/2, 

hyperbolic cosine - cosh(x)=(ex+e x)/2, hyperbolic tangent – tanh(x)=(ex-e x)/(ex+e x), etc. 

Basic commands of the basic language. Operators: assignment, the formation of the block of 

data and output. 

CLS - (Clear screen-clear the screen) Used as a command, that is, without a line number and in the 

program as an operator. Allows you to clear the screen, but the program text will remain in the computer's 

memory.  

NEW - (translated from anl. new) clears the computer's memory i.e. erases the program text. 

RUN-allows you to execute a program entered into the computer's memory (translated from anl. run)   

LIST-the command is used to display the program text on the screen. It is necessary to specify the 

row number if the row number is not specified, it displays the full text of the program. 

LIST 

     LIST N 

     LIST N- 

     LIST –N 

     LIST N-M 

DELETE - command to delete program lines. After the command name you must specify the line 

number to delete.   

     DELETE N 

     DELETE N- 

     DELETE –N 

     DELETE N-M 

LOAD "file name" - command to load the program from permanent memory to RAM. 

SAVE "file name" - command to save the program in the computer's permanent memory. 

Operators are written certain words of the English language .These words have a meaning 

corresponding to the action that the operator performs. 

1. the Simplest operator for entering the value of a variable is the LET a=B operator

Where A is a variable, B is a number, or an arbitrary arithmetic expression. 

Examples: 

10 LET А1=5 

20 LET С=2*А1+А1/2  

Example#1. Create a program to calculate the heart rate. 

          20 LET V=6E-5 

          30 LET  P=13000 

          40 LET  D=1.05E3 

          50 LET  C=0.5 

          60 LET A= 1.2*V1*(P+D*C^2/2) 

Note: when entering program text, the LET statement may be omitted, but it is inserted in the appropriate 

places in the programs and displayed on the screen when the text is output. 

2. If there is a lot of data (there is a block of data), it is more convenient to describe it with the DATA

operator, for example: 

10 DATA 15, 100, 4, 2E-6 

Data values are assigned to variables using the READ statement, for example 

20 READ X, Y, Z ,A 



Here the variables X, Y, Z,and A will be assigned the values 13, 100, 4, and 2E-6, respectively. 

The program can contain any number of DATA statements and they can be located in any place, regardless 

of the position of the operators . READ. 

Example №2. Calculating the heart rate. 

10 REM 

20 DATA 6E-5, 1. 05E3, 0.5 

30 READ V, D, C 

40 INPUT " pressure P="; P 

50 A= 1.2*V*(P+D*C^2/2) 

60 PRINT "work A=‖; A," pressure P="; P          

3. if you need to change the values of any variables while the program is running , use the INPUT

operator. Also, this operator will query for the values of variables performed using input operators. The 

message about the value of variables and the results of arithmetic calculations are implemented using output 

operators. Entering information in Basic with the INPUT operator. Its structure is as follows: 

[line number] INPUT ["hint";] variable 

* hint - any text enclosed in quotation marks

* variable - a comma-separated list of variables that will be assigned the corresponding values entered from

the keyboard. 

The types of numeric data and variables must match. 

The number of data entered must match the number of variables specified in the statement. 

There should be no quotation marks inside the hint text. 

10 INPUT ―ENTER THE COORDINATES"; X, Y 

When the INPUT statement is executed, the computer stops working and "waits" for you to assign 

specific values to the variables X and Y ,which are entered using the display keyboard separated by 

commas. If there is no text, such as 20 INPUT X, a question mark appears instead. 

PRINT output operator. Its structure is as follows: 

[line number] PRINT [list] [{,;}] 

List-contains data (numbers, variables, expressions, texts) enclosed in quotation marks and separated by a 

semicolon or comma. If the separator is a comma, then the next data is output to the beginning of the next 

zone (14 characters). This is a display in the zoned format. If the separator is a semicolon, the output is 

separated by a single space. 

Example №3. The calculation of the heart. 

10 REM 

20 LET V=6E-5 

30 INPUT ―давление P= ‖;P 

40 LET D=1.05E3 

50 LET C=0.5 

60 LET A= 1.2*V*(P+D*V^2/2) 

70 PRINT ―operation " A=‖;A, ―давление P= ‖; P 

Or 

10 REM 

20 THE DATA 6E-5, 1-THE.05E3, 0.5 

30 FOR READ V V V V V, D, C, 

40 INPUT ―давление P= ‖;P 

50, A= 1.2*V*(P+D*V^2/2) 

60 PRINT ―working " A=‖;A, ―давление P= ‖; P 

11. Unconditional transition operator. Conditional jump operators.

Quite often there is a need to change the sequence of execution of program commands, i.e. go to the desired 

line. In BASIC, special operators are used to change the sequence of execution of statements: conditional 

operators (IF, THEN) and transition operators (GOTO). 

1) Unconditional transition The simplest operator that changes the sequence of program execution is called

the UNCONDITIONAL TRANSITION OPERATOR. It is written as: < ns1 > GOTO < NS2 >. 



Here NC1 is the line number with the GOTO operator, and NC2 is the line number in the program to be 

executed.

Example №1 

10 A=4 

20 PRINT ; ―Enter X=";: INPUT X 

30 Y=A*X 

40 PRINT A; ―X‖; X: ‖=‖; Y 

50 PRINT 

60 GOTO 20 

 This program displays a multiplication table of the number X by A. the Value of A is determined in 

the first step – line 10. In line 20, use the INPUT operator to enter the value x. The result is displayed in line 

40. The PRINT statement outputs an empty string without parameters. After the GOTO statement on line 60,

the program runs again from line 20. 

GO TO. For example, 20 GO to 40. Use this command to move to line 40, bypassing the lines between lines 

20 and 40 . 

2) Conditional if-THEN transition

.  

The conditional operator (branch operator) is described as follows: line 

number IF condition THEN operators ELSE operators 

this is the full form of branching, and there is also an incomplete form: 

line 

number IF condition THEN operators 

IF-name of the operator (translated from English "if") 

THEN-auxiliary word of the operator (translated from English "that") 

ELSE-auxiliary word of the operator (translated from English otherwise "case») 

For example, 100 IF A= 100 THEN 30. 

This command , if A=100, jumps to line 30. If A <> 100-to the next row in order, let's say 110. 

The peculiarity of branching algorithms is that the sequence of steps of the algorithm may change 

depending on certain conditions. 

Creating and editing linear and branching programs for biomedical tasks. 

Basic arithmetic expressions consist of constants, variables, and functions. When writing, 

parentheses are used to indicate the order of operations. Inside the parentheses, operations are performed 

from left to right according to the generally accepted priority:  

A) calculating the function value,

B) exponentiation

C) multiplication and division

D) addition and subtraction.

Output the result (print). 

The word ―print " means the output of information (result) on the display screen. It is performed by 

the PRINT operator for example: 50 PRINT ―Number of red blood cells N="; N 

The display screen displays: 

The number of red blood cells N= (calculated value). 

Objective 1 N1.Create programs for solving linear algorithm problems. 

The program for the linear algorithm is executed in ascending order of line numbers. All programs use 

variables for calculations. Variables are indicated by Latin letters or Latin letters and numbers. For 

example:A, B, X1, Z2. 

Find the values of the following functions X=A+B ; Y=A*B; Z=(A-B)/(A+B) for A=5 and B=7. Display the 

calculation result on the screen. 

Program in the basic programming language: 

        10 A=5: B=7 

20 X=A+B: Y=A*B 

30 Z=(A-B)/(A+B) 



                      40 PRINT X, Y, Z 

                      50 END 

In BASIC, the assignment operator-LET is used for calculation. To the left of the ― = " sign after the LET 

operator, specify the variable whose value should be calculated. To the right of the ―=‖ sign, write a formula 

or algebraic expression for calculations. 

The PRINT operator is used to output the calculation result. After the word PRINT, you specify what data to 

display on the screen. 

In this program, lines 10 and 20 each contain two assignment operators. In this case, there should be a colon 

between them that separates one operator from the other. 

Another operator that changes the sequence of program execution is called a CONDITIONAL OPERATOR. 

This statement can be written in two ways: 

First way: 

< NS > IF <condition> THEN <operators-Yes > 

Second way: 

< NS > IF <condition> THEN <operators-Yes > ELSE <operators-no > 

The condition always contains comparison characters(=;<; >; =.; <=; <> ). 

      How does the conditional operator work? If < condition> is true , then <operator – Yes> is executed, i.e. 

all operators that are after the word THEN. If <condition> if this is not true, then in the first method, the 

program continues from the next line. In the second method, <no > operators are executed, i.e. all operators 

that are after the word ELSE. 

12. Cycle operator.  

             To solve many problems, often the program must be repeated many times. The program should be 

organized in a cycle. To do this, use special loop operators FOR and NEXT (or the transition operators 

described above, for example: 200 IF X<P THEN 30 as long as the condition in line 200 is met). The FOR 

statement sets the loop header, and the NEXT statement ends the loop. Between these two operators, the 

operators that form the body of the loop are written. FOR i=i1 TO i2 STEP i3, where the values i, i1, i2, i3 

have the same values as the entries in the "start of cycle" block».  

The FOR loop is most often used when the number of iterations (circles) to be performed is known in 

advance. The FOR statement has the following syntactic structure: 

line number FOR < parameter>= < start> TO <end> STEP < step> 

. 

The body of the loop 

. 

line number NEXT <operator> 

FOR-operator name (translated from English "for") 

NEXT-auxiliary word (translated from English "next") 

TO-auxiliary word (translated from English "to") 

STEP-auxiliary word (translated from English " step») 

For example, you need to raise 2 to the 5th power, the counting cycle will be smoothed as follows:  

  10 f=1; 

  20 FOR i=1 TO 5 

  30 f=f*2  

  40 NEXT i 

 

        The statement that ends the loop is written as NEXT I, where I is the loop parameter. The NEXT 

statement changes the value of the loop parameter by the value of the I3 step specified in the loop 

header,and returns the program to the first command in the loop body. This happens until then, until the 

parameter reaches its limit value. 

Example 1. 

10 FOR I=0 TO 10 STEP 2 

20 PRINT Z=I^2 

30 NEXT I 

    After executing this program, six numbers appear on the display screen: 0,4,16,36,64,100. 

The loop step can also take negative values. 



Example 2: 

10 FOR I=10 TO 0 STEP –2 

20 PRINT Z=I^2  

30 NEXT I 

And in this case, the sequence of displaying numbers on the screen will be the reverse: 

100,64,36,16,4,0. 

Nested cyclic processes. 

There may be cases when you need to repeat a certain sequence of operators inside the loop body, i.e. 

organize an internal loop. This structure is called a loop in a loop or nested loops. The depth of nested loops 

(i.e. the number of nested loops) can be different.  

When using this structure, to save machine time, all operators that do not depend on the parameter of the 

inner loop must be moved from the inner loop to the outer loop. 

Example of nested loops for 

Calculate the sum of the elements of the given matrix A (5,3). 

13. User function

The programmer can define mathematical functions that are frequently used in the program at his 

own discretion, and then use them as standard built-in functions such as SIN, COS LOG, and so on. the 

user's function is Defined using the DEFFN operator (the service word DEFFN is formed by an abbreviation 

of two English words: DEFINITION ) and FUNCTION), which is written as:  

DEFFN <Fn name> (<simple. num. AC.>) = <arithmetic. expression> 

Here < name FN > is a number or letter of the Latin alphabet that serves as a symbol for the defined 

function. Example of a function definition: 

DEFN A(X) = X ^ 2 + 5 * X + 6 

If during the program execution it is necessary to use the value of a new function defined in the program 

with a specific value of its argument, it is enough to insert the identifier of this function in the appropriate 

place of the form FN, < Fn name>, followed by the desired argument value in parentheses instead of 

<simple numeric variable> that serves as a formal parameter. So, for example, a call to the function a(X) 

defined above can be made by calling: 

FNA(3) 

        The action of the DEFFN operator is called only when the FN function is mentioned. IT is not an 

executable operator in itself and can be placed anywhere in the program. The right-hand side of the function 

definition FN can include other defined functions, but if, for example, function A calls function B, then B 

cannot call A (an infinite loop is obtained). 

14. Arrays

 An ARRAY is a set of data of the same type (either numbers or string characters), and all this data is stored 

in one place in the computer's memory in cells ordered by numbers. 

For example: 

1. A flock of birds

2. Students



3. The seats in the cinema

4. Apartment houses

When working with arrays, we will use the following terminology: 

Array name - one or more Latin characters, to which, depending on the type of "stored" variables, the signs 

$,%,! . 

Cell - a place to store data; 

The array element data is stored in the cell array; 

Index - the bin number; 

Dimension - number of indexes; 

Visually, the array can be represented as a set of numbered "boxes", each of which can contain only one 

data. Sometimes this data may match the cell number. 

1 2 3 4 5 6 

34 45 2 0 5 -35 

where: 

a is the array name; 

1, 2, 3, 4, 5,6 - indexes ( ordinal number of the " box"); 

34, 45, 2, 0, 5,-35 - array elements (mailbox contents); 

Array A has a dimension of one because when accessing elements, it is enough to specify an address 

consisting of a single number-the number of the "box". The size of array A is 6, because it has 6 elements. 

Arrays of this type are called one-dimensional. Their elements are written as A(1), A (2), and  

e.t.s. 

For example: 

A(1)=34 (the first cell in array A contains the number 34) 

A(2)=45 (the second cell of array a stores the number 45) 

A(3)=2 

A(4)=0 

A (5)=5 

A (6)=-35 

From several one-dimensional arrays of the same length, you can "build" a two-dimensional array: 

А 1 2 3 4 

1 8 7 2 13 

2 5 1 0 3 

3 8 7 9 15 

The figure shows an array consisting of 3 rows and 4 columns (often simply said: a two-dimensional 3-by-4 

array). In two-dimensional arrays, each cell has two indexes: a row and a column. The elements of this two 

dimensional array A are written as follows: 

A(1,1) AND(1,2) AND(1,3) AND(1,4) AND(2,1),..., A(2,4) AND(3,1),..., A(3,4) 

The values of the elements in this array are as follows: 

А(1,1) = 8    А(1,2) = 7  А(1,3) = 2   А(1,4) = 13 

А(2,1) = 5    А(2,2) = 1  А(2,3) = 0   А(2,4) = 3 

А(3,1) = 8    А(3,2) = 7  А(3,3) = 9   А(3,4) = 15 

When solving medical, sociological, mathematical, and any other problems, one often has to deal 

with ordered groups of numbers. So any table contains ordered data, since it is always clear from it what 

characterizes each number A(i, j) located at the intersection of the i-th row and the j-th column. 



Since when using arrays, a large number of variables are used that must be located in one memory 

location, it becomes necessary to allocate computer memory space for an array (they talk about reserving 

memory for an array)  

Before using an array in a program, it must be described (declared) by the DIM operator. Description 

of an array is reduced to declaring its name with maximum index values in parentheses. You can use a single 

comma operator to describe multiple arrays. 

Examples: 

DIM A(20) - reserve space for a one-dimensional array of numbers a of size 20; 

DIM MD$(10) - reserve space for a one-dimensional array of MD$ character strings of size 10; 

DIM B%(10.10) - reserve space for a two-dimensional array of integers in size 100 (10x10); 

Note: 

It is usually said that the operator DIM A (20) reserves space for 20 elements of the array A, but in fact 21 

cells are reserved, since the numbering of cells begins with 0. But since we are more used to starting with 1 , 

the first cell ("zero" ) is simply not easily used. 

Examples 

DIM B(5,3) - specifies a two-dimensional array B with six rows (not five) and four columns. 

     DIM C1(4), M (2,2), K (255) - set a one-dimensional array C1(4) with five elements, a two-dimensional 

M with three rows and three columns, and a one-dimensional array K of 256 elements 

In addition to one-dimensional and two-dimensional arrays, there can be three-dimensional and other n-

dimensional arrays. The "dimensionality" of arrays is determined by the number of indexes specified in 

square brackets in order to define an array element.  

Example: 

A (7) - A-one-dimensional array 

S (2,-3) - S is a two-dimensional array 

W (1,0,0) - W-three-dimensional array 

Z (-1,3,4,3,0) - Z-five-dimensional array 

In practice, one-dimensional arrays are most often used, less often two-dimensional arrays, and much less 

often large-dimensional arrays. 

Example 2. 

Write the table to a two-dimensional array and print it on the display screen: 

7,6         5,3        2 2,4  

3 6,5      -1         -8,2 

0 8        6 3,2 

Program: 

10 DATA  7.6 ,5.3,2,2.4,3,6.5,-1,-8.2,0,8,6,3.2 

20 DIM A(2,3) 

30 FOR I=0 TO 2 

40 FOR J=0 TO 3 

50 READ A(I,J) 

60 PRINT A(I,J) 

70 NEXT J 

80 PRINT 

90 NEXT I 

15 Subprogrammes. 

A subroutine in basic is a program located inside the main program. 

A subroutine is a logically complete section of the computational process that is completed by the RETURN 

statement. The subroutine is located at any location in the General program, and its lines are numbered in the 

usual order. The number of the first line of the program is essential, since it is used when accessing the 

subroutine.  

The subroutine is accessed using a special GOSUB operator (short for the English words 

GOTO (go to) and SUBROUTINE (subroutine)). 

After the GOSUB service word, a number is specified - the number of the line that the subroutine starts 

with, for example: 



GOSUB 190 

After accessing the subroutine, all the actions provided for in it are performed, and when the 

queue reaches the RETURN operator, it returns to the main program, i.e. it transfers control to the operator 

that is behind the corresponding GOSUB subroutine call operator. 

For example: 

20 REM main program 

30 GOSUB 190 

40 PRINT Y 

190 REM subroutine: 

200 Y=SIN (X)+COS (X): RETURN 

The "Resume" Method. Students are divided into subgroups. The teacher explains the purpose and 

course of the lesson, and also distributes material where various ways to solve a particular problem or 

problem are given. Group members will need to identify the positive and negative aspects of ways to solve 

the problem. Each group explains their responses. All groups will have to participate in the discussion of 

responses. At the end of the lesson, the teacher supplements the team responses and inserts grades. 

Topic 

Way №1 Way №2 Way №3 
Advantage Disadvantage Advantage Disadvantage Advantage Disadvantage 

The "concept Analysis" method. The group is divided into subgroups-teams. Materials on the topic of 

the lesson are distributed. Students get acquainted with this material and describe, i.e. comment on each 

concept. The teacher shows slides with correct answers. Students check their answers and thus consolidate 

their knowledge. 

The concept The essence of the concept 

Control question: 

1. List the main stages of solving problems on a computer?

2. What is an algorithm?

3. what is a program?

4. what is a programming language?

5. what algorithmic programming languages do you know?

6. List the characters included in the basic alphabet?

7. What is costante?

8. What is a variable?

9. What distinguishes the command from the operator?

10. Which character can be used instead of the PRINT operator:

Literature: 

(O: 3, 4; D: 2, 7, 8; MS: 2, 4) 

4-Topic: text editors and working in Them. Spreadsheet. Computer graphics programs. 

1.1. Model of technology training 

Duration of the lesson-2 hours        Number of students: 30-60 

Form of studies Informational lecture 

Plan of the lecture 

1 - Word Text editor. 

2-Word 2007 Interface. 

3 - the spreadsheet program 

MS Excel. 

4-Computer graphics. 

Micrososoft Word-the basis of any office and, perhaps, the most 

necessary and popular program in all Microsoft Office. In addition, 

using the example of Word, it is very convenient to study the interface 

of all other programs in the Microsoft Office family: by studying Word, 

you select the key to all your office programs (just as by studying 

WordPad, you were preparing to work with Word itself). MS Excel 

spreadsheet editor is another Micrososoft program that is part of The 



Microsoft Office application package and allows you to automate the 

computing process. 

The aim of the lesson: Give General information about text editing and the programs used for 

this purpose. Introduce students to the capabilities of the Word text 

editor. Show and explain the program interface and how to use various 

controls and editing. 

Training method Monitoring and evaluation 

Type of training Collective 

Tools training Tutorials, textbooks, lecture text, projector, computer 

Training conditions Methodically equipped audience. 

Monitoring and evaluation 

1.2. Technological map of the lecture 

Stages of work and 

allotted time 

Stages of conducting a lesson by a teacher Studying 

Preparatory stage. 1. Prepare a training component of the topic.

2. Prepares presentation slides for the topic.

3. Make a list of literature used for the development of

the subject. 

1. . Introduction to

the topic 

(10 min) 

Will introduce you to the purpose and purpose of the 

topic. 

Listen 

2. Main stage

(55 min) 

1. Explains the topic and demonstrates the presentation.

2. Applies the posters.

Listen 

Record 

3. The final stage

(10 min) 

Makes a final conclusion. Listen 

4. Self-study tasks

(5 min) 

Declares tasks for independent work. Records 

1 Word text editor. 

Micrososoft Word-the basis of any office and, perhaps, the most necessary and popular program in 

all Microsoft Office. In addition, using the example of Word, it is very convenient to study the interface of 

all other programs in the Microsoft Office family: by studying Word, you select the key to all your office 

programs (just as by studying WordPad, you were preparing to work with Word itself). 

Microsoft Word (often MS Word, WinWord, or simply Word) is a word processor designed for 

creating, viewing, and editing text documents, with local application of the simplest forms of table-matrix 

algorithms. A word processor produced by Microsoft as part of the Microsoft Office Suite. The first version 

was written by Richard Brodie for IBM PCs using DOS in 1983. Later versions were released for Apple 

Macintosh (1984), SCO UNIX, and Microsoft Windows (1989). 

Microsoft Word owes a lot to Bravo, a word processor with an original graphical interface developed 

at the Xerox PARC research center. The Creator of Bravo, Charles Simonyi (Charles Simonyi) left PARC in 

1981. That same summer, Simoni poached Brody, with whom he worked on Bravo. 

The first release of Word for MS-DOS took place in late 1983. It was poorly received by the market, 

sales were reduced by the presence of a competing product-WordPerfect. 

The first version of Word for Windows, released in 1989, sold for $ 500. It demonstrated the 

development path chosen by Microsoft: like Windows itself, it took a lot from the Macintosh, and used 

standard keyboard shortcuts (for example, CTRL-S to save a file).  

Microsoft Word is the most popular of the currently used word processors, which has made its binary 

document format the de facto standard, and many competing programs have support for compatibility with 

this format. The ".doc" extension on the IBM PC platform has become synonymous with the Word 97-2000 



binary format. The latest versions of MS Word 2007, Word 2010, and Word 2013 " use the default ".docx" 

format based on XML-Microsoft Office Open XML.  

Versions for Microsoft Windows: 

1989 November-Word for Windows 

1991 Word 2 for Windows 

1993 Word 6 for Windows (the number "6" was introduced to continue the line of DOS version 

numbers, the same numbering with Mac versions and with WordPerfect, the market leader among word 

processors at that time) 

1995 Word 95, also known as Word 7 

1997 Word 97, also known as Word 8 

1999 Word 2000, also known as Word 9 

2001 Word 2002 or in Word 10 

2001 Word XP see above. 

2003 Word 2003, also known as Word 11, but officially referred to as Microsoft Office Word 2003 

2007 Word 2007, a revolutionary interface change, support for OOXML (docx) format 

2010 Word 2010 

2012 Word 2013 

With Word, you can not just type text, but also design it to your liking: include tables and graphs, 

images, and even sounds and video images. Word will help you create a simple letter and a complex three-

dimensional document, a bright greeting card or an ad block. 

In terms of its functions, Word is very close to publishing systems and layout programs. This means that 

in this editor you can fully prepare for printing (or, as experts say, make up) a magazine, newspaper, or even 

a book, or create a WWW page on the Internet... 

The basic features of Microsoft Word: 

* The ability to create a new document using special templates (in particular, Word includes templates

for standard letters, greeting notes, reports, faxes, and a number of other office documents). 

* Ability to simultaneously open and work with a large number of documents.

* Automatically check spelling, grammar, and even style when entering a document.

* Automatic correction of the most frequently repeated errors.

Advanced document formatting features. Unlike WordPad, Word allows document alignment on both 

edges, multi-column layout. Use styles to quickly format the document. The ability to automate the input of 

repetitive and standard text elements. Convenient mechanisms for working with links, footnotes, and 

footers. Include elements created in other Microsoft Office programs in the text: graphics, spreadsheets and 

graphs, sounds, video images, and so on. Ability to prepare simple spreadsheets and hypertext documents on 

the Internet. 

* Ability to work with mathematical formulas.

* The ability to automatically create pointers and table of contents of the document.

* The ability to send the finished document directly from Microsoft Word to Fax or email (in both

cases, the user's computer must be equipped with a modem). 

* Advanced indexing capabilities for the finished document.

* Built-in hint Wizard and extensive help system.

2. Microsoft Word 2007 interface.

The main element of the Microsoft Word 2007 user interface is a ribbon that runs along the top of each 

application window, instead of the traditional menus and toolbars. (Fig. 4). 

Figure 4. Feed 



You can use the ribbon to quickly find the necessary commands (controls: buttons, drop-down lists, 

counters, checkboxes, etc.). the Commands are arranged in logical groups, collected on tabs. 

You can't replace the ribbon with toolbars or menus from previous versions of Microsoft Word. 

You can't delete a feed either. However, you can hide (collapse) the ribbon to enlarge the workspace. 

Click the quick access toolbar settings button (figure 5). From 

the menu, click Collapse ribbon. 

The feed will be hidden and the tab names will remain (Fig. 6). 

Рис.4. Лента 

Fig. 5. Minimize the ribbon

Fig. 6. A window with a broken tape 

To use the ribbon in a collapsed state, click the name of the desired tab, and then select the option or 

command that you want to use. For example, when a tab is collapsed, you can select text in a Word 

document, click the Home tab, and select the desired font size in the Font group. After selecting the font 

size, the ribbon will collapse again. 

To quickly collapse the feed, double-click the name of the active tab. To restore the feed, double-

click the tab. 

You can also press Ctrl + F1 to minimize or restore the feed. 

The content of the feed for each tab is constant and unchangeable. You can't add or remove an item 

from a tab. 

The appearance of the ribbon depends on the width of the window: the larger the width, the more 

detailed the tab elements are displayed. The figures show how the Home tab ribbon is displayed with 

different window widths. 

Fig. 7. The display of the ribbon Home tab when window width is 1280 dots

Fig. 8. The display of the ribbon tab when the Main window width 1024 pixels Tabs 

By default, the window displays seven permanent tabs: Home, Insert, page Layout, Links, mailing 

Lists, Review, and View. 

To go to the desired tab, just click on its name. 



Each tab is associated with the type of action being performed. For example, the Home tab, which 

opens by default after launch, contains elements that you may need at the initial stage of work, when you 

need to type, edit, and format text. The page Layout tab is used to set parameters for document pages. 

The Insert tab is used for inserting various objects into documents. And so on. 

You can also display another tab: Developer. 

Click the Microsoft Office button. Then click Word Options. 

In the General tab of the Word Options dialog box, select the appropriate check box (figure 9). 

 
Fig. 9. The display of the Developer tab 

The Developer tab contains tools for creating macros and forms, as well as functions for working 

with XML. 

Files and templates created in previous versions of Word may contain custom toolbars. In this case, 

when you open such files in Word 2007, another permanent tab appears – add-Ons (Fig. 10). 

 
Figure 10. Add-Ons Tab 

This tab contains toolbar elements created in previous versions of Word. Each toolbar occupies a 

separate row in the tab ribbon. However, some elements that were present in the toolbars may be missing 

in Word 2007. 

The standard set of tabs is replaced when you switch from document creation mode to another mode, 

such as Preview (figure 11). 

 
Figure 11. Preview Tab 

In addition to permanent tabs, there are a number of contextual tabs, for example, for working with 

tables, figures, charts, etc., which appear automatically when you switch to the appropriate mode, or 

when you select an object or set the cursor on it. 

For example, when creating headers and footers, the corresponding tab appears (Fig. 12. 

 
Fig. 12. Contextual tab to Work with headers and footers/Designer 



In some cases, several tabs appear at once, for example, when working with tables, the Designer and 

Layout tabs appear (figure 13). 

 

 
Figure 13. Context tabs for working with tables 

When you deselect or move the cursor, the context tab is automatically hidden. 

There are no ways to force the display of contextual tabs. 

Control element 

Controls on feeds and tabs are grouped according to the type of action being performed. For 

example, on the Home tab has groups for clipboard, set the font settings of the paragraphs, work with 

styles and editing (see Fig. 4). 

Controls are normal buttons, drop-down buttons, lists, drop-down lists, counters, buttons, menus, 

check boxes, badges (buttons) group. 

Buttons are used to perform an action. For example, the Bold button in the Font group on the Home 

tab sets the font to bold. To click a button, click on it with the mouse (Fig. 14). 

 

 
 

Figure 14. Using a normal button 

 

In some cases, a dialog box appears after you click the button. 

Drop-down buttons have an arrow in the right or lower part. Clicking the arrow opens a menu or palette 

where you can select the desired action or parameter. The selected action or parameter is stored on the 

button, and you don't need to open the button to apply it again. For example, you can click the 

Underlined arrow in the Font group on the Home tab and select the underline method (figure 15). To 

assign the same underline again, you don't need to click on the arrow, just click on the button itself.

 
Figure 15. Using the drop-down button 



 

In the list, you can select a parameter to apply. To do this, click on it with the mouse. For example, in the 

table Styles list on the Designer tab, you can select a table layout option (figure 16).

 
 

Fig. 16. Use the list 

 

You can use the Forward and Back buttons to view the list within the feed. But usually the list is 

expanded by clicking the Advanced parameters button (see figure 16). 

The corresponding menu commands can be displayed at the bottom of the expanded list (Fig. 17).

 
Figure 17. Expanded list 

 

When using the drop-down list, click the list arrow and select 

the desired parameter. For example, in the font Size drop-down list 

of The font group on the Home tab, you can select the font size 

(figure 18). 

in most cases, you can click in the drop-down list box, enter 

the value of the desired parameter using the keyboard, and press 

Enter. 

Counters are used to set numeric values for any parameters. To 

change the value, use the counter buttons More (Up) and Less 

(Down). For example, in the Interval counter of the Paragraph 

group on the page Layout tab, you can set the value of the interval 

after the paragraph (figure 19). 

 
Figure 18. the drop-down list is 

Used 



 
Figure 19. Using the menu button 

 

In some cases, selecting a button menu command opens a dialog box. 

Checkboxes are used to apply a parameter. For example, the Show or hide View tab group 

checkboxes (figure 20) determine how the window is displayed. 

 
 

Fig. 20. Use check boxes 

 

To select or clear a check box, just click on it. 

The group icon (button) is a small square in the lower-right corner of the group of elements in the tab. 

Clicking the icon opens the corresponding dialog box or task area for expanding functionality. For 

example, the Font group icon on the Home tab opens the Font dialog box (figure 21).

 
Figure 21. Using the group icon 

 

 

 

 

 



Office button 

The "Office" button is located in the upper-left corner of the window. Clicking the button displays a 

menu of basic commands for working with files, a list of recent documents, and a command for 

configuring application parameters (for example, Word Parameters) (figure 22).

Figure 22. "Office" Button and menu " 

Mini toolbar 

The mini toolbar contains the main most frequently used elements for formatting the document text. 

The mini-panel appears automatically when you select a document fragment. Initially, a semi-transparent 

mini-panel is displayed (figure 23). 

Figure 1.23. semi-Transparent mini toolbar 

The mini-panel will become bright as soon as the mouse pointer is pointed at it (figure 24). To use 

the mini-panel, click any of the available commands. 

Figure 24. Mini toolbar 

The composition of the mini-toolbar elements is constant and unchangeable. 

Inserting a date and time in Word 2007 



Place the cursor where you want to insert the date and / or time, and then click Insert on the Insert tab 

in the Text group/Date and time (figure 36). 

in the date and time dialog box (figure 37), select the language and format of the inserted data. 

 
Figure 36: Inserting a date and / or time in a document 

 
Fig. 37. Selecting date and time parameters 

If you select the Update automatically check box in the date and time dialog box before inserting it 

(see figure 37), the date and time inserted in the document will be updated every time the document is 

opened. If you want to update the date and time after opening the document, place the cursor on this field 

and press the F9 keyboard key. 

Spell check when entering text 

When you enter text in a document, a red wavy line underlines words that contain spelling errors, as 

well as repetitions of the same word. The green wavy line highlights words, punctuation marks, sentence 

fragments, and entire sentences that contain grammatical and stylistic errors, as well as punctuation errors. 

To correct a spelling error, right-click on the underlined word and select the correct spelling in the 

context menu (Fig. 38). 

 



Figure 38. Correcting a spelling error in a document 

Spellings of words are suggested only when there are similar words in the dictionary. Otherwise, the context 

menu will indicate that there are no options. Then make the correction yourself. 

To correct a grammatical error, right-click on the underlined text. The context menu will describe the 

detected error or suggest a way to fix it. 

 

Spell check in the entire document 

The document may contain errors that have not been corrected or noticed before. This can be text 

copied from an external source. To avoid searching for text fragments underlined with red and green wavy 

lines, run a spell check throughout the document. 

On the Review tab, in the Spelling group, click Spelling. 

If a spelling or grammatical error is detected, the Spelling dialog box appears. The window title will also 

indicate the verification language.  

For spelling errors, a text fragment with the misspelled word highlighted in red is displayed at the top 

of the Spelling dialog box. In the lower part of the window, you can see the correct spelling of the word(see 

figure 39). For grammatical and stylistic errors, an error sentence is displayed at the top of the Spelling 

dialog box. Grammatical notes can be shown in the lower part of the window (Fig. 40).  

To correct a spelling error, select the correct spelling and click Replace or Replace all. 

If there are no correct spellings of a word or a specific grammatical recommendation in the lower 

part of the window, then you should correct the error yourself. You can do this in the upper part of the 

window, and then, depending on the type of error, click Replace, Replace all, or Change. 

 
Fig. 39. Identified spelling error 

 
Figure 40. Comment on the detected grammatical error 

 

 



Vertical alignment of the text. 

The concept of a paragraph 

A paragraph is a fragment of text from one press of the Enter key to the next. A paragraph is also a 

fragment from the beginning of the document to the first press of the Enter key. In table cells, a paragraph is 

a fragment from the beginning of the cell to the nearest Enter key press or cell end sign. 

Paragraphs can have different sizes: from one line to any number of lines. There may be an empty 

paragraph that does not contain text. When selecting a paragraph, it is important that the non-printable end 

of paragraph mark is included in the selection area. To display these characters, on the Home tab, in the 

Paragraph group, click Display all characters (figure 41). 

 
Fig. 41. The paragraphs in the document 

When setting parameters for a single paragraph, it is not necessary to highlight it. It is enough if the 

cursor is located in this paragraph. If several paragraphs are drawn up at once, they must be highlighted. 

Text search 

You may need to search for a word or text in the document. 

 

field (figure 45). 

he found text will be 

highlighted sequentially in the document. 

To find all occurrences of a word or phrase at once, click Select while reading and select Select all. 

In the Find tab of the Find and replace dialog box, you will see the number of items found. The found text 

will be highlighted in yellow throughout the document (figure 46). This selection will continue after the 

dialog box is closed. 

 



Figure 45: Searching for text in a document

Figure 46. Selecting the found text in the document 

To deselect, in the Find tab of the Find and replace dialog box, click the Selection while reading 

button and select Deselect (see figure 46). You can also remove the selection using the mini toolbar or the 

Home tab features. 

Replacing text 

You may need to replace some text in the document. 

 On the Home tab, in the Edit group, click Replace. 

 In the Replace tab of the Find and replace dialog box, enter the text you are looking for in the Find 

field, and in the Replace with – replace text field (figure 47). 

 to find the next occurrence of text in the document, click Find next. 

To replace an occurrence of text in a document, click Replace. After clicking the Replace button will 

be allocated to the next occurrence of the specified phrase. 

To replace all occurrences of text in a document, click Replace all. 

Figure 47: Replacing text in a document 

Inserting Word 2007 page numbers 

Page numbers in Word 2007 are automatically assigned to the entire document at once. 

Page numbering can be performed in any document display mode, but it is more convenient to do it 

in the page Layout mode. 

In the insert tab, in the header and Footer group, click page Number in the list that appears, select one 

of the methods of numbering (Top of page, Bottom of page or page margins), and then one of the numbering 

options (Fig. 48). 

After inserting the document numbers will be automatically transferred to the operation mode with 

the headers and footers. 



Figure 48: Inserting page numbers 

Depending on the selected numbering option, the page number can be inserted as a regular field or in 

a special graphic object – labels. 

You can insert page numbers in the header and footer mode. 

 In the headers and Footers group of the Working with headers and footers tab/Designer, click page 

Number in the list that appears, select one of the methods of numbering (Top of page, Bottom of page or 

page margins), and then one of variants of numbering. 

 Exit the header and footer mode. 

If you set different headers and footers for even and odd pages when working with headers and 

footers, insert the page numbers separately for even and odd pages. The numbering will remain continuous. 

Renumbering 

On the Insert tab, in the headers and Footers group, click page Number, and then click format page 

numbers in The list that appears. 

In the page number Format dialog box (figure 49), in the number Format drop-down list, select the 

page numbering method, and in the start with counter, set the number from which to number the pages. 

Fig. 49. Change page numbering 



If you set different headers and footers for even and odd pages when working with headers and 

footers, you must change the numbering method separately for even and odd pages. 

Deletion of the numbering 

Regardless of how you insert page numbers, to delete all the numbers on the Insert tab, in the headers 

and Footers group, click the page Number button and select Delete page numbers from the menu that 

appears. 

You can also delete page numbers in the header and footer mode. To do this, select the page number 

or the label frame where it is located and press the Delete key. 

Creating headers and footers. Working with columns. 

Working with headers and footers 

Headers and footers are areas located in the upper, lower, and side fields of each page of the 

document. 

Headers and footers can contain text, tables, and graphic elements. For example, footers can include 

page numbers, time, date, company logo, document name, file name, and so on. 

All pages in a document can have the same header and footer. But you can make the headers and 

footers of even and odd pages differ, and the footer of the first page differs from all the others. You can also 

create independent headers and footers for each section of the document. 

You can set headers and footers yourself or use a collection of standard header blocks. 

Headers and footers are shown in the Word window only in the page Markup display mode and in 

the preview mode. 

To start creating and/or editing headers and footers, double-click in the upper or lower field of the 

page. This will automatically open a special tab for Word 2007-Working with headers and 

footers/Constructor (Fig. 50). 

Figure 50. Working with headers and footers 

To switch between the header and footer, as well as between the headers and footers of different sections, 

you can use the Navigation group buttons on the Working with headers and footers tab/Constructor (see Fig. 

50) or just scroll through the document.

If the content of the header exceeds the height set for it, the field size does not increase, but the text on the 

page moves down (when working with the header) or up (when working with the footer). 

To finish working with the headers and footers and return to the main part of the document, click Close 

header window (see Fig. 50) or press Esc. 

Changing headers and footers 

To change the header and footer, go to the header and footer display mode and add both text and 

other footer elements. Change the design if necessary. 

Deleting headers and footers 

Regardless of how you created it, to completely delete the header, on the Insert tab, in the Headers 

group, click the Header button and select Delete header from the menu that appears. Similarly, you can 

delete the footer. 

The headers and footers will be deleted throughout the document. 

Print the document 

Print the entire document in one copy 

To print the entire document in a single copy, simply select Print from the Office button menu, and then 

select Quick print from the subordinate menu (see figure 57). 

Configuring print settings 



To configure document printing options, select Print from the Office button menu, and then Print 

from the subordinate menu (see figure 57). The settings are made in the Print window (Fig. 58) 

 
Fig. 58. Customize the print settings of the document 

 In the Printer section, in the Name drop-down list, if you have multiple printers connected to your 

computer or local network, you can select the printer to print the document to. 

In the Pages section, you can print one page that currently has the cursor on it (the current button), or 

multiple pages by entering the numbers of the pages to print (the switch and the number field). You can also 

print only the selected part of the document (select the selected part switch). 

In the Copies section, in the number of copies counter, you can specify the number of copies to print. 

Select the parse by copy check box so that each copy is printed in the page order of the created document. 

In the Zoom section in the number of pages per sheet drop down list you can select the number of 

pages in the document (1, 2, 4, 6, 8 or 16), which should be printed on each sheet of paper. Naturally, 

several pages on a sheet will be printed at a reduced scale. 

In the Enable drop-down list, you can select one of the options to print all pages, even or odd pages. 

 

General information about tables 

Tables in Word documents are used, for the most part, to organize the presentation of data. 

Calculations can be made in tables, and tables can be used to create document forms. You can use tabular 

data to create charts. 

Table cells can contain text, graphic objects, and nested tables. 

To insert a table, use the Insert tab. 

 
Figure 1. Tabs for working with tables 



To work with tables, Microsoft Word uses the context tabs Designer and Layout of the Working with tables 

tab group (figure 1). These tabs are automatically displayed when the cursor is located in any cell of an 

existing table. 

In addition to regular Word tables, documents can contain tables imported from Microsoft Excel and 

Microsoft Excel tables created directly in the document. 

9.2. Creating and modifying tables.  

Inserting a Microsoft Word table 

The table is always inserted at the point in the document where the cursor is currently located. It is best to 

put the cursor at the beginning of the text paragraph, before which the created table should be located. 

To quickly insert a simple table, click the table button on the Insert tab and select the required number of 

columns and rows in the tableau that appears (Fig. 2). when you hover the mouse pointer, the preview 

function is triggered and the created table is displayed in the document. The table takes up the entire width 

of the page and has columns of the same width. 

Figure 2. Inserting a simple table 

You can configure some parameters of the created table. 

 Place the cursor where the table you are creating will be located. 

 Click the table button on the Insert tab and select Insert table (see figure 2). 

 in the Insert table window (figure 3), select the required number of rows and columns, as well as the auto-

selection method. When you select the constant mode, you can set the width of the table columns.

Fig. 3. Selecting parameters for the inserted table 

When creating a table, you can use existing Microsoft Word templates or your own previously created 

tables. 

ill be located. 

Express table list are usually located in the General section at the end of the list. 



Fig. 4. Choice Express table 

As a result, a ready-made table containing text and layout will be inserted into the document (Fig. 5). 

the Layout of built-in Microsoft Word Express tables depends on the selected document theme. The inserted 

table can have a header. You can also change the table layout. 

Fig. 5. Inserted in the document Express table 

Calculations in the table 

 In Word tables, you can perform simple calculations using formulas.

 Place the cursor in the cell where you want to get the calculation result.

 On the Layout tab, in the Data group, click Formula. If this button is not displayed, click the data

button arrow and then click It after the button is displayed. 

 In the Formula window (figure 29), enter a formula in the Formula field. You can use the Insert

function field list to select a function. If desired, in the list of the number Format field, you can select 

the numerical result of the calculation (numeric with a digit separator, monetary, percentage). 



Figure 29: creating a formula in a cell 

In some cases, the formula in the Formula window can be written automatically. For example, if the 

cell is located below the cells with numbers, the formula =SUM(ABOVE) will be written, which means 

summing all the cells above. If the cell is located to the right of the cells with numbers, the formula 

=SUM(LEFT)is written, which means summing all the cells on the left. If this is what you want, you can 

apply these formulas. Otherwise, clear the field and enter the formula yourself. 

The formula is inserted into a table cell as a special field. If you change values in calculated cells, the 

result will not automatically change. To recalculate, select a cell and press F9. 

Graphical features 

A Microsoft Word document can contain various graphic objects: drawings from image files and 

drawings from the Microsoft Office clip collection, organizational charts, and regular charts. To some 

extent, graphics can also include labels and WordArt objects. Finally, you can use Word to create simple 

drawings. 

To insert graphic objects into a document use the elements of the illustration group And some 

elements of The text group of the Insert tab. 

To work with drawings from image files and a collection of clips in Microsoft Word, use the context 

tab Format of the group of tabs Working with drawings. This tab is automatically displayed when you select 

a drawing. To select a drawing, click on it with the mouse. Drawing markers are a sign of selection (Fig. 

30). 

Figure 30. Format Tab and selected image 

To delete a drawing, just select it and press the Delete key. 

Inserting drawings 

Inserting a picture from a graphic file 
 Microsoft Word allows you to insert images from image files in all major image formats: jpeg, bmp,

gif, tiff, etc.

 Move the cursor to the place where the image will be inserted. If necessary, you can then move the

drawing to another location. 

 Click the picture button on the Insert tab.

 In the Insert image window (figure 31), go to the folder with the desired image file.

 Double-click the image file icon or select the icon and click Insert.



Fig. 31. Selecting the file for the inserted image 

Inserting a picture from the Microsoft Office clip collection 

Clips in Microsoft Office are multimedia files: a drawing, sound, animation, or movie. You can use 

either the clip collection that comes with Microsoft Office or, if you have an Internet connection, the web 

collection from the Microsoft website. 

 Move the cursor to the place where the image will be inserted. If necessary, you can then move the 

drawing to another location. 

 Click the Clip button on the Insert tab, and the Clip task area will appear (figure 32). 

In the Search field, enter the keyword of the drawing you are looking for. Click the View field arrow and 

select the collections that you want to search. Click the arrow in the Search for objects field and select the 

check box next to the names of the types of clips that you want to find. Click Start.  

The Clip task pane displays thumbnails of the found drawings (figure 33). Click the thumbnail to insert 

the drawing into the document. 

Figure 32. Clip task Area Fig. 12.4. The choice of pattern 

If you can't find the image you need using keywords, you can use the clip Organizer. 

In the lower part of the Clip task area (see figure 33), click the Organize clips link, and the Microsoft clip 

Organizer window will appear (figure 34). 

Use the list of collections on the left side of the window to select the appropriate section (theme) for images. 



With the left mouse button pressed, drag the thumbnail image from the clip Organizer window to the Word 

document window.  

Figure 34. Searching for a drawing using the clip Organizer 

Changing the position of the drawing in the document 

Changing the flow mode 

 Initially, the drawing is inserted directly into the document text as an embedded object without text 

wrapping. 

 In order for the drawing to move freely in the document, you should set one of the text wrapping 

modes for it. 

  

  Click the text Wrap button in the Arrange group of the Format tabs. 

  In the menu that appears (Fig. 35), select one of the wrapping options. 

 
Figure 35. Changing the flow mode of the drawing 

For a drawing, you can choose one of the wrapping styles: Around the frame, along the contour, 

Behind the text, Before the text (figure 36) , or another. 



Fig. 36. Flow pattern 

12.1. General information about Microsoft Excel Spreadsheets. 

Microsoft Excel (hereinafter referred to simply as Excel) is a program for performing calculations and 

managing so-called spreadsheets. 

A spreadsheet is the main tool used for processing and analyzing digital information using computer 

technology. Although spreadsheets are primarily related to numerical or financial transactions, they can also 

be used for various data analysis tasks, providing the user with great opportunities to automate data 

processing. 

Excel allows you to perform complex calculations that can use data that is located in different areas 

of the spreadsheet and is related to each other by a certain dependency. To perform such calculations in 

Excel, you can enter various formulas in the table cells. Excel performs calculations and displays the result 

in a cell with a formula. Available formulas range from simple addition and subtraction to financial and 

statistical calculations.  

An important feature of using a spreadsheet is the automatic recalculation of results when changing 

cell values. For example, you can use Excel to perform financial calculations, record and control the 

organization's personnel, and so on. Excel can also build and update graphs based on the numbers you 

entered.  

4.2 Basic elements of an Excel spreadsheet 

To start or open Microsoft Excel on your computer, select the Microsoft Excel command in the main 

Windows menu (opens when you click the start button) in the All programs section. After that, the Excel 

shell is loaded, which opens an empty workbook. This file that Excel works with is called a workbook. A 

workbook in Excel is a file that stores and analyzes data. A workbook usually consists of several worksheets 

that can contain tables, texts, diagrams, and drawings.  

The book is a good organizational tool. For example, you can collect all documents (worksheets) 

related to a specific project (task) in one workbook, or all documents that are maintained by a single 

performer.  



A Microsoft Excel workbook consists of separate sheets (sometimes the term "worksheet"is used). A 

newly created workbook usually contains 3 sheets. You can add sheets to a workbook. The maximum 

number of sheets is unlimited. The leaves can be removed. The minimum number of sheets in a book is one. 

The sheets in the book can be arranged in any order. You can copy and move sheets, both in the 

current workbook and from other workbooks. 

Each sheet has a name. The names of the sheets in the workbook cannot be repeated. 

Sheet shortcuts are located at the bottom of the Microsoft Excel window. 

Sheets can contain tables, charts, drawings, and other objects. There can be sheets that contain only 

the chart. 

The sheet consists of cells combined into columns and rows. 

In Microsoft Excel 2003, the worksheet has 256 columns and 65536 rows. 

A Microsoft Excel 2007 worksheet contains 16834 columns. Columns are named with letters of the English 

alphabet. The column header contains one to three characters. The first column is named A, and the last 

column is named XFD. 

The sheet contains 1048576 rows. Strings are named with Arabic numerals. 

The base of the worksheet (figure 1) is a grid of rows and columns. A cell is formed by the intersection of a 

row and a column. The cell (s) selected by the mouse are called active. 

 
Fig. 1. Table elements 

A row in the worksheet is identified by the name (number) that appears on the left side of the 

worksheet. 

A column in the worksheet is also identified by the name (Latin letters) that appears at the top of the 

worksheet. 

Each cell has an address (link) consisting of a column header and a row header. For example, the top 

– left cell of the sheet has the address A1, and the bottom-right cell has the address XFD1048576. In 

addition, a cell (or range of cells) can have a name. 

A cell can contain data (text, numeric, dates, times, etc.) and formulas. A cell can have a note. In the 

active cell, you can enter and edit data directly in the cell or in the formula bar. 

When you open a previously created file, a workbook with the entered data appears in the Excel 

window. 

Files created by Excel 2003 have xls extension. Microsoft Office 2007 introduces a new XML-based 

file format. By default, documents created in Excel 2007 are saved with a new file name extension, which is 

obtained by adding the suffix "x" or " m " to the usual extension. The suffix " x "indicates that the XML file 

does not contain macros, and the suffix" m " indicates that the XML file contains macros. Therefore, the 

names of regular Excel 2007 files have the extension xlsx, not xls. 

XML formats offer a number of advantages-not only for developers and the products they create, but 

also for individual users and organizations. 

Files are automatically compressed, and in some cases their size may be reduced by 75 percent 

compared to previous versions of Excel. 

 

 



The Interface Of Microsoft Excel 2007 

When planning the release of the 2007 Microsoft Office system, developers set a goal to make the main 

Microsoft Office applications easier to use. As a result, the Microsoft Office Fluent user interface was 

created, which makes it easier for users to work with Microsoft Office applications and allows them to get 

better results more quickly. 

Tape 

The main element of the Microsoft Excel 2007 user interface is a ribbon that runs along the top of 

each application window, instead of the traditional menus and toolbars. (Fig. 2). 

 
Figure 2. Feed 

You can use the ribbon to quickly find the necessary commands (controls: buttons, drop-down lists, 

counters, checkboxes, etc.). the Commands are arranged in logical groups, collected on tabs. 

You can't replace the ribbon with toolbars or menus from previous versions of Microsoft Excel. 

You can't delete a feed either. However, you can hide (collapse) the ribbon to enlarge the workspace. 

1. Click the quick access toolbar settings button (figure 3). 

2. from the menu, click Collapse ribbon 

.  

 
Fig. 3. Minimize the ribbon 

3. the Feed will be hidden and the tab names will remain (Fig. 4).

 
Fig. 4. A window with a broken tape 

To use the ribbon in a collapsed state, click the name of the desired tab, and then select the option or 

command that you want to use. For example, when a tab is collapsed, you can select text in an Excel 

document, click the Home tab, and select the desired font size in the Font group. After selecting the font 

size, the ribbon will collapse again. 

To quickly collapse the feed, double-click the name of the active tab. To restore the feed, double-

click the tab. 

To minimize or restore the feed, you can also press Ctrl + F1 

. 

 

Tabs 



By default, the window displays seven permanent tabs: Home, Insert, page Layout, Links, mailing 

Lists, Review, and View. 

To go to the desired tab, just click on its name. 

Each tab is associated with the type of action being performed. For example, the Home tab, which 

opens by default after launch, contains elements that you may need at the initial stage of work, when you 

need to type, edit, and format text. The page Layout tab is used to set parameters for document pages. The 

Insert tab is used for inserting various objects into documents. And so on. 

office button" 

The "Office" button is located in the upper-left corner of the window. Clicking the button displays a 

menu of basic commands for working with files, a list of recent documents, and a command for configuring 

application parameters (for example, Excel Parameters) (Fig. 5). 

Figure 5. "Office" Button and menu" 

Some of the "Office" button menu commands have subordinate menus. In the new versions of Excel 

2010 and Excel 2013, the "Office" button is replaced with the "File" section» 

Mini toolbar 

The mini toolbar contains the main most frequently used elements for data formatting. 

Unlike other Office 2007 applications (Word, PowerPoint, And others), Excel 2007 does not display 

the mini-panel automatically when you select a sheet fragment. To display the panel, right-click on the 



selected area (Fig. 6).

Fig. 6. Displays a mini toolbar 

12.2. Entering and editing data. 

In each cell, or rather cell of the worksheet, a unit of information is entered: a symbol, a string of 

characters, a number, a formula, a built-in function, a graph, a drawing, a video or audio clip, etc.Although 

you can enter about 32 thousand characters in one cell, however, the recommended line size is no more than 

256 characters. This limit is determined by the speed of the computer and the size of its RAM. 

Use the scroll bars to move around the worksheet. In order to quickly move to the last row of the 

worksheet, press the Ctrl key on the computer keyboard and press the down arrow key, i.e., press a 

combination of keys . To quickly move to the last column of the sheet it is necessary to apply a combination 

of keys . To quickly return to the beginning of the sheet, i.e. to cell A1, use the Ctrl + Home combination. 

Entering and editing data is a monotonous operation that leads to rapid user fatigue. Before you start 

entering data, you should determine what data Excel distinguishes and what it can do with it. 

Microsoft Excel distinguishes between the following types of data: 

• Text;

• Numeric;

• Dates and times;

• Formulae;

• Functions.

Characters are displayed not only in the active cell, but also in the formula bar as you enter them. 

When you start entering data, Excel automatically analyzes it and determines whether it is text, a number, or 

a formula.  

Entering text data 

Text data is a sequence of letters, numbers, punctuation marks, and spaces between them. By default, 

the text you enter in a cell is left-aligned. Text in tables is mainly used for creating headings, cell notes, and 

explanations of numeric data (their description). 

The cell format either remains the default (General) or is set as Text. Very often, the text you enter 

does not fit into the standard cell and goes beyond it. The screen gives the impression that the text also 

occupies neighboring cells. However, this is not the case. You can enter new text in them and it will not 

replace the one you already entered. Excel cuts the previously entered text along the cell border and hides it 

so that it doesn't obscure the new text. To display a hidden text fragment on the screen, change the size of 

the corresponding column. 

   To enter text, follow these steps: 

* Select the cell where you want to enter text.

• Dial it. The text appears in the cell and in the formula bar.



• press enter. The text in the cell is left-aligned.

• If an error is made in the entered text, then it is edited in the formula bar. If you have already pressed

Enter, you can double-click on the cell, enter it, bring the input point (blinking vertical line) to the wrong 

character and edit the cell itself 

Entering numeric data 

The main type of data that Excel works with is numeric data. Excel distinguishes between two types of data 

- quantitative numbers and numbers that represent dates. 

Numeric data can only consist of the following characters: 

1 2 3 4 5 6 7 8 9 0 + - ( ) , / $ % . E e 

You can enter integers, decimals, or simple fractions of a number in exponential (power law) form. The plus 

sign ( + ) before the number is ignored, and the comma is interpreted as a decimal separator (depending on 

the Windows settings in the Language and standards section of the control Panel). All other keyboard 

shortcuts consisting of numbers and non-numeric characters are treated as text. 

The number entered in the cell is stored with an accuracy of 15 decimal places. When setting the 

numeric format of a cell (or range of cells), you can always set the required number of decimal places to 

display. 

If the entered number does not fit completely in the cell, Excel automatically converts it to the so-called 

exponential form, as shown in figure 3  

Figure 7. Exponential representation of a number that doesn't fit in a cell 

12.3. Working with cells. 

Before entering data into a cell, it must be highlighted. Selecting a cell is extremely simple - you just 

need to click on it with the left mouse button. The border of the cell becomes thickened, and in the lower 

right corner there is a cell marker - a small square.. 

Very often you will have to work with several cells at the same time, with a so-called range of cells. 

The range of cells is the neighboring cells that form a rectangle. A range of cells can consist of cells in a 

single column or row, or a combination of cells located in different columns and rows. The main condition 

that it must meet in this case is very simple-the cells must form a rectangle. 

The range of cells is selected as follows: the starting cell of the range is selected and, without 

releasing the left mouse button, it stretches to the end cell. If necessary, you can add any number of cells 

located on the worksheet to the rectangular range of cells. To do this, select while holding down the Ctrl 

key.  

If you have selected a rectangular range of cells and this selection has not been removed, you can 

change the selection if necessary. Only use the Shift key to select the cell that limits the new range to the 

right and bottom. 

To select the same cell ranges on several sheets, hold down the Alt key and click on the labels of the 

combined sheets. In this case, several sheets are combined into a group. Grouping sheets allows you to 

perform the same actions on the same cells of each of the combined sheets at the same time. This includes 

selecting a range, entering and deleting data, and formatting cells in the same way. This way you can 

simultaneously create the same tables on several sheets, enter the same data in the same cells, and so on. 

    Для того, чтобы снять группировку, необходимо только кликнуть по ярлычку любого, не 

объединенного в группу, листа. 

    In our next lectures, we will learn how to perform calculations using forms and functions. They often 

use the addresses of cell ranges as operands and arguments. 

    The address of a rectangular range of cells is set by cell coordinates located in the upper-left and 

lower-right corners of the rectangle, separated by a colon. The address of the added non-rectangular range is 

separated by a semicolon. 



In General, the address of a cell or range of cells consists of the name of the workbook enclosed in [], the 

name of the worksheet, and, separated from it by an exclamation mark, the address of the cell:  

[Book1]Sheet1!F7:G8 

Moving through a sheet 

Using the mouse 

You can move to a specific cell in the sheet using the mouse. To do this, just hover the mouse pointer 

over this cell in the form of a white cross and click once with the left mouse button. 

   Using the keyboard 

You can use the keyboard to navigate to the desired cell. The and keys move one cell to the right or 

left, and the and keys move one cell down or up. Page Up and Page Down keys – one screen down or up. 

The Home key moves to the first cell in the row. 

The Ctrl + key combination moves to the right edge of the current area, Ctrl + to the left edge, Ctrl + 

to the bottom edge, and Ctrl + to the top edge.The Ctrl + Home key combination moves to the beginning of 

the sheet, and Ctrl + End moves to the last cell on the sheet, located in the lowest used row of the column to 

the far right of the used column. The Alt + Page Up key combination switches the screen to the left, and Alt 

+ Page Down switches the screen to the right. 

Copying and moving data. 

When copying and moving, the data that these operations are performed on is temporarily placed in a 

memory area called the clipboard, which allows you to copy data to other areas of the sheet, to another 

sheet, or to a workbook. When copying, the data remains in the source cell and is placed in the destination 

cell that you specify. When you move data, the source cell is cleared of it.  

Data is copied as follows: 

* Select the cells whose contents you want to copy.

* Call the copy command (using one of the known Methods - from the menu, context menu, or toolbar).

The contents of the cell (s) are copied to the clipboard. A sign that the data is in the clipboard is the presence 

of a running dotted border along the border of the selected range. 

* Select the first cell to copy data to.

Call the Insert command. The data will appear in the cell you selected. 

When inserting data into a cell, the insert options icon is displayed next to it. 

You can quickly copy data within a single worksheet screen by dragging and dropping the cell 

containing the original data. To do this, hold down the Ctrl key and grab the mouse on any side of the 

selected cell and tow it to the desired location. After you release the mouse button, the data is copied (if you 

forgot to press the Ctrl key while dragging, the data is not copied, but moved). 

If you drag the selected cell by the marker instead of by its side, then all cells that fall under the tow 

track will be filled with data from the dragged cell. 

Data is moved in the same way, but the Cut command is used instead of the Copy command 

. 

Setting numeric formats 

About numeric formats 

Numbers in Microsoft Excel are numbers themselves, including numbers with decimals and / or 

simple fractions and numbers with the percent symbol, as well as dates and times. 

Number formatting is used for more convenient representation of data on a sheet. 

You can set numeric formats for numbers entered from the keyboard or imported, as well as for 

calculation results. The value of the entered or imported number or calculation result does not change when 

setting the format. When setting the format, the number entered in the formula bar and in the cell may be 

displayed differently. But it is the value of the number displayed in the formula bar that will be used for 

calculations, sorting, and so on. 

Just as the formatted number is displayed on the sheet, it will also be printed. 

To set numeric formats, use the Number group elements on the Home tab, as well as the Number tab 

in the cell Format dialog box (figure 8). 



Figure 8. Excel Elements for setting numeric formats 

You can select basic numeric formats from the Numeric format drop-down list. 

Select a cell or range of cells. 

Click the arrow in the Numeric format list of the Number group on the Home tab and select the 

desired format (figure 9).

Figure 9. Setting basic numeric formats 

In addition, in the Number group of the Home tab contains buttons for setting the financial format, 

percentage format, and to set thousands separator and control the number of displayed decimal places (see 

Fig. 8). 



To navigate to the Number tab of the Format dialog box cell, you can click on the group icon a 

Number of the Home tab or in the list of formats (Fig. 9) to select Other number formats. 

Common format 

The General numeric format is used by default. In most cases, numbers that have a common format 

are displayed as they were entered from the keyboard. 

In the process, the General numeric format is used to reject other numeric formats. The easiest way 

to set a common format is to use the Numeric format drop-down list (see figure 8). 

The formats of floating point numbers 

Changing the bit depth allows you to change the number of decimal places displayed in a cell. 

Select a cell or range of cells. 

Click Increase or Decrease the number of bits in the Number group on the Home tab (figure 10). One 

click of the corresponding button increases or decreases the number of displayed decimal places by one 

character.  

Fig. 10. change in bit depth (decrease) 

The percentage format 

The percentage format allows you to set the percentage sign ( % ) designation for the number 

displayed in the cell. This is usually used to represent the results of calculations. 

Select a cell or range of cells. 

Click the Percentage format of the Number group on the Home tab (figure 11). 

Figure 11. Percentage format 

Scientific notation 

The exponential format is used to display very large or very small numbers in an exponential 

notation. 

For example, the mass of the planet Earth (5980000000000000000000000 kg) will be displayed as 

5.98 E+24, which means 5.98 times 1024 (ten to the twenty-fourth power), and the mass of the hydrogen 

atom (0.000000000000000000000000001673 kg) will be displayed as 1.673 E-27, which means 1.673 times 

10-27 (ten to the minus twenty-seventh power) (figure 12). To set the exponential format, the easiest way is 



to use the Numeric format drop-down list (see figure 8).

Figure 12. Exponential format 

Creating and formatting "Tables" 

About tables 

Data organized on a sheet can be arranged as a "Table". When you create a table, you can analyze its 

data and manage it independently of data outside the table. You can create any number of tables on a 

worksheet. 

A table can be used to quickly sort, select, summarize, or publish the data it contains. 

On the other hand, the presence of a table on a sheet and in a book also creates some problems. For 

example, a table cannot be structured. You can't use automatic summing up either. 

Creating a table 

A table is usually created based on the data available on the sheet. 

Select any cell in the data range. 

Click the Format as table button in the Styles group on the Home tab and select a design style (figure 

18). The preview doesn't work in this situation. 

Fig. 18. The choice of table style 

The field in the table Formatting window will automatically specify the range of data that is 

converted to a table (figure 19). If necessary, you can clear the field and select a different range of cells on 



the sheet with data that is formatted as a table. Click OK.

Fig. 19. creating a table as 

a result, a table will be created. An AutoFilter icon is automatically added to each column. The 

context tab Working with tables will be displayed automatically/Designer. (Fig. 20).

Fig. 20. Table 

Working with tables 

In addition to the usual tools, you can use the elements of the Designer tab to work with the table 

(see figure 20). This tab automatically appears when any table cell is selected, and also automatically 

disappears when any cell outside the table is selected. 

You can apply a different design style to the table. 

Select any cell in the table. 

Click the Express styles button on the design tab And select a design style .The preview works in this 

situation and the table is displayed with the specified layout. 

To change the layout style of a table, you can also click Format as table in the Styles group on the 

Home tab and select the layout style. 



On the Design tab, in the table style Parameters group (Fig. 21), you can configure specific table 

design parameters.

Figure 21. Changing the table layout style 

To enable or disable the title bar, select or clear the title Bar check box. 

To enable or disable the summary line, select or clear the total Line check box. 

To display special formatting for the first column of the table, select or clear the First column check 

box. 

To display special formatting for the last column of the table, select or clear the Last column check 

box. 

To display odd and even lines differently, select or clear the Alternating lines check box to make it 

easier to read. 

To display odd and even columns differently for easier reading, select or clear the Alternating 

columns check box. 

About charts 

Charts are a visual representation of data and make it easier to make comparisons and identify 

patterns and trends in data. 

Charts are created based on data located on worksheets. As a rule, data from a single sheet is used. 

This can be data from ranges of adjacent or non-adjacent cells. Non-contiguous cells should form a 

rectangle. If necessary, during or after creating the chart, you can add data located on other sheets to it. 

The chart can be placed as a graphic object on a data sheet (not necessarily on the same page as the 

data taken to build the chart).A single data sheet can contain multiple charts. The chart can be placed on a 

separate special sheet. 

You can print the chart. A chart located on a separate sheet is printed as a separate page. A chart 

located on a data sheet can be printed together with the data in the sheet or on a separate page. 

The chart is constantly linked to the data it is based on and is updated automatically when the source 

data changes. Moreover, changing the position or size of data elements on the chart may cause the data on 

the sheet to change. 

You can create various charts in Excel. In total, there are 11 types of embedded charts, each of which 

has many more varieties (types). The choice of the chart type is determined by the tasks that are solved when 

creating it. 

One of the chart types is standard, meaning it is used by default when creating charts. Usually the 

standard chart is a flat histogram. 

Create a chart 

Before creating a chart, make sure that the data on the sheet is arranged according to the chart type 

that you plan to use. 

The data must be arranged in columns or rows. Data columns (rows) do not have to be contiguous, 

but non-contiguous cells must form a rectangle. 



When creating a bar chart, bar chart, graph, area 

chart, petal chart, or pie chart, you can use from one to 

several columns (rows) of data. 

When creating a Surface chart, there must be two 

columns (rows) of data, not counting the column (rows) of 

category labels. 

When creating a pie chart, you can't use more than 

one column (row) of data, not counting the column (row) of 

category labels. 

Generally, the data used to create a chart should not 

have significantly different values. 

Select the table fragment that the chart is being 

created for. 

On the Insert tab, in the Charts group, click the 

button with the desired chart type and select a specific chart 

type in the gallery (figure 22). 

A diagram of the selected type will be created on the 

sheet (Fig. 23). 

 

 
Fig. 23. The generated chart 

  
Figure 22. Selecting the type and type of 

chart to create 



If the Chart group does not display the appropriate chart type and type, click the Chart groups button 

and select a chart in the Insert chart window (figure 24).

Figure 24. Selecting the type and type of chart to create 

To create a standard chart, just select a fragment of the sheet and press F11. 

To delete a chart, just select it and press the Delete key. 

Configuring and editing charts 

Chart selection 

All actions are performed with the selected chart or its selected elements. 

Fig. 25. Selection chart 

To select a chart, click anywhere in the chart area. The selection is indicated by the chart frame (Fig. 

25). The frame has markers located at the corners and sides of the frame. 

To select a chart element, click on it. The selection is indicated by the border and element markers 

(Fig. 26). Linear elements (axes, trend lines, etc.) do not have frames. The number of markers may vary for 

different chart elements. Only one chart element can be selected at a time. 



Fig. 26. The selected chart elements 

To select individual chart elements you can also use the drop down list chart Elements groups 

Current fragment of the context tab working with charts/Layout (Fig. 27).

Figure 27. Selecting chart elements 

About printing tables 
In Microsoft Excel, you can print all the data in a worksheet or only a specific range of cells. When 

printing large tables on multiple pages, you can move the names of rows and columns of the table to each 

page. If necessary, you can insert forced page breaks when printing large tables. You can print a chart 

located on it separately from the sheet.You can control the mode for printing notes to sheet cells. 

You can print multiple sheets of the same book or multiple books at once. 

You can change the print scale by increasing or decreasing the size of the table; you can adjust the 

scale to match the size of the printed table. 

When printing, you can choose the paper size, page orientation, and margin size. 

Print pages can have headers and footers that can contain various information, including the date and 

time of printing. 

The table should usually be prepared for printing. 

The page Layout view mode ensures that the document is displayed almost exactly as it will be 

printed. In this mode, you can configure page parameters, create and arrange headers and footers, and set 

document printing features. 



The main preparation of the document for printing is performed in the page Layout view in the page 

Layout tab (Fig. 28).

Figure 28. Viewing a document in page Layout mode 

To print and preview a document, use the Print menu command of the Office button and the 

subordinate menu commands (figure 29).

Figure 29. Printing and configuring Excel document printing 

Preparing a document for printing 

Setting page parameters 

To select and setup page use the group members page setup tab page Layout (see Fig. 28). 

To select the paper size in the page setup group, click Size and select one of the suggested sizes (Fig. 

30). 

Fig. 30. The choice of page size 



To select the page orientation, in the page Settings group, click the Orientation button and select one 

of the suggested options from the menu that appears (figure 31).

Fig. 31. Select the orientation of the page 

To set page fields, in the page Settings group, click the Fields button and select one of the suggested 

options from the menu that appears (figure 32).

Figure 32. Selecting the size of page margins 

To select an arbitrary field size, select Custom fields (see figure 32). In the upper, Lower, Left, and 

Right counters of the Fields tab of the page Parameters window (figure 33), set the required field sizes.

Figure 33. Setting the size of page margins 

Excel does not respond to setting too small fields that are not supported by the printer's capabilities. 



You can also change the size of the margins when you preview the document before printing. 

On a sheet displayed in page Layout mode, you can see the size of the fields on the horizontal and 

vertical bars. The fields on the rulers are highlighted in dark color, unlike the main part of the page, where 

the ruler is highlighted in white. 

It should be noted that the steps to install page parameters can't be undone. 

1.1. General information about computer graphics 

Computer graphics is a field of computer science that deals with the problems of obtaining various 

images (drawings, drawings, animation) on a computer. 

Working with computer graphics is one of the most popular ways to use a personal computer, and 

not only professional artists and designers are engaged in this work. At any enterprise, from time to time 

there is a need to submit advertisements to Newspapers and magazines, to issue an advertising leaflet or 

booklet. Sometimes companies order such work from special design bureaus or advertising agencies, but 

they often manage on their own and with available software. 

No modern program can do without computer graphics. The main labor costs in the work of editorial 

offices and publishing houses are also artistic and design work with graphic programs. 

The need for widespread use of graphic software tools has become especially noticeable in 

connection with the development of the Internet and, first of all, thanks to the World Wide Web service, 

which has linked millions of "home pages" into a single "web". A page designed without computer 

graphics has little chance of attracting mass attention. 

The scope of computer graphics is not limited to artistic effects alone. In all branches of science, 

technology, medicine, commercial and managerial activities, computer-generated diagrams, graphs, and 

diagrams are used to visually display a variety of information. Designers, developing new models of cars 

and planes, use three-dimensional graphic objects to represent the final appearance of the product. 

Architects create a three-dimensional image of the building on the monitor screen, and this allows them 

to see how it will fit into the landscape 

. 

Main applications of computer graphics: 

Scientific graphics the First computers were used 

only for solving scientific and industrial problems. To 

better understand the results obtained, we performed 

their graphic processing, built graphs, diagrams, and 

drawings of the calculated structures. 

The first graphics on the machine were obtained in 

character printing mode. Then there were special 

devices-graph planners (plotters) for drawing drawings 

and graphs with an ink pen on paper. Modern scientific 

computer graphics make it possible to conduct 

computational experiments with a visual representation 

of their results..   

Business graphics is an area of computer graphics 

intended for visual representation of various 

performance indicators of institutions. Planned 

indicators, reporting documentation, and statistical 

summaries are the objects for which business graphics 

are used to create illustrative materials 

. Business graphics software is included in 

spreadsheets. 

Design graphics are used in the work of design 

engineers, architects, and inventors of new technology. 

This type of computer graphics is a mandatory element 



of CAD (design automation systems). Using design graphics, you can get both flat images (projections, 

sections) and three-dimensional spatial images.    

  Illustrative  graphics are arbitrary drawing and drawing on a computer screen. Illustrative graphics 

packages are General-purpose application software. The simplest software tools for illustrative graphics 

are called image editors.  

Art and advertising graphics - which became 

popular largely due to television. You can use your 

computer to create commercials, cartoons, computer 

games, video tutorials, and video presentations. 

Graphics packages for these purposes require large 

computer resources in terms of speed and memory. A 

distinctive feature of these graphics packages is the 

ability to create realistic images and "moving pictures". 

Getting drawings of three-dimensional objects, their 

rotations, approximations, deletions, and deformations 

is associated with a large amount of calculations. 

Transmitting the illumination of an object depending on the position of the light source, the location of 

shadows, and the texture of the surface requires calculations that take into account the laws of optics.  

Computer animation is the acquisition of moving images on the display screen. The artist creates a 

drawing of the initial and final positions of moving objects on the screen, calculates all intermediate 

States and depicts the computer, performing calculations based on the mathematical description of this 

type of movement. The resulting drawings, displayed sequentially on the screen with a certain 

frequency, create the illusion of movement.  

Multimedia is the combination of a high-quality image on a computer screen with audio. 

Multimedia systems are most widely used in the field of education, advertising, and entertainment.  

Types of computer graphics 

There are three types of computer graphics. These are raster graphics, vector graphics, and fractal 

graphics. They differ in the principles of image formation when displayed on a monitor screen or when 

printed on paper. 

In bitmap graphics, an image is represented as a 

set of colored points. This method of image 

representation is called bitmap. Raster graphics are used 

in the development of electronic (multimedia) and 

printed publications. Illustrations made using raster 

graphics are rarely created manually using computer 

programs. Most often, scanned illustrations prepared by 

artists or photographs are used for this purpose. 

Recently, digital photo and video cameras have been 

widely used for entering bitmap images into a computer. 

Most image editors designed for working with raster 

illustrations are focused not so much on creating images as on processing them. So far, only raster 

illustrations are used on the Internet. A vector method is a method for representing an image as a 

collection of segments and arcs, and so on.in this case, a vector is a set of data that characterizes an 

object.. 

  Software tools for working with vector graphics are designed primarily for creating illustrations and 

to a lesser extent for processing them. Such tools are widely used in advertising agencies, design 

bureaus, editorial offices and publishing houses. Design work based on the use of fonts and simple 

geometric elements can be solved using vector graphics much easier. 

Software tools for working with fractal graphics are designed for automatic image generation by 

mathematical calculations. Creating a fractal artistic composition is not a matter of drawing or design, 

but of programming. 



Fractal graphics, like vector graphics, are calculated, but they differ from it in that no objects are 

stored in the computer's memory. The image is based on an 

equation (or a system of equations), so you don't need to 

store anything other than the formula. By changing the 

coefficients in the equation, you can get a completely 

different picture. 

The ability of fractal graphics to model images of 

wildlife computationally is often used to automatically 

generate unusual illustrations. 

.  

 

 

1.1. About computer graphics programs 

Programs designed to work with bitmap images are called bitmap image editors. These programs are 

used to create images and perform their artistic processing. There are many programs for working with 

raster graphics. A number of graphic programs are focused directly on the drawing process. They focus on 

the variety of artistic tools, their ease of use, and the ability to create new tools and materials. An example of 

the simplest image editor of this type is Paint, which is included in all Windows operating systems.  

For professional work, more powerful editors are used that have a rich set of tools and features – for 

example, Corel Painter. Other image editors are designed not only for creating images "from scratch", but 

primarily for processing ready-made images in order to improve their quality, stylize them, and implement 

creative ideas in relation to them. These programs primarily include: Adobe Photoshop. This is an extremely 

powerful, convenient and stable program. 

The original version of Photoshop, developed by the Knoll brothers, was purchased by Adobe from 

BarneyScan in 1988. After significant improvements, the first commercial version of Adobe Photoshop was 

released in 1989. Over the years, the program has become a global standard in the field of raster graphics 

processing, especially with the introduction of Photoshop 4.0, released in November 1996. Adobe 

Photoshop is used for creating, retouching and improving the quality of images. it is used in almost all 

technological cycles of image reproduction and transmission-from printing to the World Wide Web. 

Despite the fact that the program was originally developed as an image editor for printing, it is now 

widely used in web design. An earlier version included a special program for this purpose — Adobe 

ImageReady, which was excluded from the CS3 version due to the integration of its functions into 

Photoshop itself, as well as the inclusion in the Adobe Fireworks line of software products, which became 

the property of Adobe after the acquisition of Macromedia. 

Photoshop is closely related to other programs for processing media files, animation, and other creative 

work. Together with programs such as Adobe ImageReady (the program was discontinued in version CS3), 

Adobe Illustrator, Adobe Premiere, Adobe After Effects, and Adobe Encore DVD, it can be used to create 

professional DVDs, provide tools for non-linear editing, and create special effects such as backgrounds, 

textures, and so on for television, cinema, and the world wide web. Photoshop has also caught on in 

computer game development circles. 

Photoshop's main format, PSD, can be exported and imported by all the software products listed above. 

Photoshop CS supports creating menus for DVDs. In conjunction with Adobe Encore DVD, Photoshop 

allows you to create menus or DVD buttons. Photoshop CS3 in the Extended version also supports working 

with three-dimensional layers. 

Due to the high popularity of Photoshop, support for its specific PSD format has been implemented in many 

graphic programs, such as Macromedia Fireworks, Corel PHOTO-PAINT, WinImages, GIMP, Corel Paint 

Shop Pro, and others. 

Photoshop supports the following color models or ways to describe image colors (in the notation of the 

program itself — image mode): 

RGB 

LAB 

CMYK 

In grayscale 

Black-white 



Duotone 

With 256-color palette (Indexed) 

Multichannel (Multichannel) 

Image processing is supported, with a color depth of 8 bits (256 gradations per channel), 16 bits (using 15 

bits plus one level, i.e. 32769 levels), and 32 bits (using single-precision floating-point numbers). You can 

save additional elements in the file, such as guides, channels (For example, the alpha channel), clipping 

paths, and layers containing vector and text objects. The file can include color profiles (ICC), color 

conversion functions (transfer functions). Non-square pixels (Pixel Aspect Ratio) are allowed. 

14.3. General information about PowerPoint. 

PowerPoint is part of the Microsoft Office Suite of office applications. It allows you to create and display 

electronic presentations on a computer screen using a projector, as well as arrange slide shows on the 

Internet. 

The undeniable advantage of the PowerPoint program is the use of menus and toolbars in Its interface, 

designed in the same style as other Microsoft Office programs (for example, Microsoft Word and Microsoft 

Excel). 

Just as Microsoft Word text files are called documents and Excel spreadsheets are called workbooks, 

PowerPoint documents also have a special name: presentations. If Microsoft Word documents consist of 

separate pages and Excel workbooks consist of worksheets, then presentations consist of slides. During the 

presentation development process, you can rearrange, delete, add new slides, or change the content of 

existing slides. 

PowerPoint allows you to combine text, graphs, numeric data, and charts generated by other Microsoft 

Office applications (such as Microsoft Word or Microsoft Excel) within a single presentation. 

Thus, a presentation is a combination of text, graphics, animation effects, videos, and music that are 

organized in a single environment and designed in a single style. 

The presentation usually starts with the title slide, which contains basic information about the upcoming 

report: the title of the topic, the purpose of the presentation, the author's name, and other introductory 

information. If we draw the analogy of a presentation with a book, then the title slide is the cover of the 

book, and the title of the slide is the title of the Chapter or part of the book. 

Presentation files have the *.ppt extension, which is automatically added at the end of the file name when 

saving. The new version of the program starting with PowerPoint 2007 create a file with the extension 

*.pptx. 

In order to simplify the creation of slides, PowerPoint has many professionally designed templates and 

color schemes that pre-set the location of objects, the slide background, and other characteristics. Each 

template contains the necessary text placeholders or placeholders for graphic elements that form the desired 

slide appearance and are subsequently replaced with ready-made elements.  

Methods for creating slides and presentations. 

There are three ways to create a presentation in PowerPoint: 

- use the built-in auto-content wizard; 

- use built-in design templates; 

- create a presentation starting from a blank page, i.e. completely independently. 



1. Modes of operation

PowerPoint provides three main modes for displaying the work window: 

- Normal mode - for developing a separate slide; 

- slide Sorter mode - for working on the entire set of slides; 

- slide Show mode - for viewing slides. 

You can switch between modes using the buttons located at the bottom left 

presentation Windows , or the corresponding commands in the View menu. 

By default, PowerPoint opens any presentation, regardless of how it was created, in the Normal display 

mode. This mode is convenient for creating and editing individual slides. In Normal mode, the program 

window is divided into three parts, each of which is occupied by a corresponding area – the Slide, Notes, 

and presentation Structure. 

The Structure panel consists of two alternative tabs – Structure and Slides. The Slides tab contains a 

numbered list of all the presentation slides, with a thumbnail image for each of them. You can use the Slides 

tab to quickly navigate to the desired slide, or to select a group of slides. On the Structure tab, each slide is 

represented by its name and text information. Any non-text objects (images, diagrams, tables, etc.) that are 

present on slides are not displayed on the Structure tab. The main purpose of the Structure tab is to choose 

the sequence of presentation of the material, paying attention directly to the content of the presentation, and 

not to its artistic design. Using the Structure toolbar, you can easily move slides, change the level of 

structural elements, and collapse and expand lists of items. After entering and pre-editing the text content, 

you can add drawings, tables, and other graphic elements by going to the Slide tab. 

Slide layout 

Each slide can contain: 

– text blocks with the headings of the various hierarchical levels;

– tables;

- graphic elements-drawings, diagrams, graphs; 

- video clips, audio files; 

- service data (date and time, footer, slide number); 

- animation effects applied to various slide objects; 

- background or background image. 

The placement of these objects on the slide can be controlled by the PowerPoint program or the author. If 

you select slide Layout in the context menu or in the Format menu, the slide Layout panel appears in the 

task Pane, which contains standard layouts for placing objects (each slide object has a specific location). To 

apply one of the layouts to the selected slide, just click on it. Selecting an empty slide allows the author to 

Выбор способа  
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create the layout themselves. 

Inserting text on a slide 

Text on a PowerPoint slide is entered in a special area called a frame, placeholder, field, or prototype, 

which means the same thing – the place that is specifically reserved for placing an object on the slide. You 

can't enter text directly on the slide background. 

If you use ready-made templates or slide layouts, then the specific placement of text fields for slides is 

already set by the corresponding frame, so you just need to enter your text in it. This text will also be 

displayed on the Structure tab. If you use the layout of an empty slide, or if you want to place the text in a 

different place, you must first create 

use the Label button to create a new frame for it  Draw toolbar and enter text in it. This text is not 

displayed in the Structure. After you finish entering text, you can change the size of the label by moving its 

borders, rotate it randomly using the rotation marker, or move it to another location on the slide. 

The entered text can be formatted using the appropriate Format menu commands or the Formatting 

toolbar buttons. 

You can also enter text copied from a Word document in the label. When copying and pasting text, you 

can use the parameters of the paste Options button that appears under the pasted text. These options allow 

you to keep the original formatting or discard 

it. 

If the insert Options button is not displayed, 

you can enable this feature by selecting Options 

from the Tools menu, and then on the edit tab, 

select the appropriate check box. 

6. Saving a presentation

The table shows the file formats used for saving presentations (specified in the file Type parameter of the 

Save as dialog box). 

File type Expansion Used for saving 

Presentation .ppt A regular PowerPoint presentation 

Windows metafile .wmf Slide as a graphic 

The picture in the GIF 

format, JPEG, Portable 

Network Graphics, 

ТIFF 

.gif,.jpg, 

.png, tiff 
Slide as a graphic for use on web pages 

Structure, RTF .rtf Presentation content as a structure document 

Presentation template .pot Presentations as a template 

PowerPoint 

Demonstration 
.pps A presentation that will always open in slide show mode 

Web page .htm; .html Web pages as a folder with. htm files and all auxiliary files 

Web archive 
.mht; 

.mhtml 
Web pages as a separate file that includes all auxiliary files 

You can save the presentation along with the viewer, the necessary fonts, and all auxiliary files. This 

need occurs if you don't know which computer the demo will be running on: whether the fonts used in the 

presentation and the desired version of PowerPoint are installed on it. This task is solved by using the 

special Pack for CD command in the File menu. If you select Copy to folder in the dialog box of this 

command, you can save the packaged presentation to any media. 

Insert pictures, charts, tables, sounds and movies to slides in your presentations. 

Inserting tables 

There are several ways to create a table in a PowerPoint presentation. You can create a table using 

PowerPoint tools or add it from another program as an embedded object (see Adding objects created in other 

Microsoft Office applications to a slide below). If you want to create a table that is larger or has more 

formatting options than those available in PowerPoint, you can create it in Word and then embed it. For 



example, Word contains more options for formatting lists, margins, tabs, and individual cells. You can also 

embed a spreadsheet from Excel or a spreadsheet from Access. 

In PowerPoint, you can create a table using the table command in the Insert menu. All further work with 

the table is performed using the buttons on the toolbar that appears Tables and borders and is very similar to 

similar work in the Word application. 

2.4. Inserting graphics 

Well-chosen graphic images on a specific topic on the slides of a PowerPoint presentation sometimes 

replace a lot of words, and also make the presentation more effective and attractive. 

Graphic objects used in PowerPoint presentations are images that are drawings( graphics), photos, or 

images of two main types: raster and vector. 

A bitmap (bitmap) drawing is perceived as a set of many individual points that make up the entire 

image. Photos taken with a digital camera, scanned drawings, and drawings created in some graphics 

programs (such as Adobe PhotoShop) are all examples of bitmap images. The most common bitmap image 

formats have the extension bmp, gif, jpg, png, and tiff. 

The main disadvantage of bitmap images is that each point (pixel) increases proportionally when the 

image is enlarged. Therefore, when the bitmap image is enlarged too much, its quality deteriorates. In 

addition, the size of the raster image files are usually quite large. 

Vector drawings are created from segments of straight lines, curves, rectangles, and other shapes, and 

the drawing file stores not the shapes themselves, but their mathematical description, which allows you to 

build each of them at any scale. The main advantage of vector images is the ability to enlarge the image 

while maintaining high quality. In addition, a vector image can be ungrouped, i.e. split into its component 

shapes. An example of a vector image is drawings created, for example, in CorelDraw. In PowerPoint (as in 

other Microsoft Office applications), you can create vector images using the tools in the Drawing panel. 

Vector image files have the extension cdr, emf, wmf, etc. 

You can insert a variety of graphic elements from the Microsoft Office drawing collection and images 

from files on a presentation slide. To insert an image, use the command 

Picture menu Insert or button on the Drawing toolbar. Using the parameters of the image Format 

command, which is called from the Format menu or the context menu, you can change the size of the 

inserted image, crop it and/or compress it if necessary. 

You can use the tools in the Drawing panel to add your own drawings to your PowerPoint presentation. 

Some tools in the Drawing panel are used to select and then edit pre-existing shapes. In addition, the 

same panel contains tools that help you create new shapes and text elements. In order to complete the work 

on the drawings, the panel includes buttons that allow you to choose a color for filling objects and 

connecting lines (i.e. lines that connect different shapes). The Draw toolbar lets you choose the thickness 

and type of lines, and apply shadow and volume effects to graphics 

Using the same toolbar, you can add a text frame (label) to a shape in a slide or directly on the slide, then 

enter text in it, which allows you to place text anywhere on the slide. 

The Draw toolbar lets you draw simple lines, arrows, and shapes such as rectangles, squares, ovals, and 

circles. More complex shapes – various polygons, shapes consisting of curves, stars, ribbons, blocks for 

diagrams-are available in the Autofigure button palettes. The Lines palette of this button also contains three 

tools that allow you to draw arbitrary lines on the slide. 

Additional PowerPoint tools help you optimally place objects (both those inserted by the Insert command 

and those created by the Drawing panel tools) on the slide. This task can be solved using the actions button 

menu in the Drawing panel, which contains commands for grouping and ungrouping objects, moving 

through layers, aligning and distributing objects on the slide, mirroring, and rotating. 

PowerPoint allows you to include a large number of drawings in your presentation without setting the 

parameters for each of them. To do this, create a presentation in the form of a photo album, where you can 

add images from a file, scanner, or camera. 

When creating, editing, or updating a photo album, you can use the following options. 

- Selection of different types of markings and the shape of the frame. 

- Adding a signature. 

- Adding design templates. 

- Add labels in combination with markup to create a custom design. 



- Displaying drawings in black and white. 

To create a photo album, select picture from the Insert menu, and then Create a photo album. 

Inserting charts 

PowerPoint Uses the built-in Microsoft Graph module to create and edit charts. It controls the window 

where its own menus and toolbars open while working with the chart. To insert a chart, click 

Adding a chart  on the Standard toolbar or on the Insert menu, click Chart. Please note that the 

menu and toolbars have changed to resemble Excel. Replace the data shown in the table as a sample 

manually or import the finished data from Excel. To import data, use the form that appears on .                     

In the standard panel, click Import  or the Import command in the edit menu. When importing, you can 

specify either the entire table or a range of cells. Use the new Data and Chart menu to set the chart 

parameters. Click outside the chart to return to the slide. 

Adding objects created in other apps to the slide 

PowerPoint allows you to combine text, graphs, numeric data, and charts generated by other Microsoft 

Office applications (such as Microsoft Word or Microsoft Excel) within a single presentation. 

If an object was inserted into PowerPoint as an object from another application and then needed to be 

edited, a method called in-place editing will generate a menu, dialog boxes, and toolbars in the PowerPoint 

window for the application that was used to create the object. Thus, when you make changes, it will appear 

that you are in the original program that created this object. For example, you can insert a sheet of an Excel 

spreadsheet into a PowerPoint presentation, and then edit the sheet right where it is placed. 

You can create a new object for another application directly in PowerPoint using Its menus and toolbars. 

You can use one of the following methods to add objects created in other applications to the slide. 

The 1st method. Select Object from the Insert menu.

 
 

Select the object type and insert method: either a new object will be created or an existing one will be 

inserted. 

The 2nd method. Copy the desired fragment in the source application, go to PowerPoint, and select paste 

Special from the edit menu. 

 
 

Select how the copied object should be inserted. 



If the object was inserted on the slide as an object of the source application, double-clicking on it with the 

left mouse button takes you to the environment of the application that created it for editing. The objects 

inserted in this way for PowerPoint are "foreign" and they are sent to the source application for editing. 

2.7. Inserting hyperlinks and control buttons 

You can link a hyperlink to any slide object. Clicking on such a hyperlink allows you to quickly navigate 

to a pre-defined location within a presentation, to a custom display, to a specific slide in another 

presentation, to a specified file, or to a specified Web page. 

To create a hyperlink select the object and select Hyperlink from the Insert menu 

or use the button   the Standard toolbar. 

To create a tooltip or a short comment that appears when the pointer is placed on a hyperlink, click the 

Tooltip button and enter the appropriate text. If the hint text is not entered, the standard text is displayed. 

If the link points to a different slide, that slide is displayed in PowerPoint. If the link points to a web 

page, network resource, or other file type, this object is displayed in the corresponding application or web 

browser. 

Hyperlinks can help in situations where you need to create slides of different orientations in the same 

presentation: both landscape and portrait. 

The slide orientation is set by the page Settings command in the File menu. By default, slide layouts are 

in landscape orientation. Unfortunately, in one presentation, all the slides must be equally oriented, so you 

have to use the following technique. 

- Move the slides that you want to change their orientation to portrait to the new presentation file. 

- Change the orientation of the presentation slides. 

- Create a link to the new presentation in the original presentation. 

- Create a link to the original presentation in the new presentation. 

Note. To display the created slides, both presentation files must be present, and these files must be 

located in the same folder where they were located when creating the links. 

A control button (or action button) is a ready-made button that you can insert into a presentation and 

define hyperlinks for it. To insert a control button, select the Control buttons command in the slide Show 

menu, select the button type from the list, and use the cursor to draw it on the slide (the control button is 

essentially an autofigure, so you can use the selection markers to change its size, line type, and fill, and 

move it around the slide). Then, in the dialog box that appears, specify the necessary actions. Actions that 

are triggered by clicking on a button or simply hovering the mouse pointer over it can be divided into four 

categories. 

The inclusion of hyperlinks. This option is most often used when creating control buttons. This button 

allows you to navigate to any slide in the current presentation, to another PowerPoint presentation, or to a 

document saved in a different format than the PowerPoint presentation. You can trigger a link to a specific 

Internet page. 

Program start. The action assigned to this button can be opening a Word text document or an Excel 

spreadsheet. 

Running the macro. PowerPoint allows you to create macros, which are programs written in the Visual 

Basic for Application (VBA) programming language. The action of this button will be to launch the 

specified macro, prepared in advance and saved in this presentation. 



Sound reproduction. Using these types of command buttons is one of the methods for adding sound to 

PowerPoint presentations. 

Hyperlinks and control buttons become active when the presentation is shown. 

Putting dates, page numbers, and headers and footers on the slide 

To add a date, page number, or footer, follow these steps: 

1. Select the View headers and Footers menu command.

2. Select the option to enter the date, if necessary. By default, the option to enter the current date is

selected. To replace it with a fixed value, set the switch to Fixed and enter the desired value. Add a footer 

and slide number by checking the corresponding options. If these fields are not required, clear the specified 

check boxes. 

3. Click the Apply button to apply the set parameters only to the selected slide. If you want to apply these

settings to all slides in your presentation, click Apply to all. If you want to add headers and footers to the 

title slide, clear the Do not show on title slide option. 

All placeholder areas for entering dates, page numbers, or headers and footers can be moved around the 

slide. The placeholder for the slide number is recommended to be placed away from the other digits of the 

slide. Placeholders in headers and footers typically include information about the presentation title, name of 

Creator, name of organization, etc. 

Slide layout and layout. Animation effects and their settings. 

You can use ready-made templates or create your own to design your slides. To use a ready-made 

template, select slide Layout in the context menu or in the Format menu. The slide Design panel appears in 

the task Pane. You can apply the template you like to all slides in your presentation, a single slide, or a 

group of selected slides.you can select from the list that opens by clicking the arrow next to the template 

thumbnail. 

If you want, you can create your own samples of title and regular slides. The sample title slide sets all the 

necessary parameters for the main title of the entire presentation, which usually differ significantly from the 

header parameters on the other slides. In a presentation created using a design template or the auto content 

wizard, there is usually only one title slide. However, in a very large presentation, there may be several of 

them – title slides may precede different sections of the report, presenting the topic and content of each of 

them. 

The slide template defines the design of all presentation slides except the title slides: sets text 

characteristics, allows you to select background and graphic objects, and apply special effects. In principle, 

any slide can be converted to a title slide by applying the created sample title slide to it, and Vice versa. 

You can recommend that you start creating a presentation by preparing a sample (or samples) of slides 

that define the appearance of all normal presentation slides, and then create a sample of the title slide. This 

approach takes into account the relationship between these samples: all changes made to the slide sample are 

automatically reflected in the title slide sample, but not Vice versa. 

To create a sample slide, run the menu command View Sample slide Sample. A new Sample toolbar 

appears, which contains buttons that allow you to insert, delete, rename, and save the created sample.  

The Add new title sample button creates a title slide sample. 

Perform the required formatting of the slide sample: 

- Make the necessary changes to the placement of text fields. 

- Insert graphic objects if you want them to be present on all slides – such as the author's logo. 

- Change the background. 

- Insert any required information (for example, the name of the author of the presentation) into the sample 

slide, which will appear on all slides. 

- After creating a slide sample, save it with a name so that it appears among the ready-made design 

templates. 

- Close the Sample toolbar by clicking the Close wizard view button. 



The use of animation in presentations 

General information about creating animation effects 

Animation of text, graphics, diagrams, and other objects on slides highlights various aspects of the 

content, manages the presentation of materials, and makes the presentation more interesting. However, you 

need to handle animation effects very carefully, too many effects will only be harmful. Conversely, the 

predominance of slides in the presentation with a large amount of text information, "lifeless" diagrams and 

diagrams will lead to the fact that the overall informative value of the presentation will significantly 

decrease. The success of a presentation depends on how creative You are in creating it. 

Depending on which objects you want to apply animation effects to (slide, text, graphic, diagram), 

PowerPoint offers a different set of animation effects. 

Transitions between slides. The selected animation effect determines how the slides will change on the 

screen. 

Animation schemes. Include ready-made animation effects for changing slides, slide titles, and the main 

part of the slide. 

Non-standard animation. If you don't like ready-made animation schemes, you can create your own 

schemes by combining basic effects and selecting objects to influence them on the slides. 

To assign slide transition effects, go to slide Sorter mode, select the slides that you want to apply the 

effect to, and select Change slides from the slide Show menu or from the context menu. In the task pane, 

you will see the slide Changer panel and a list of all available effects for changing slides during the demo. 

Select an effect and set the effect parameters in the area below the list. 

To select a complete slide animation scheme, go to the slide Sorter mode, select the slides that you want 

to apply the effect to, and select animation Effects from the slide Show menu or the context menu. The slide 

Design panel appears in the task pane. Open the drop-down list in this panel and select slide Design-

animation Effects. Select the appropriate effect.

Changing slides. Time setting. 

Creating a custom impression 

A custom display contains a group of slides in a General presentation that you plan to show to a specific 

audience. To create a custom impression, follow these steps: 

1. In the slide Show menu, click custom show, and click Create.

2. In the presentation Slides, select the slides to include in the custom show and click Add. To select

multiple slides, hold down the CTRL key and select the desired slides one at a time. Use the arrows to 

change the display order. 

3. Enter a name for the custom display and click OK.

In the main presentation, you can set a hyperlink to any custom display. When adding a hyperlink, don't 

forget to check the Show and return box. 



You can design each section of your presentation as a custom impression, then automatically create a 

table of contents and link its items to custom impressions. 

1. Open the presentation for which you want to create a table of contents slide.

2. Create a custom impression for each section of the presentation.

3. In slide Sorter view select the first slide in each new random show. (To select multiple slides, hold

down the CTRL key and select them one at a time.) 

4. On the slide Sorter toolbar, click  The final slide.

5. Double-click the new slide that appears before the other slides. It will contain the titles of the first

slides of each section. 

6. to create a hyperlink to the corresponding custom display in each bulleted list item, select the bulleted

item, and then select customize actions from the slide Show menu. 

7. Select the Go to hyperlink check box, and then select Custom display from the list. Select a

custom impression that you want to go to via the hyperlink, and then select the Show and return check box. 

8. Repeat steps 6-7 for each bulleted element on the table of contents slide.

Demonstration of the presentation 

Before showing a presentation, in the slide Show menu, select presentation settings and set the necessary 

parameters. The main thing you need to decide before the demonstration is whether the slides will be 

changed at the click of the mouse, or after the specified time for each slide. To determine the exact time of 

demonstration of each slide and the entire presentation as a whole, there is a special tool – a timer. When 

you select the time setting command in the slide Show menu, the full-screen slide show starts 

simultaneously. 

timer in the form of the Rehearsal toolbar  . Use the buttons in this panel to view 

the entire presentation, setting the viewing time for each slide. 

If you are confused and want to repeat a rehearsal, click the Repeat button on the Rehearsal toolbar. 

PowerPoint will reset the time counter and start a new countdown. The Pause button allows you to 

temporarily pause the timing. 

During the presentation (mostly when answering questions), sometimes you need to highlight important 

data or certain elements on the slide, put a label on the slide to explain or emphasize the most important 

point. 

To draw directly on the screen, you can use the pen, felt-tip pen, or selection tools (to select any object as 

if using a colored marker) by selecting them in the slide Show mode from the context menu. 

Videos 

The image collection in Microsoft Office 2003 contains images, photos, sounds, videos, and other media 

files (called clips) that can be inserted and used in presentations. Consider the algorithm insertion video clips 

to the slide images on the slide discussed above. 

Insert / Movies and sounds / Movie from clip organizer 

Inserting video clips: 

* Select Insert / Movies and sound / Movies from the image collection. Next, in the clip Collection panel in

the task pane, you can select a clip and view it. To do this, hover the mouse pointer over the clip, and click 

on the drop-down list button, from which you need to select the "View and properties"command. After 

viewing the clip, click the Close button. 



• To add a selected clip to a slide, click on the clip in the clip Collection panel and it will be displayed on the

slide. 

Inserting sounds 

Adding music and sound effects to a slide: 

1. Open the slide that you want to add music or sound effects to.

2. on the Insert menu, select Movies and sound, and then do one of the following::

Inserting an audio file 

* Select sound from file, locate the folder that contains The file, and double-click the file you want.

Inserting audio from an image Collection 

* Select Sound from the collection, find the clip you want, and click it to add it to the slide.

Recording from a CD 

* Select Burn from CD, locate the desired file, and double-click it.

Record sound 

* Select the Record audio command, and the Sound recording dialog box opens, where you need to click the

start recording button. Use the microphone to record audio. After recording, click on the "Stop recording" 

button" 

Recording speech accompaniment 

To record speech accompaniment, a presentation demonstration is started and speech accompaniment is 

recorded for each slide. You can pause and continue recording at any time. 

• In normal mode, in the Structure or Slides area, select the icon or thumbnail of the slide from which you

want to start recording speech. 

• From the slide Show menu, select Sound recording. The dialog box "Recording voice accompaniment"

opens» 

* Click the microphone Volume button and set the microphone sensitivity level in the microphone Check

window that opens. After scan is completed click OK, the result once again opens the window "Record 

narration" 

• In the "Record narration", click OK, open the dialog "re-recording narration" in which to record the first

slide or the current slide. 

* In slide show mode, dictate the text of the speech accompaniment into the microphone. Click the slide to

continue. Dictate the text for this slide, go to the next one, and so on. you Can pause and continue recording 

speech accompaniment. 

* Speech accompaniment will be automatically recorded and the screen will display a request to save the



slide show time values. 

* To save the slide show time values, click Yes. The slides will be displayed in the slide sorter mode, and

each slide will have its display time displayed under it 

The creation of control buttons 

To set additional control buttons on slides in Normal mode, use the slide Show / Control buttons 

command. 

The use of tools for presentation 

During the presentation, control buttons appear in the lower-left corner of the screen, which are very 

easy to use. You can also use the context menu to manage your presentation. To exit the presentation display 

mode, use the Esc key. 

The "Blitz game" method. The group is divided into subgroups or teams, and all are given a common 

scheme-a task. There is a discussion in each subgroup and the correct answer is put in the columns. After 

that, the teacher calls the correct answer and calculates the correspondence between the correct and 

incorrect ones. A point is awarded on this basis. 

The mind Map method. Students are divided into subgroups. A topic is announced and each team is 

given a separate concept related to this topic. Each team will have to describe this concept in the form of 

a diagram and one or more team members will have to explain their scheme to the auditor. 

The "Summary analysis or SWOT" method. The teacher explains the purpose and course of the 

lesson. Groups are announced the topic of the debate or a specific issue. At first, students work on 

solving this problem individually. Then the group is divided into subgroups and sheets are distributed. 

Each team in the sheets describes: 1-Advantages, 2-Disadvantages 3-Opportunities, 4-Obstacles to the 

situation and defends their ideas to the group. 

The "concept Analysis" method. The group is divided into subgroups-teams. Materials on the topic 

of the lesson are distributed. Students get acquainted with this material and describe, i.e. comment on 

each concept. The teacher shows slides with correct answers. Students check their answers and thus 

consolidate their knowledge. 

Control question 

1. What are the features of modern versions of the text editor?

2. What is the feed and what elements does it contain?

3. what is the function of the ―Office " button‖

4. What is a mini panel instruments?

5. What is a paragraph?

6. What are the ways to change the paragraph format exist?

7. what is the most optimal way to change the zoom in Word 2007?

8. What ways to move the document can be used?

9. what ways to create numbered or bulleted lists do you know?

10. Which keyboard shortcut opens the Print dialog box?

11. what settings are possible in this window?



12. is it Possible to configure the page parameters in the document?

13. What methods of opening the page Parameters dialog box do you know?

14. For what purpose will use the preview?

15. What paragraph parameters can be configured?

16. What are the ways to insert tables exist?

17. How are the table elements added?

18. What is a spreadsheet?

18. How is the file that Excel works with configured?

19. What is in the Excel workbook?

20. What features do modern versions of Excel have?

21. What data can be entered in Excel cells?

22. How is the cell address determined?

23. what are tables for?

24. What is the diagram for?

25. What are the ways to create diagrams you know of?

26. How do I preview a document?

27. what is Computer graphics?

28. List the main applications of computer graphics.

29. How is the file created by PowerPoint?

30. What is the presentation?

31. What data can a presentation contain?

32. What information does the title page contain?

33. what extension do presentation files have?

34. what are the ways to create presentations?

35. What graphic objects can be inserted into the presentation?

36. What is the Drawing toolbar used for?

Literature: 
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5-Topic: Elements of mathematical statistics 

1.1. model of technology training 

Duration of the lesson-2 hours        Number of students: 30-60 

Class form         Informational lecture 

Plan of the lecture 

1-Discrete and continuous 

random variables. 

2-Elements of mathematical 

statistics. 

3-Student's Criterion.  

        Mathematical statistics is a science that develops mathematical 

methods for systematizing and using statistical data for scientific and 

practical conclusions. 

in many of its sections, mathematical statistics relies on probability 

theory, which allows us to assess the reliability and accuracy of 

conclusions drawn from limited statistical material (for example, to 

estimate the necessary sample size to obtain the results of the required 

accuracy in a sample survey). 

Mathematical statistics is a branch of mathematics that develops 

methods for recording, describing and analyzing observational and 

experimental data in order to build probabilistic models of mass 

random phenomena 

Purpose of the lesson: It will introduce students to the basic concepts and elements of 

mathematical statistics. Explain the Correlation relationship. 

Training method Demonstration: lecture and interview 

Type of training Collective 

learning tools Tutorials, textbooks, lecture text, projector, computer 

The learning environment Methodically equipped audience. 

Monitoring and evaluation Oral survey 



1.2. Technological map of the lecture 

Stages of work and 

allotted time 

Stages of conducting a lesson by a teacher Studying 

Preparatory stage. 1. Prepare an educational component of the topic.

2. Prepares presentation slides for the topic.

3. Make a list of literature used for the development of

the subject. 

1. Introduction to

the topic 

(10 min) 

It will introduce you to the purpose and task of the topic. Listen 

2. Main stage

(55 min)

1. Explains the topic and demonstrates the presentation.

2. Applies the posters.

Слушают  

Записывают 

3. Final stage (10

min) 

Makes a final conclusion Listen 

4. Self-study tasks

(5 min) 

Declares tasks of independent work. Records 

5.1 Discrete and continuous random variables. Elements of mathematical statistics. 

Mathematical statistics — the science that develops mathematical methods for systematization and 

use of statistical data for scientific and practical conclusions. 

Mathematical statistics is a branch of mathematics that develops methods for recording, describing 

and analyzing observational and experimental data in order to build probabilistic models of mass random 

phenomena. depending on the mathematical nature of the specific results of observations, mathematical 

statistics are divided into statistics of numbers, multidimensional statistical analysis, analysis of functions 

(processes) and time series, statistics of objects of non-numerical nature. In mathematical statistics, we 

consider approximate methods for finding distribution laws and numerical characteristics based on the 

results of experiments. 

There are descriptive statistics, estimation theory, and hypothesis testing theory. Descriptive statistics 

are a set of empirical methods used to visualize and interpret data (calculation of sample characteristics, 

tables, charts, graphs, etc.), which usually do not require assumptions about the probabilistic nature of the 

data. Some methods of descriptive statistics involve using the capabilities of modern computers. These 

include, in particular, cluster analysis, aimed at identifying groups of objects that are similar to each other, 

and multidimensional scaling, which allows you to visualize objects on a plane. 

Methods for estimating and testing hypotheses are based on probabilistic models of data origin. 

These Models are divided into parametric and nonparametric models. In parametric models, it is assumed 

that the characteristics of the studied objects are described by means of distributions that depend on (one or 

more) numerical parameters. nonparametric models are not related to the specification of a parametric 

family for the distribution of the studied characteristics.  

          In mathematical statistics, theories and methods of processing information about mass phenomena are 

developed. The source material for any statistical study is statistical data. Statistical data is understood as 

information about the number of objects of a more or less extensive population that have certain 

characteristics. statistical data are, for example, information about: a) the number of excellent students in 

each course of this faculty; b) the number of military service personnel with a height of 2 m, etc. 

On the basis of statistical data, it is often possible to draw well-defined scientifically based 

conclusions that are of great value for science and practice. To do this, statistical data must be systematized 

and processed in a pre-defined way. 

Methods of mathematical statistics are widely used in various fields of knowledge - in physics, stellar 

astronomy, economics, geology, hydrology, biology, medicine, etc. One of the main methods of processing 

statistical data is the sampling method. 

Mathematical statistics emerged in the XVII century simultaneously with the theory of probability. 

Solutions to the first problems of mathematical statistics are contained in the works of the founders of 

probability theory J. Bernoulli, P. Laplace and S. Poisson. 



A large section of modern mathematical statistics is statistical sequential analysis, the fundamental 

contribution to the creation and development of which was made by a. wald. Unlike traditional (non-

sequential) methods of statistical analysis based on a random sample of a fixed volume, sequential analysis 

allows the formation of an array of observations one by one (or, more generally, in groups), while the 

decision to conduct the next observation (group of observations) is made on the basis of an already 

accumulated array of observations. In view of this, the theory of sequential statistical analysis is closely 

related to the theory of optimal stopping. 

Of great importance is the section of mathematical statistics related to the conduct of sample surveys, 

with the properties of various schemes for organizing samples and the construction of adequate methods for 

evaluating and testing hypotheses. Dependency recovery problems have been actively studied for more than 

200 years, since the development of the least squares method by K. Gauss in 1794. 

The totality of all the studied objects is called the general totality. In a sample study, a certain 

number of objects are randomly selected from the entire population, called a sample, and only they are 

subjected to research.  

General population and sample size 

          The number of objects in a sample or general population is called the sample size. for example, if 100 

items are selected from 10,000 items for control, then the volume of the general population is n=10,000, and 

the sample size is n=100. 

         For statistical processing, the results of the study of objects that make up the sample are presented (in 

certain physical units) in the form of a numerical sample, i.e. in the form of a sequence of numbers x1, x2, 

x3,....., xn. 

       Variation series. a sample that is an increasing sequence of numbers is called a variational series. It is 

obvious that any numerical sampling can be written in the form of variational series. For example, by 

writing down the sample values 

1,10, -2,1,0,1,10,7, -2,10,10,7 

in the form of an increasing sequence, we get the variational series 

-2,-2,0,1,1,7,7,10,10,10,10. 

The difference between the largest value of a numerical sample and its smallest value is called the sample 

span. 

The sample span is 10-(-2)=12. 

let the study of a general population obtain a numerical sample of volume n, with the value of x1 

occurring in the sample n1 times, the value of x2-n2 times,..., the value of xk-nk times. The numbers n1, n2, 

n3,.... pc are called frequencies, and their ratios to the sample size, i.e. the ratios n1/n, n2/n.... pc/n, are the 

relative frequencies of the corresponding values x1,x2,....,xk of the sample. 

Obviously, the sum of the frequencies is equal to the sample size, and the sum of the relative frequencies is 

equal to one, since 

        n1+n2+n3+……+nк=n ,    n1/n+n2/n+……+nк/n=1. 

Statistical series. A sequence of pairs (a number with a frequency of occurrence) (x1; n1), 

(x2;n2),....., (xk;nk) is called a statistical series. 

Usually a statistical series is written in the form of a table: 

x1 x2 x3 ….. xi ….. хk 

n1 n2 n3 ….. ni ….. nk 

Example. for the selection 3, 8, -1, 3, 0, 5, 3, -1, 3, 5 

determine the volume and scope. Write the sample in the form of a variation series and in the form of 

a statistical series. Find the sample distribution. The sample size is n=10, its range is 8-(-1)=9. 

by writing the sample values as an increasing sequence, we obtain a variational series 

-1,-1,0,3,3,3,3,5,5,8. 

 A statistical series can be written as a sequence of pairs of numbers (-1;2),(0;1),(3;4),(5;2),(8;1) 

or in the form of a table 

-1  0 3 5 8 

2 1 4 2 1 



For control, we find the sum of frequencies, which should be equal to the sample size 

2+1+4+2+1=10. 

After calculating the relative frequencies, we find the sample distribution  

-1 0 3 5 8 

2/10 1/10 4/10 2/10 1/10 

For control, we make sure that the sum of relative frequencies is equal to one 

:  2/10+1/10+4/10+2/10+1/10=1. 

Graphical images of the sample. Polygon and histogram. 

For a visual representation of the sample, various graphical images of the sample are often used. The 

simplest sample images are a polygon and a histogram. 

A frequency polygon (Fig.1) or a relative frequency polygon is a polyline with vertices at (x1;n1), 

(x2;n2),....., (xk;nk) or (x1;n1/n), (x2;n2/n),....., (xk;nk/n), respectively. It is clear that the relative frequency 

polygon is obtained from the frequency polygon by compressing along the ordinate axis n times, where n is 

the sample size.  

ni
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 -1    0    3    5  8 x i 

рис.1 

A histogram of relative frequencies is a stepped figure consisting of rectangles whose bases are 

partial intervals of length ∆x, and heights wi/∆x , where wi is the sum of the relative frequencies of the 

sample values that fall into the i - th interval. 

The area of the histogram of relative frequencies is obviously equal to one. 

For example, a sample is obtained (the sum of the current score of first-year students in computer 

science during the I - semester) 

218 221 215 225 225 217 

224 220 220 219 221 219 

222 227 218 220 223 230 

223 216 224 227 220 222 

Plot a frequency histogram if the number of partial intervals is 5. 

the smallest sample value is 215, the largest is 230. find the length of partial intervals h =(230-215)/5=3. we 

calculate, taking into account the multiplicity, the number of sample values that fall into each interval. for 

the first interval (215;218) this number is 3, for the second (218;221) it is 8, for the third (221; 224) - 6, for 

the fourth [224;227] - 5, for the fifth [227;230] - 2.  

Therefore, the heights of the rectangles (from left to right) forming the histogram are equal 1, 8/3, 2, 

5/3, 2/3. Based on the obtained data, we build a histogram Fig.2. For control, make sure that the area of the 

histogram is equal to the sample size: 



S гист.= 3(1+8/3+2+5/3+2/3)=24.       

n /3 
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Figure.2 

Selective characteristics 

The arithmetic average of the 

Let there be some sample of volume n: 

x1, x2, ……, xn. 

The sample mean for the variation series is determined by the formula 

Mв=(x1+x2+…..+xn)/n 

If the sample is given by a statistical series, then the sample average is determined by the formula 

Mст=(n1x1+n2x2+…..+nkxk)/n 

Mean square deviation 

this indicator is an important characteristic of a random variable since it characterizes the degree of 

dispersion of the results of observations around the arithmetic mean, and also gives information about the 

stability and non-stability of the studied process. 

if the results of studies are presented in the form of a series of variations, the mean square deviation 

is calculated by the formula 

σв= ((x1- M)
2
 + (x2-M)

2
+ ……+(xn-M)

2
)/(n-1)

If the results of studies are presented in the form of a statistical series, the mean square deviation is 

calculated by the formula 

σст= (n1(x1- M)
2
 +n2(x2-M)

2
+ ……+nk(xk-M)

2
)/(n-1)

Standard Error 

When sampling a small volume, the estimate of the arithmetic value may differ 

significantly from the true value of the random variable and lead to gross errors. Therefore, for a small 

volume of observations, use interval estimates, which are determined by two numbers - the ends of the 

interval covering the estimated random variable. 

The average square error of the arithmetic mean is calculated by the formula 

m=σ / n

The confidence interval (M ± m) 

The value of the average square error of the arithmetic mean of a random variable 

shows the limits within which the true value of the arithmetic mean of a random variable M ± m is 

contained. 

A) The upper limit of M + m



B) the Lower limit M - M

х 

+m 

М        95% достоверность 

-m     

n  

A measure of the accuracy of the results 

(Confidence criterion) 

Using the arithmetic mean M and its mean squared error m, it is possible to estimate the accuracy of 

the observations made. 

To do this, an indicator of the accuracy of observations is calculated, which we denote Rt. 

Rt = m / M * 100% 

if r<=5%, then 95% of the research results are considered reliable. 

10.1. Student's Criterion. 

In 1906, the English mathematician W. Gosset published his works under the pseudonym "Student" 

where he established the distribution of the random variable t. 

the "student a" distribution is widely used in the processing of research results that obey the normal 

distribution law. 

As you know, when conducting research, many experiments are performed and control experiments 

are often distinguished among them. There is a problem of the need to compare the results obtained with the 

data obtained by other authors who conducted similar studies. The proximity and difference between control 

studies and other observations or between the own results of observations from the results of observations of 

other authors can be determined by the Student's criterion using the formula

Tэксп =ABS( M1 - M2)/ SQR(m
2 

1 +  m
2 

2)

  where, T is the Student's criterion; 

M1 - the arithmetic mean of the result of observations of a group of control experiments; 

M2 - arithmetic mean of the result of other groups of observations; 

m1 , m2 - the standard error of the control and observed groups; 

Further, based on the calculated values of the Tec and the number k - the degree of freedom, the 

probability of differences is determined by the Student's table. When comparing two groups (series), the 

degree of freedom is calculated by the formula k = n1 + n2 -2 

n1 - the number of observations in the control groups (experiments). 

n2 - number of observations in other groups (experiments). 

If, when comparing two rows of the calculated values of teksp > Ttable, then they are significantly different 

and the probability of differences is P=>0.95 ( Significance of differences is p<= 0.05). The 

probability and confidence interval of the study results obeying the normal distribution law 

P= 95% ( M+σ),            P=99%( M+2σ),         P=99,9 ( M+3σ). 

5.2 Correlation analysis 

In biomedical research, much attention is paid to establishing links between various parameters, 

signs or phenomena. 

In mathematics, the concept of a function is used to express the relationship between variables. 



a functional relationship is defined when only one value of another variable corresponds to a 

particular value of one variable. In general, this dependence is written as follows: y = f (x). For example, the 

length of a circle is uniquely related to the radius of the circle: L = 2nr.   

However, in biomedical experiments, functional dependencies are not always found, and more often 

one value of a trait corresponds to several values of another trait. 

For example, with the same height, the weight of different individuals may be different. 

The section of mathematical statistics that deals with the establishment of relationships between 

random variables is called correlation and regression analysis. 

Correlation analysis is used to determine the tightness and direction of the relationship between the features. 

Establishing the relationship between various signs and indicators of the functioning of the body, allow for 

changes in some of them, to judge the state of others.  

Let us assume that as a result of medical and biological studies, experimental data on changes in two 

indicators X and Y are obtained.                           X:  x1 ; x2 ; ……; xn 

Y:  y1 ; y2 ; ……; yn 

If the obtained data is plotted on the coordinate plane, the points will occupy a certain area, which is 

usually called the correlation field. 

Linear correlation is most often used in experimental studies. 

It is assumed that the general aggregates for X and Y have a normal distribution law or close to it. 

In this case, the tightness of the linear connection is determined by the formula: 

 R=( Y* X - Y *X)/ (σx *σy) 

where r is the correlation coefficient, σx and σy are the mean square deviations of the values x and y 

Y*X = (y1* x1 +y2* x2 +…..+yn* xn )/ n 

         Y= (y1 + y2 + ……+yn) / n 

         X = ( x1 + x2 +…..+ xn )/n  

The correlation coefficient ranges from -1 to +1 (-1<= Rx/y <= +1): 

1) Negative R values from 0 to -1 indicate an inverse relationship between the variables.

2) Positive values of R from 0 to +1 characterize a direct relationship between the features.

3) When R=0, this indicates that there is no statistical linear relationship between the features.



It is generally accepted that the correlation coefficient at: 

R<0.3 is considered weak 

0.3<r<0.5 the relationship is considered moderate 

0.5<R<0.7 correlation is considered significant 

0.7<r<0.9 correlation is considered strong 

R>0.9 correlation of a very strong, close functional relationship. 

5.3. Modeling of various systems 

The most important mathematical models usually have an important property of universality: fundamentally 

different real phenomena can be described by the same mathematical model. Thus, studying one 

mathematical model, we study at once the whole class of the phenomena described by it. 

Modeling is a method of research in which the object of research is replaced by another, which is called a 

model 

The physical model. 
Currently, there are a wide variety of types of models that 

can be classified in various ways. 

In accordance with this, all models used in biology and 

medicine are divided into biological, physico-chemical, 

cybernetic, and mathematical models. 

Physical (analog) models are physical systems or devices 

that simulate a real object by special design 

A physical model is a model created by replacing objects 

with modeling devices that mimic certain characteristics or 

properties of these objects. In this case, the modeling device has 

the same qualitative nature as the simulated object. 

Physical models use the scale effect in the case of the 

possibility of proportional application of the entire complex of 

studied properties. 

A physical model is an analog model in which there is an unambiguous correspondence between the 

parameters of an object and a model of the same physical nature. In this case, the system element 

corresponds to physical equivalents that reproduce the structure, basic properties and relations of the object 

under study. In physical modeling, which is based on the theory of similarity, the features of conducting an 

experiment in nature are preserved in compliance with the optimal range of changes in the corresponding 

physical parameters. 

Physical modeling is a method of experimental study of various physical phenomena based on their 

physical similarity. The method is applied under the following conditions: 

Reproducing the physical phenomenon under study for experimental purposes on a real scale is 

impossible, undesirable, or too expensive (for example, a tsunami). 

The method consists in creating a laboratory physical model of the phenomenon on a reduced scale, 

and conducting experiments on this model. The conclusions and data obtained in these experiments are then 

extended to the phenomenon on a real scale. 

The method can give reliable results only if the physical similarity of the real phenomenon and 

model is observed. similarity is achieved due to the equality of the values of similarity criteria for the model 

and the real phenomenon — dimensionless numbers that depend on the physical (including geometric) 

parameters that characterize the phenomenon. The experimental data obtained by the method of physical 

modeling extend to the real phenomenon also taking into account the similarity criteria. 

Scale model of the city center in 

Singapore 



Physical models include electromechanical devices that replace organs and systems of a living 

organism: 

- artificial respiration apparatus (simulate the lung), 

- artificial blood circulation apparatus (heart model), 

- hemodialysis apparatus (kidney model), etc. 

Currently, these devices are widely used in medical practice. 

 in a broad sense, any laboratory physical experiment is a simulation, since in the experiment a

specific case of a phenomenon is observed in particular conditions, and it is necessary to

obtain general laws for the entire class of similar phenomena in a wide range of conditions.

 The art of experimentation is to achieve a physical similarity between the phenomenon

observed in the laboratory and the entire class of phenomena studied.

 Some examples of the application of the physical modeling method:

 Исследование Investigation of gas flows and flow around aircraft, cars, etc. in wind tunnels.

 Hydrodynamic studies on reduced models of ships, hydraulic structures, etc.

 study of seismic stability of buildings and structures at the design stage.

 Study of the stability of complex structures under the influence of complex power loads.

 measurement of heat fluxes and heat dissipation in devices and systems operating under high

thermal loads.

 study of natural phenomena and their consequences.

Mathematical models 

This is a set of equations that establish a quantitative relationship between parameters that describe 

the properties of the object, phenomenon or process being studied.   

A mathematical model is a mathematical representation of reality. 

Features of mathematical models: 

- a mathematical model allows you to judge the behavior of an object in such conditions that are 

difficult to create in an experiment or clinic; 

- the mathematical model allows you to predict the course of the disease and choose the best 

treatment options; 

- mathematical model of biological systems, allows you to reduce the time of research and reduce the 

number of animals needed for research.  

Mathematical modeling is the process of building and studying mathematical models. All natural 

and social sciences that use mathematical tools are essentially engaged in mathematical modeling: they 

replace a real object with its mathematical model and then study the latter. 

No definition can fully cover the actual mathematical modeling activity. Despite this, definitions are 

useful because they attempt to highlight the most significant features. 

Definition of the model according to A. A. Lyapunov: Modeling is an indirect practical or theoretical 

study of an object, in which not the object of interest itself is directly studied, but some auxiliary artificial or 

natural system (model):  

* being in some objective correspondence with the object to be known;

* able to replace it in certain ways;

* which, in the final analysis, gives information about the object being modeled itself.

According to the textbook of Sovetov and Yakovlev: "a model (Lat. modulus-measure) is an object-

substitute for the original object, which provides the study of some properties of the original.". "The 

replacement of one object by another with the aim of obtaining information about the most important object 

properties of the original by using the object model is called modeling.". "Under the mathematical modeling 

we mean the process of establishing compliance with the real object of a particular mathematical object 

called a mathematical model and investigation of this model allows to obtain the characteristics of the real 

object. The type of mathematical model depends both on the nature of the real object, and the tasks of 

studying the object and the required reliability and accuracy of solving this problem.» 

According to Samarsky and Mikhailov, a mathematical model is "the" equivalent "of an object, 

reflecting in mathematical form its most important properties — the laws to which it obeys, the connections 

inherent in its constituent parts, etc." 

Finally, the most concise definition of a mathematical model is "An equation expressing an idea". 



This is a set of equations that establish a quantitative relationship between parameters that describe 

the properties of the object, phenomenon or process under study (taking into account internal connections 

and external influences).   

The features of mathematical models are as follows: математ 

a mathematical model allows you to judge the behavior of an object in such conditions that are difficult to 

create in an experiment or clinic; 

- accurate, economical and objective; 

the mathematical model allows you to predict the course of the disease and choose the best treatment options 

(medications); 

a mathematical model of biological systems that takes into account a variety of interrelated processes of a 

living organism allows you to reduce the time of research and reduce the number of animals needed for such 

research 

Computer simulation systems 

Computer mathematics systems have been developed to support mathematical modeling, such as 

Maple, Mathematica, Mathcad, MATLAB, VisSim, etc. They allow you to create formal and block models 

of both simple and complex processes and devices, and easily change the parameters of the models during 

the simulation. Block models are represented by blocks (most often graphical), the set and connection of 

which are set by the model diagram. 

Regression analysis 

A function that allows you to find the average values of another trait-Yx by the value of one trait-X, 

is called regression. 

Regression analysis allows you to describe the form of dependence between random variables using 

regression equations (linear, quadratic, exponential, etc.). 

Regression and correlation analyses are closely related. 

The analytical form of recording the relationship between the values of X and Y is the regression line 

equation. 

The regression line is drawn in the correlation field so that it passes closest to all points. 

The "least squares method" is usually used as the proximity criterion 

».    

The least squares method is one of the regression analysis methods for estimating unknown 

quantities based on measurements containing random errors. 

The least squares method is also used to approximate the representation of a given function by other 

(simpler) functions and is often useful in processing observations. 

When the desired value can be measured directly, such as the length of a segment or an angle, then, 

to increase accuracy, the measurement is performed many times, and the arithmetic mean of all individual 

measurements is taken as the final result. This rule of arithmetic mean is based on considerations of 

probability theory; it is easy to show that the sum of the squares of the deviations of individual 

measurements from the arithmetic mean will be less than the sum of the squares of the deviations of 

individual measurements from any other quantity. The arithmetic mean rule itself is therefore the simplest 

case of the least squares method. 

The worst-squares method is the minimum sum of the squares of the deviation of the experimental 

points from the regression line.     (Y экс - Yтеор )
2
 => min  (i=1,n).



Consider linear regression, which is expressed by a simple linear dependence equation: 

 Yx=a*Х+b       

Here, Yx is the arithmetic mean of the variable Y corresponding to the given value of X; 

a and b are parameters of the equation; 

b - free term, a-regression coefficient. 

  a = ( Y*X-Y*X ) / ( X^2 - ( X )^2) 

  b = Y - a*X 

The parameters of the regression equation calculated using these formulas determine the "best" direct 

uteor, i.e. the sum of the squared differences between the observed estimated values of the uexp will be 

minimal (min). 

Prediction 

 Prediction (from the Greek. πρόγνωσις — foresight, prediction) — the prediction of the future using

scientific methods, as well as the result of the prediction itself.

 A forecast is a scientific model of future events, phenomena, etc. A

 forecast is a calculation of an unknown economic indicator based on specified factors based on a

model.

 Forecasting, development of a forecast; in a narrow sense — a special scientific study of specific

prospects for the development of a process.

 Forecasts are shared

 by terms: short-term, medium-term, long-term.

 by scale: personal, at the enterprise (organization) level, local, regional, industry, country, global

(global). 

The main forecasting methods include 

* statistical methods;

* Expert assessments (Delphi method);

* modeling.

Forecasting is carried out by extrapolating the formed process (mathematical model) to the present 

time in the future. 

For example: 

1. The table shows the dependence of atmospheric pressure on the height of the lift. Based on these

data, a mathematical model y=ax+b is constructed, which fully describes this table.      

pressure gauge (mm hg)) P1 P2 P3 P4 P5 P6 P7 

Altitude (km) H1 H2 H3 H4 H5 H6 H7 

2. Based on the obtained mathematical model is defined by the atmospheric pressure Progn at the

height of Prognos ie in formula y=ax+b is x is Prognos (projected height) and determine the projected 

amount of pressure on Upohn . 

Program for predicting postoperative complications in children with VRN 

When analyzing experimental data based on a mathematical model of the process, the main task is to 

determine the parameters of the model based on the results of observations. 

This is due to the fact that the parameters of the model calculated from real data are estimates of the 

parameters of the organism. 

Within the framework of a mathematical model, the choice of parameters can always be interpreted 

as a transition from a pathological to a healthy state of the body. 

Based on correlation and regression analysis for a set of clinical, laboratory and biochemical 

parameters (Table 1). 1 and 2) a multiple linear mathematical model is constructed 

: 

Yk=1.102335 – 0.01185 * x1 +0.545827*x2 – 0.02144 *x3 – 0.15949 *x4 – 0.01027 * x5 + 0.005959 

*x6 + 0.001654 * x7  - 0.00203 *x8

Yb=5.181555  +0.05195257 * x9 -0.1543024*x10 – 0.0165529 *x11 +5.13345E-05 *x12 + 0.0531037 * 

x13 - 0.0032743 *x14 + 0.00680218 * x15  



Block diagram of the forecast - " phase interval method» 

When predicting an unfavorable outcome, medical correction is performed both in the pre-and 

postoperative period. 

Applications (computer) for forecasting 

Computer programs — forecasting tools-are used for time series forecasting. This allows you to 

automate most of the operations when building a forecast, and also allows you to avoid errors associated 

with data entry. Such applications can be either local (for use on a single computer) or Internet applications 

(available as a website, for example). Such programs as SPSS, Statistica, and Forecast Expert should be 

singled out as local applications. 

5.5 Working with formulas and functions in MS Excel. The structure of 

the formula 

Formulas are expressions that are used to perform calculations.the formula always starts with the 

equal sign (=). a formula can include functions, cell references, or names, operators, and constants. 

for example, in the formula 

=SUMM(В2:В8)*30 

sums () – function; 

B2 and B8 are cell references; 

: (colon) and * (asterisk) are operators; 

30-constant. 



Functions are predefined formulas that perform calculations based on specified values, called 

arguments, and in the specified order. Structure function: a function name, an opening parenthesis, the 

argument list, separated by semi-colons, closing parenthesis. The function argument can be a number, text, 

boolean value, array, error value, cell reference. Constants, formulas, or functions are also used as 

arguments. 

The reference points to the cell or range of cells in the worksheet that you want to use in the formula. 

You can specify links to cells in other sheets of the current workbook and to other workbooks. Links to cells 

in other books are called links. 

An operator is a sign or symbol that specifies the type of calculation in a formula. There are 

mathematical, logical, comparison and reference operators. 

A constant is a constant (not calculated) value. The formula and the result of calculating the formula 

are not constants. 

Creating and editing formulas 

Entering formulas from the keyboard 

Formulas can be entered using the keyboard and mouse when working in any Excel tab. 

Using the keyboard, enter operators( action signs), constants, parentheses, and, sometimes, functions. 

Use the mouse to select the cells and ranges of cells that are included in the formula. 

Select the cell where you want to enter the formula. 

Enter = (equal sign). 

Select the cell that is an argument of the formula with the mouse. 

Enter the operator sign. 

Select the cell that is the second argument of the formula with the mouse. 

If necessary, continue typing characters of the operators and selection of cells. 

Confirm entering the formula in the cell: press Enter or Tab or the Enter button (check mark) in the 

formula bar. 

For example, you need to create a formula for calculating the cost of several books in cell D2 of the 

table in Figure 6.1: 

select cell D2,  

enter the sign =, 

click on cell B2, 

enter the sign *, 

click on cell C2, 

press the Enter key. 

Figure 1. Entering a formula using the keyboard 

When you enter the formula from the keyboard, it is displayed both in the formula bar and directly in 

the cell (see Figure 1). The cells used in the formula are highlighted with a colored border, and the links to 

these cells in the formula are in the same color font. 

Creating formulas using the Function Wizard 

A function is a standard formula that performs certain actions on values that act as arguments. 

Functions allow you to simplify formulas, especially if they are long or complex. Functions are used not 

only for direct calculations, but also for converting numbers, such as rounding, searching for values, 

comparing, and so on. 



To create formulas with functions, you usually use the Function Library group of the Formulas tab 

1. Select the cell where you want to enter the formula.

2. Click the function category button in the Function Library group and select the desired function.

3.in the function arguments window, enter the function arguments in the corresponding field (s). Cell

references can be entered using the keyboard, but it is more convenient to use the mouse to select cells. To 

do this, put the cursor in the appropriate field and select the desired cell or range of cells on the sheet. To 

make it easier to select cells, you can move or collapse the Function Arguments window. Text, numbers, and 

Boolean expressions are usually entered as arguments from the keyboard. as a hint, the window displays the 

function assignment, and at the bottom of the window displays a description of the argument in which the 

cursor is currently located. It should be borne in mind that some functions do not have arguments. 

4. in the function arguments window, click ok.

you don't have to use the function category buttons in the function library group to insert a function. 

you can use the function wizard to select the desired function. moreover, this can be done when working in 

any tab. 

click insert function in the formula bar. 

In the Function Wizard window: Step 1 of 2 (Figure 2), in the Category drop-down list, select the 

function category, then in the Select Function list, select the function. 

Click OK or double-click the name of the selected function. 

Figure 2. Selecting a function in the Function Wizard 

In the Function Arguments window that appears, enter the function arguments in the same way as in 

the previous case. Click ok. 

Creating formulas using the Sum button 

To quickly perform some actions using functions without starting the function wizard, you can use 

the Sum button. this button, in addition to the function library group of the formulas tab (where it is called 

autosum), is also available in the edit group of the home tab. 

To calculate the sum of numbers in cells located continuously in one column or one row, just select 

the cell below or to the right of the summed range and click the Sum button. For example, to calculate the 

sum of values in cells B2:B13 in the table in Figure 3, select cell B14 and click the Auto-Sum button. 



Figure 3. Summation using the Sum button 

To confirm entering the formula, press Enter or press the Sum button again. 

To calculate the sum of randomly arranged cells, select the cell in which the sum is to be calculated, 

click the Sum button, and then select the cells and/or ranges of cells to be summed on the sheet. To confirm 

entering the formula, press Enter or press the Sum button again. 

In addition to calculating the sum, you can use the sum button to calculate the average value, 

determine the number of numeric values, and find the maximum and minimum values. In this case, click on 

the arrow of the button and select the desired action: 

average – calculation of the arithmetic mean; 

number-determining the number of numeric values; 

maximum – finding the maximum value; 

Minimum – finding the minimum value. 

for example, to calculate the average value in cells b2:b13 in the table in figure 4, select cell b14, 

then click the arrow of the sum button and select the average action. 

Fig. 4. Calculation of average values using the buttons Amount 

Edit the formulas 

Cells with a formula can be edited in the same way as cells with a text or numeric value: by double-

clicking on the cell or in the formula bar. 

when editing a cell, as when entering a formula, cell references and borders around the 

corresponding cells are highlighted in color (see figure 6.1). 



Figure 5. Changes to the formula argument 

To change the reference to cells and/or a range of cells, simply drag the colored border to the new 

cell or range. To change the size of a range of cells, you can drag the corner of the border (Figure 5). 

To replace a link, delete it, and then select a new cell or range of cells with the mouse. 

You can add new operators and arguments to the formula. For example, in an existing formula, in 

cell B14 in the table in Figure 6.8, you can add the " / " operator (division) and the argument A20 (Figure 6).

Figure 6. Editing the formula 

Moving and copying formulas 

You can move and copy cells with formulas in the same way as cells with text or numeric values. 

In addition, when copying cells with formulas, you can use the special insertion capabilities. This allows you 

to copy only the formula without copying the cell format. 

When you move a cell with a formula, the references contained in the formula do not change. when copying 

a formula, the cell references may change depending on their type (relative or absolute). 

Error checking 

checking errors when creating and editing formulas 

During the process of creating and/or editing formulas, excel detects errors in the formula syntax and 

suspends further work. 

If you find extra operator characters, extra or missing parentheses, etc., an error message is displayed 

in the warning window. 



 

Organization of calculations 

Setting the calculation mode 

By default, Microsoft Excel automatically recalculates cell values that depend on other cells that 

contain changed values. This type of recalculation avoids unnecessary calculations. Recalculation is also 

performed when the book is opened. 

To select the calculation mode, click the Calculation Parameters button in the Calculation group of 

the Formulas tab and select the desired mode. If the button is not displayed, first click the arrow of the 

Formula Dependencies button on the Formulas tab (Figure 6.7). 

 
Figure 7. Changing the calculation mode 

After that, to recalculate formulas in all sheets of the current workbook, press the Recalculate Group 

Calculation button of the Formula tab (see Figure 7) or the F9 key, and to recalculate formulas only on the 

current sheet, press the Recalculate Group Calculation button of the Formula tab (see Figure 6.7) or the Shift 

+ F9 key combination. 

 

6.4 .Basic statistical and mathematical functions. mathematical calculations 

About mathematical functions 

mathematical functions are used when performing arithmetic and trigonometric calculations, 

rounding numbers, and in some other cases. 

Summation 

A simple sum 

For the simplest summation, use the SUM function. 

The syntax of the function 

sums(a), 

where a is a list of 1 to 30 elements to be summed. An element can be a cell, a range of cells, a 

number, or a formula. references to empty cells, text or boolean values are ignored. 

in fact, this function replaces direct summation using the addition operator (+). The formula 

=sum(B2:b7), specified in cell b8 (figure 8), is identical to the formula =b2+b3+b4+b5+b6+b7.however, 

there are some differences. when using the sums function, adding cells to the summation range 

automatically changes the range entry in the formula. for example, if you insert a row in a table, the formula 

will specify a new summation range. similarly, the formula will change as the summation range decreases. 



Figure 8. Simple summation 

Multiplication 

For multiplication, use the PRODUCT function. 

The syntax of the function 

type(a), 

where a is a list of 1 to 30 elements that need to be multiplied. An element can be a cell, a range of 

cells, a number, or a formula. references to empty cells, text or boolean values are ignored. 

In fact, this function replaces direct multiplication using the multiplication operator (*). Just like 

when using the SUM function, when using the SUM function, adding cells to the multiplication range 

automatically changes the range entry in the formula. For example, if you insert a row in the table, the 

formula will specify a new multiplication range. Similarly, the formula will change as the range decreases. 

Rounding 

Rounding numbers is especially often required in monetary calculations. for example, the price of 

goods in rubles, as a rule, can not be set with an accuracy of more than two decimal places. if the calculation 

results in a larger number of decimal places, rounding is required. otherwise, the accumulation of 

thousandths and ten thousandths of the ruble will eventually lead to errors in calculations. 

you can use a whole group of functions to round numbers. 

The most commonly used functions are ROUNDED, ROUNDED UP, and ROUNDED DOWN. 

The function syntax is ROUNDED 

ROUNDED(A; B), 

where A is a rounded number; 

B – the number of decimal places (decimal places) to which the number is rounded. 

The syntax of the ROUND-UP and ROUND-DOWN functions is exactly the same as that of the 

ROUND-UP function. 

The ROUND function discards digits less than 5 when rounding, and rounds digits greater than 5 to 

the next digit. The ROUNDING UP function rounds any digits to the next digit when rounding. The 

ROUND DOWN function discards any numbers when rounding. An example of rounding to two decimal 

places using the ROUND, ROUND UP, and ROUND DOWN functions is shown in Figu. 



 
Fig. 9. Rounding to a given number of decimal places 

You can also use the ROUND, ROUND-UP, and ROUND-DOWN functions to round off integers. 

TO DO this, use The negative values of The argument in. 

To round numbers down, you can also use the otb function. 

The syntax of the function 

Otb(a;b), 

where A Is a rounded number; 

B – the number of decimal places (decimal places) to which the number is rounded. 

In fact, the OTB function discards the extra characters, leaving only the number of characters 

specified in the argument B. 

Just like the ROUND, ROUND-UP, and ROUND-DOWN functions, the OTB function can be used 

to round off whole digits of numbers. To do this, use the negative values of the argument in. 

To round a number to a smaller integer, you can use the INTEGER function. 

The syntax of the function 

INTEGER(A), 

where A is a rounded number. 

An example of using the function is shown in Figure 10. 

 
Fig. 10. Rounding to the nearest whole number 

To round a number with a given precision, you can use the ROUNDING function. 

The syntax of the function 

ROUNDED(A;B), 

where A is a rounded number; 

B – the accuracy with which you want to round the number. 

exponentiation 

 

for exponentiation, use the degree function. 

The syntax of the function 



DEGREE(A;B), 

where A is a number raised to a power; 

B is an indicator of the degree to which the number is raised. 

Negative numbers can only be raised to a power whose value is an integer. otherwise, there are no 

restrictions on exponentiation. 

to extract the square root, you can use the root function. 

The syntax of the function 

root(a), 

where a is the number from which the square root is extracted. 

You can't extract the root of negative numbers. 

 

Trigonometric calculations 

In Microsoft Excel, you can perform both forward and reverse trigonometric calculations, that is, 

knowing the value of an angle, find the values of trigonometric functions, or knowing the value of a 

function, find the value of an angle. 

the syntax of all direct trigonometric functions is the same. For example, the syntax of the SIN 

function. 

sin(a), 

where a is the angle in radians for which the sine is determined. 

Similarly, the syntax of all inverse trigonometric functions is the same. For example, the syntax of 

the function ASIN 

ASIN(A), 

where A is a number equal to the sine of the defined angle. 

Note that all trigonometric calculations are performed for angles measured in radians. To convert to 

more familiar degrees, use the conversion functions (DEGREES, RADIANS) or translate the values yourself 

using the PI () function. 

The PI () function inserts the value of a number (pi). The function has no arguments, but you can't 

delete the parentheses after the name. 

For example, if you need to calculate the value of the sine of the angle specified in degrees, you need 

to multiply it by PI ()/180.

 
Fig. 11. Calculation of trigonometric functions for angles specified in degrees 

Statistical calculations 

about statistical functions 

Statistical functions are used in data analysis. Using most of the functions in this category requires 

knowledge of mathematical statistics and probability theory. 

 

Calculation of average values 

 

In the simplest case, the CPN function is used to calculate the arithmetic mean. 



The syntax of the function 

CP = (A), 

where A is a list of 1 to 30 elements whose average value is to be found. An element can be a cell, a 

range of cells, a number, or a formula. references to empty cells, text or boolean values are ignored. 

If the range for which the average value is calculated includes data that differs significantly from the 

rest, the calculation of the simple arithmetic mean may lead to incorrect conclusions. In this case, you should 

use the LOWER-MIDDLE function. This function calculates the average by discarding the specified 

percentage of data with extreme values. 

The syntax of the function 

LOWER the AVERAGE(A; B), 

where A is a list of 1 to 30 elements whose average value is to be found. An element can be a cell, a 

range of cells, a number, or a formula. References to empty cells, text or boolean values are ignored; 

B – the percentage of data excluded from calculations. 

The percentage of data excluded from calculations is indicated as a percentage of the total number of 

data. For example, a fraction of 10 % means that 2 values are discarded from data containing 20 values: one 

is the largest, the other is the smallest. In the table in Fig. 7.11, the value of the defect for the product "Luna" 

(34 %) differs significantly from the other values. The arithmetic mean of the data is 2.23 % (cell E3), which 

gives a somewhat distorted picture of the actual values. Calculating the average value using the CUT-

DOWN function (cell E4) gives a more correct idea of the average values of defects in batches of goods 

(0.58 %). 

 
Figure 12. Calculation of the average value with the rejection of a given percentage of data with 

extreme values 

 

To some extent, the median gives an idea of the average value of a set of data. The median is a 

number that is the middle of a set of numbers, that is, half of the numbers have values greater than the 

median, and half of the numbers have values less than the median. To calculate the median, use the 

MEDIAN function. 

The syntax of the function: 

MEDIAN(A), 

where A is a list of 1 to 30 elements to find the median among. An element can be a cell, a range of 

cells, a number, or a formula. references to empty cells, text or boolean values are ignored. 

for example, for the data in the table in figure 7.12, the median is 3.0% (cell e3), while the average is 

4.0 % (cell e2). 

 

 



 
Fig. 13. Calculation of the middle set of numbers 

To find the value that is not the average, but is most often found in the data set, use the MOD 

function. 

Function syntax: 

MODE (A), 

where A is a list of 1 to 30 elements, among which you want to find the most common value. An 

element can be a cell, a range of cells, a number, or a formula. references to empty cells, text or boolean 

values are ignored. 

For example, for the data in the table in Figure 7.13, the most common value (mode) is 4% (cell E3), 

while the average value is 2.8 % (cell E2). 

 
 

Fig. 14. Finding the most frequently occurring, or repetitive values 

 

When calculating the average rate of change of a parameter, a more correct representation is given 

not by the arithmetic mean, but by the geometric mean. it is especially convenient to use the geometric mean 

when calculating the average growth rate of production, the average percentage of the contribution, etc.to 

calculate the geometric mean, use the srgeom function. 



The function syntax is: 

CREAM(A), 

where a is a list of 1 to 30 elements whose geometric mean is to be found. An element can be a cell, a 

range of cells, a number, or a formula. references to empty cells, text or boolean values are ignored. 

For example, for the data in the table in Figure 7.14, the average implementation gain (geometric 

mean) is 3.46 % (cell E3), while the average value is 4.33 % (cell E2). 

 
Fig. 15. Calculation of the geometric mean 

 

finding extreme values 

To find the extreme (largest or smallest) values in the data set, use the MAX and MIN functions. 

The syntax of the function MAX: 

MAX(A), 

where A is a list of 1 to 30 elements, among which you want to find the largest value. An element 

can be a cell, a range of cells, a number, or a formula. references to empty cells, text or boolean values are 

ignored. 

The MIN function has the same syntax as the MAX function. 

The MAX and MIN functions only define the extreme values, but do not show in which cell these 

values are located. 

In cases where you want to find not the largest (smallest) value, but a value that occupies a certain 

position in the data set (for example, the second or third largest), you should use the LARGEST or 

SMALLEST functions. 

The syntax of the function is LARGEST: 

LARGEST(A; B), 

where A is a list of 1 to 30 elements, among which you want to find a value. An element can be a 

cell, a range of cells, a number, or a formula. References to empty cells, text or boolean values are ignored; 

B – position (starting from the largest) in the data set. if you want to find the second value by value, 

then specify position 2, if the third, then position 3, and so on. 

the smallest function has the same syntax as the largest function. 

for example, for the data in the table in figure 7.15, the second largest value is 12 % (cell e1), and the 

second smallest value is 2 % (cell e2). 



 
Figure 16. Finding values by relative location 

The "problem" method. students are divided into subgroups. Teams are given or shown a specific 

situational problem. Team members will have to identify the problem, find out the reasons for its 

occurrence, and they will also have to find ways to solve this problem. 

The "Blitz game" method. The group is divided into subgroups or teams, all are given a common 

scheme-a task. There is a discussion in each subgroup and the correct answer is put in the columns. 

After that, the teacher calls the correct answer and calculates the correspondence of correct and 

incorrect. 

The "brainstorming" method. A specific concept related to the topic is written on the board or 

demonstrated on the side. Students will have to express their thoughts related to this concept. And on 

the basis of these statements, all the basic concepts of the current topic are determined. 

Control question 

1. What does mathematical statistics study? 

2. When did mathematical statistics appear and in the works of which scientists do some of its 

elements and their description occur? 

3. In which areas are the methods of mathematical statistics used? 

4. What is the General Population? 

5. What are the sample characteristics of a statistical series, 

6. What is the variation series? 

7. What is a statistical series? 

8. What is a correlation relationship? 

9. How do mathematical statistics and computers relate to each other? 

10. What does the correlation coefficient mean? 

11. What is a model? 

12. What is modeling? 

13. In what industries is mathematical modeling used? 

14. What is the difference between mathematical and physical models? 

15. What does the mathematical model of the process look like? 

16. What determines regression analysis? 

17. Application of the worst squares method? 

18. How is the regression coefficient calculated? 

19. What is a forecast? 

20. what tasks does the statistical method of forecasting solve? 

21. list the main procedures for processing predictive expert assessments? 

22. what computer applications of forecasting do you know? 

23. What is a function? 



24. What arithmetic operators are used in Excel?

25. What comparison operators are used in Excel?

26. How do I enter formulas using the keyboard?

27. For what calculations can I use the Sum button?

28. What mathematical functions are built into the spreadsheet?

29. What are statistical functions used for?

References: 
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6-Topic: Technology of storing, sorting and searching information. The Microsoft Office 

Access program. 

1.1. Model of technology training 

Duration of the lesson-2 hours        Number of students: 40-45 

Class form Informational lecture 

Plan of the lecture 

1-Basic concepts and 

classification of database 

management systems 

2-Microsoft Office Access 

Program 

 A database (db) is a collection of structured data stored in the memory 

of a computer system and displaying the state of objects and their 

relationships in the subject area under consideration. 

a database management system (dbms) is a set of language and software 

tools designed for creating, maintaining and sharing databases by many 

users. 

Purpose of the lesson: Familiarization of students with the concept of a Database (DB) and a 

Database Management System( DBMS), as well as the Microsoft Office 

Access program. 

Training method Demonstration: lecture and interview 

Type of training Collective 

Tools training Tutorials, textbooks, lecture text, projector, computer 

Training conditions Methodically equipped audience. 

Monitoring and evaluation 

1.2. Technological map of the lecture 

Stages of work and 

allotted time 

Stages of conducting a lesson by a teacher Students 

Preparatory stage. 1. Prepare an educational component of the topic.

2. Prepares presentation slides for the topic.

3. Make a list of literature used for the development of

the subject. 

1. Введение в тему

(15 мин) 

Will introduce you to the purpose and task of the topic. Listen 

2. Main stage

(55 min) 

1. Explains the topic and demonstrates the presentation.

2. Applies the posters.

Listen 

Write down 

3The final stage (10 

min) 

Makes a final conclusion. Listen 

4. Self-study tasks

(5 min) 

Declares tasks of independent work. Records 



1.1. Basic concepts and classification of database management systems 

A database (db) is a collection of structured data stored in the memory of a computer system and 

displaying the state of objects and their relationships in the subject area under consideration. 

The logical structure of data stored in a database is called a data representation model. The main data 

representation models (data models) are hierarchical, network, and relational. 

A database management system (dbms) is a set of language and software tools designed for creating, 

maintaining and sharing databases by many users. Typically, a DBMS is distinguished by the data model 

used. So, DBMS based on the use of a relational data model are called relational DBMS. 

DBMS tools are often enough to work with the database. However, if you want to make the database 

user-friendly for unqualified users, or the DBMS interface is not suitable for users, then applications can be 

developed. Their creation requires programming. An application is a program or set of programs that 

automate the solution of an application problem. Applications can be created in the environment or outside 

the DBMS environment — using a programming system that uses database access tools, for example, 

Delphi or C++ Build. applications developed in the dbms environment are often referred to as dbms 

applications, and applications developed outside the dbms are referred to as external applications. 

The data dictionary is a database subsystem designed for centralized storage of information about 

data structures, relationships of database files with each other, data types and formats of their representation, 

data belonging to users, security codes and access control, etc. 

Information systems based on the use of databases usually operate in a client-server architecture. in 

this case, the database is hosted on the server computer, and it is shared. 

The server of a certain resource in a computer network is the computer (program) that manages this 

resource, the client is the computer (program) that uses this resource. A computer network resource can be, 

for example, databases, files, print services, and mail services. 

The advantage of organizing an information system on a client-server architecture is a successful 

combination of centralized storage, maintenance and collective access to general corporate information with 

individual user work. 

according to the basic principle of the client-server architecture, data is processed only on the server. 

The user or application generates queries that are sent to the database server in the form of SQL statements. 

The database server searches for and retrieves the necessary data, which is then transmitted to the user's 

computer. The advantage of this approach in comparison with the previous one is a noticeably smaller 

amount of transmitted data. 

There are the following types of DBMS : 

* fully functional DBMS;

* the database servers;

* tools for developing database programs.

Full-featured DBMSs are traditional DBMSs. These include dBaseIV, Microsoft Access, Microsoft 

FoxPro, and others. 

Database servers are designed for the organization of data processing centers in computer networks. 

The database servers provide the processing of requests of client programs, normally using SQL statements. 

Examples of database servers are: Microsoft SQL Server, InterBase, etc. 

In the role of client programs, in general, DBMS, spreadsheets, word processors, e-mail programs, 

etc. can be used. 

Database development tools can be used to create the following programs: 

* client programs;

* database servers and their individual components;

* custom applications.

By the nature of the use of DBMS is divided into multi-user (industrial) and local (personal). 

Industrial, DBMS represent a software basis for the development of automated control systems for large 

economic objects. Industrial 

DBMS must meet the following requirements: 

* the ability to organize joint parallel work of many users;

* scalability;

* portability to various hardware and software platforms;



* resistance to failures of various kinds, including the presence of a multi-level system for reserving stored

information; 

* ensuring the security of stored data and a well-developed structured system of access to it.

Personal DBMS is software that is designed to solve the problems of a local user or a small group of users 

and is intended for use on a personal computer. This explains their second name-desktop. 

The defining characteristics of desktop systems are: 

* relative ease of operation, allowing you to create workable user applications based on them;

* relatively limited hardware resource requirements.

According to the data model used, DBMS is divided into hierarchical, network, relational, object-oriented, 

etc. Some DBMSs can support multiple data models at the same time. 

To work with data stored in the database, the following types of languages are used: 

* data description language — a high-level non-procedural declarative language designed to describe the

logical structure of data; 

* data manipulation language — a set of constructs that provide basic operations for working with data:

input, modification and selection of data on requests. 

The named languages may differ in different DBMSs. Two standardized languages are most widely 

used: QBE, a sample query language, and SQL, a structured query language. QBE basically has the 

properties of a data manipulation language, SQL combines the properties of both types of languages. 

The DBMS implements the following basic low-level functions: 

* Data management in external memory;

* buffer management memory;

* transaction management;

* logging changes to the database;

* ensuring the integrity and security of the database.

The implementation of the data management function in external memory provides the organization 

of resource management in the OS file system. 

The need for data buffering is due to the fact that the amount of RAM is less than the amount of 

external memory. Buffers are areas of RAM designed to speed up the exchange between external and RAM 

memory. The buffers temporarily store fragments of the database, data from which is supposed to be used 

when accessing the DBMS or is planned to be written to the database after processing. 

The transaction mechanism is used in the DBMS to maintain the integrity of the data in the database. 

A transaction is an indivisible sequence of operations on database data that is tracked by the DBMS from the 

beginning to the end. If for any reason (hardware failures and failures, software errors, including the 

application), the transaction remains incomplete, then it is canceled. 

an example of a transaction is the operation of transferring money from one account to another in the 

banking system. first, they withdraw money from one account, then transfer it to another account. If at least 

one of the actions is not performed successfully, the result of the operation will be incorrect and the balance 

of the operation will be violated. 

change logging is performed by the dbms to ensure the reliability of data storage in the database in 

the presence of hardware and software failures. 

Ensuring the integrity of the database is a necessary condition for the successful operation of the 

database, especially when it is used online. Database integrity is a property of a database, which means that 

it contains complete, consistent and adequately reflects the subject area of information. The complete state 

of the database is described using integrity constraints in the form of conditions that must be met by the data 

stored in the database. 

Security is achieved in the DBMS by data encryption, password protection, support for access levels 

to the database and its individual elements (tables, forms, reports, etc.). 

Models of data organization 

In a hierarchical model, entity objects and domain relationships are represented by data sets that have 

a tree-like (hierarchical) structure. The hierarchical data model was historically the first. On its basis, in the 

late 60s-early 70s, the first professional DBMS were developed. 

the main focus of integrity constraints in the hierarchical model is on the integrity of links between 

ancestors and descendants, taking into account the basic rule: no child can exist without a parent. 



the network data model allows you to display a variety of relationships of data elements in the form 

of an arbitrary graph. a network database consists of a set of records and a set of corresponding 

relationships. there are no special restrictions on the formation of a connection. while in hierarchical 

structures, a descendant record could have only one ancestor record, in a network data model, a descendant 

record can have an arbitrary number of ancestor records. 

The advantage of the network midsection of data is the possibility of its effective implementation. in 

comparison with the hierarchical model, the network model provides the highest possibilities in the sense of 

the permissibility of the formation of arbitrary connections. 

he disadvantage of the network data model is the high complexity and rigidity of the database 

schema built on its basis, as well as the complexity of its understanding by the average user. In addition, the 

network data model weakens the integrity control of links due to the permissibility of establishing arbitrary 

links between records. 

Systems based on the network model are not widely used in practice. 

The relational data model was proposed by Edgar Codd, an employee of IBM, and is based on the 

concept of relation. 

A relation is a set of elements called tuples. A visual form of representation of the relationship is a 

two-dimensional table. 

Using a single table, it is convenient to describe the simplest type of relationship between data, 

namely, the division of one object, information about which is stored in the table, into many subobjects, 

each of which corresponds to a row or record of the table. 

The main disadvantages of the relational model are the following: the lack of standard means of 

identifying individual records and the complexity of describing hierarchical and network relationships. 

Relational databases 

A relational data model (RMD) of a domain is a set of relationships that change over time. When 

creating an information system, a set of relationships allows you to store data about objects in the subject 

area and model the relationships between them. 

A relational database Management system (RDBMS; otherwise, a Relational Database Management 

System, RDBMS) is a DBMS that manages relational databases. 

the concept of relational (english relation — relation) is associated with the development of a well-

known english specialist in the field of database systems edgar codd (edgar codd). 

these models are characterized by the simplicity of the data structure, user-friendly tabular 

representation, and the ability to use the formal apparatus of relation algebra and relational calculus for data 

processing. 

the relational model is focused on organizing data in the form of two-dimensional tables. 

Each relational table is a two-dimensional array and has the following properties: 

*each table element is one data element

*all cells in a table column are uniform, meaning all elements in the column are of the same type (numeric,

character, etc.) 

*each column has a unique name

*there are no identical rows in the table

*the order of rows and columns can be arbitrary

a relational database is a data warehouse containing a set of two-dimensional tables. the data in the tables

must comply with the following principles.

1. attribute values must be atomic (in other words,

each value contained at the intersection of a row and column 

must not be split into multiple values). 

2. The values of each attribute must belong to the same type.

3. each entry in the table is unique.

4. Each field has a unique name.

5. The sequence of fields and records in the table is not essential.

The relation is the most important concept and is a two-dimensional table containing some data. 

An entity is an object of any nature, data about which is stored in a database. Entity data is stored in a 



relation. 

Attributes are properties that characterize an entity. In the table structure, each attribute is named and 

corresponds to the header of a certain column in the table. 

the key of a relationship is the set of its attributes that uniquely identify each of the tuples of the 

relationship. in other words, the set of attributes k, which is the key of the relation, has the property of 

uniqueness. The next property of the key is non-redundancy. that is, none of the proper subsets of the set 

k has the uniqueness property. 

the basic unit of data processing in relational databases is a relation, not its individual tuples (records). 

The lack of ordering of records in tables complicates the search. In practice, in order to quickly find the 

desired record, indexing of fields (usually key ones) is introduced. Creating index arrays consists of 

building an additional ordered information structure for quick access to records. 

Microsoft access program 

Before you start studying the ACCESS DBMS, let's look at a few basic concepts. 

Data is information that is systematized and structured in some way. There are at least three data 

models: hierarchical, network, and relational. 

Data models-a representation of data and their relationships that describe the concepts of the 

problem environment. Data models are used for both conceptual and logical and physical representation of 

data. 

Hierarchically structured data consists of several records, one of which is defined as the root. An 

example of a hierarchical model is trees: 

Where CUSTOMER, ORDER, SALES AGENT are records (CUSTOMER is the root record), 

NUMBER, LAST NAME, FIRST NAME, PATRONYMIC are the fields of the CUSTOMER record, the 

lines show connections. 

Tree - directed graph(a graph is a pair of sets, one of which describes a set of vertices, and another 

set of connections between them) where all vertices except the root are the head of only one arc, the root is 

not the head of any of the arcs and is associated with the top of the tree. 

Relationships can be defined between records in the hierarchy: one-to-many or one-to-one, where 

the entry corresponds to the element ―one‖ of the specified relationship is defined as the source, and 

corresponds to the element a lot as a child. 

The network model is similar to the hierarchical model, but it is a more general model, in the 

sense that there are many-to-many and many-to-one relationships between records, and there is no root 

node, i.e. any record can be root. 

Network model: 



where customer, order, sales agent are records, number, last name, first name, patronymic are 

fields of the customer record, the lines show connections. 

The relational data model is one of the simplest types of information representation and the easiest 

concept to understand. This model is data arranged in tables, usually two-dimensional. Tables of this type 

are called relationships (relationships) and each table is a separate file. 

The relational model: 

 Line Column 

CLIENT'S 

NUMBER 

SURNAME - CLIENT NAME - CLIENT Patronymic - CLIENT 

Поле 

ORDER 

NUMBER 

NAME - ORDER TRADING AGENT 

ROOM - SALES AGENT SURNAME NAM

E 

Patronymic SUPPLIED GOODS 

Each table consists of columns, rows each column is assigned a unique name, one element of the 

column is called a field, and the row is called a record. This example shows that both the network model and 

the hierarchical model can be reduced to a relational model. 

Data structured in this way can be stored in a computer in the form of Databases. A database can be 

defined as a collection of data intended for machine processing and storage that can be used by one or more 

users. 

Depending on the data models discussed above, databases can be hierarchical, networked, and 

relational. Next, we will consider only relational databases. 

Microsoft Access is an interactive relational database management system (RDBMS ) for 

WINDOWS . This is a program that you can use to store and retrieve data depending on the relationships 



you have established. Working with it is simplified by using the mouse manipulator. The graphical 

capabilities of the shell make a great impression when producing high-quality reports and printouts. All this 

is thanks to the support of True-type fonts and embedding of OLE objects (Object Linking and Embedding) 

within the WINDOWS environment. an ole object is a reference to certain information that remains in its 

original form. an ole object can be an excel spreadsheet, a paintbrush illustration, or a sound file. 

A novelty of the Access program is Cue Cards - a venting system. This is a training system that 

provides the user with recommendations on how to get out of real situations when solving applied problems. 

If you know English, the user will always be able to get a hint about what to do next. 

Access also provides the user with mechanisms for working with databases of various formats. For 

example, you can directly access dBase, Paradox, or Btrieve databases without converting them to the 

format used by Access. The Access package also includes the Access Basic language (a built-in dialect of 

the Visual Basic language), which makes it possible to create specialized database management systems. 

Introduction to the access 2010 dbms 

1.1. For General information about working with Access database engine 2010 

One of the products of the Microsoft Office 2010 package is Access 2010, it belongs to the category 

of database management systems (DBMS). The term database is understood as a collection of objects of 

various types (and purposes) that are used for storing, displaying, searching, converting and displaying data. 

The data is structured as tables.Access works with the following types of objects: tables, queries, forms, 

reports, macros, and modules. All of them are grouped by category and are displayed in the database 

navigation area. Data is digitally presented information about objects in the world around us. below is a brief 

description of the main types of objects (tables, forms, queries, reports, macros) that you will have to work 

with when learning how to build a database. 

tables contain data and display rows and columns in the usual format. In Access terminology, rows are 

called records, and columns are called fields. Therefore, all columns of the table have field names (the first 

row of the table). Strings contain data in the formats that the developer assigns to them. Therefore, when 

defining a relational database (tabular), it is said that it is represented as a collection of similar records. a 

database usually consists of several tables connected by means of so-called links. Relationships make 

information from one table available to another, which ensures data integrity. 
Forms are a variant of presenting a single record on the computer screen, which allows the user to 

view information from the table sequentially, search for and quickly access any record, as well as perform 

data correction operations in records and create new records (replenish the table). In fact, the form can be 

considered as a kind of user interface when working with tables. 
 Queries are nothing more than a tool for managing data. Using queries, you can extract data from one or 

more related tables, perform logical and arithmetic operations on data, and group data into new tables based 

on certain characteristics. 
Reports are a tool for preparing output files. It should be noted that the word report is strongly 

associated with the word "print", however, the report generation environment in Assess allows you to form 

the final product in the form of a virtual form. Any output form can be reflected on paper or on a computer 

screen in a convenient representation of data using the means of formatting, summarizing, filtering and 

graphical conversion to histograms and charts. 
Macros are the simplest programs that allow you to perform certain actions when accessing pre-

created queries, forms, and reports. In Access, the macro is not created using the macro recorder, but is 

assigned by the developer. That is, to create a macro, you need to turn to the constructor mode, in which you 

can select the action and arguments of the macro. 
Module-contains one or more procedures written in Visual Basic for Application. with the help of 

modules, you can solve a wide class of tasks for searching and converting information in a database. 

1.2. Getting started in Access 2010 

Before you start working with Access 2010, you will need to specify the location on the disk where 

the file with the database you are creating will be located. 

1. Launch the Microsoft Access 2010 application. To do this, left-click on the Start icon (in the lower-left

corner). Sequentially run: Programs Microsoft Office Microsoft Access 2010. 



2. In the window that opens (Microsoft Access), specify the name of the database (in the window with the 

name "File Name", as shown in Figure 1), and then click on the icon - (Search for a location to place the 

database). 

3. In the window: New Database File, create a folder, for example, Access 2010, and save the empty 

database file named " Employee Information.accdb».  
Figure 1. Example of filling in the window with the name of the new database 

            After the button is pressed , the system will open a window with a new empty table, which is 

shown in Figure 2. As you can see, the main window of the Access database consists of several elements 

that are constantly present when using different modes of working with the database. The names of the main 

elements of the main Access 2010 window are shown in Figure 2. 
            The quick access toolbar is often called the ribbon that contains bookmarks: home, creation, external 

data, working with databases. Bookmarks have their own functionality, so on each bookmark there are icons 

with the designation of the functions performed. 

 
Fig. 2. The main elements of the main window Access  

As an example, Figure 2 shows the Home tab with the icons displayed. it should be noted that 

additional tabs (groups) appear on the ribbon, for example, if you select-table in the navigation area, then an 

additional tab "working with a table" appears on the ribbon, including two bookmarks (figure 2). note if 

there is a down arrow on the icon , this means that you can open an additional menu. In turn, an arrow in 

the form of an icon may appear in the menu:  to open the dialog box. Figure 3 shows an example of how 

an additional menu for working with text was opened on the "Working with a table" tab, on the "formatting 

text" icon, and then using the arrow  in the additional menu, the "Table Format" dialog box was opened. 



Figure 3. Example of using additional arrows on pictograms 

You can create a new (empty) database in another way. To do this, open an existing database, Click 

on the shortcut , and then activate the string with the name . Further actions of the 

developer are to follow steps 2 and 3, which are presented above in this section. 
1.3. Database design 

     Before using the Microsoft Access application for database development, it is necessary to set the task, 

identify the potential user and his needs, collect the necessary information about the content and names of 

table fields, normalize tables, think through the interface of the finished product and the names of standard 

reports for distribution. In this tutorial, the main focus is on studying the capabilities of Access 2010 and 

techniques for organizing the creation of tables, searching for information on queries, displaying user 

interfaces, as well as rules for adding to the database and making changes to it. Therefore, the reader of the 

manual is invited to familiarize himself with the approach of creating a database "from scratch", although 

there is another approach to designing an Access database-creating using templates (this will be discussed at 

the end of the manual). it should be recalled that during the development of the database, new objects are 

created (tables, queries, forms, reports, macros), links to which are added to the navigation area. However, 

all objects will be saved in a single file with the extension .accdb, so working with data in Access starts with 

creating a database file (specify the name of the database file and its location). 
Let's assume that there is a 

certain company that needs to keep 

records of employees of the company, 

information about which will be used 

by several departments, for example, 

the human resources department, 

planning department, accounting, office, 

management. This means that the 

information about the employee of the 

company is diverse, and the analysis of 

information about the employee 

requires the use of additional materials. 

For example, when forming an order on 

payroll, you will need to take into 

account additional allowances, 

depending on the length of service in 

the company of the employee, his 

category. In addition, employees receive additional benefits in the form of surcharges, in accordance with 

the order of the management. Benefits are usually assigned based on existing regulatory documents that 

Figure: 4. Scheme of user interaction with the database 



must be present in the database. Thus, some conclusions can be drawn. first, for each department, you will 

need to have different output forms that are based on queries. Secondly, in addition to information about 

employees, the database must contain materials related to the company and regulatory documents. Third, all 

data should be grouped in such a way that there is a possibility of one-time conversion and correction. 
In general, let's imagine a diagram (Fig. 4)of the interaction of potential users with the 

"Company Employees" database, from which you can see what steps should be taken when 

developing this database using Access 2010. 
1.4. Data types and their representation 

A person perceives data in the form of images that are displayed in his mind. The computer perceives 

data in the form of binary codes, so to store and display data in the computer, a certain memory location is 

required, as well as instructions for converting binary codes. it is clear that storing a prime number will 

require significantly less space than storing a photo, this should always be remembered when creating a 

database, since the speed of data processing largely depends on the type of representation. in a computer, 

data is divided into several types, the data type is set by the user. therefore, when setting properties for a 

table field, specify the type of data that will be presented in the table column under the general heading 

(field name). in access 2010, there are 11 main data types, and some of them have data subtypes, the list of 

data types is given below. 

 Text. this data type is intended for processing any alphanumeric characters (including numbers), single 

or collected in a string. the maximum length of the string must not exceed 255 characters. Therefore, when 

using data of the text type, it is advisable to set its size in characters for each field (to save the total amount 

of memory). by default, all fields in a table in access 2010 are set to this data type.   

 The memo field. this text field is very long. it is usually used to store paragraphs of text, summaries, 

short descriptions, etc.when using this type, there is no need to worry about specifying the length of the 

record that will be stored in the machine's memory. for a field with the memo data type, only as much 

memory is allocated as is required for a particular record. 

 Numeric. The Access DBMS allows you to perform calculations on fields of this type. To specify a 

specific way to store data in numeric type fields, there are several subtypes: 
1. byte-takes 1 byte.

2. Integer-takes 2 bytes.

3. A long integer takes 4 bytes.

4. single floating point-takes 4 bytes.

5. Double is floating point occupies 8 bytes.

6. Valid-takes 12 bytes.

 Money. This field stores data presented according to accounting rules (currency designation, number 

division into digits), although all arithmetic and logical operations are performed with such data, as with the 

data type – numeric. In memory, the display of this type of record takes 8 bytes. 

 The date and time. This is a special data type that stores date or time values, or both. For a variety of 

date and time display, there are special formats in the form of templates, which allows you to perform 

calculations on this data. In the machine's memory, this type of data takes up 8 bytes. 

 Counter. The data type that is used to identify a record in the database. Usually, the counter is used as a 

key field in tables, so it is represented as an integer. 

 logical. These fields contain the values: Yes\No, True\False, On.In fact, in this field, 1 is interpreted as 

Yes and 0 as No. 
Hyperlink. Provides a link to a Web page or a file. When you select this data type, Access 

automatically launches an application in which you can display this file, such as a Web browser for 

displaying a Web page or a software module with the .exe extension.    

 Field of the OLE object (Object Linking and Embedding – linking and embedding the object). the field 

can contain drawings, spreadsheets, and videos in binary format. This type of data stores data up to 1 GB. 
 Investment. a data type that appeared in access 2007/2010 for storing large files (drawings, ms office 

applications, and other types) directly in the database in a compressed format of up to 2 gb 



.            The substitution wizard. This field property, rather than the actual data type, is used in Access 

2010 as a means to enter data more efficiently and correctly. When you select this data type, the lookup 

wizard starts, which creates a field in the format and type that will be borrowed from another table or list, 

usually this data type takes 4 bytes. 
Access 2010 provides options for setting table field formats directly when creating a table. When the 

table creation mode opens, you can immediately set the required format for the field. Figure 5 shows that 

when you click on the arrow in the row with the name of the table fields, a list will be opened with the types 

of formats that can be set (by default, the format of the table field is set as-Text). 

Figure 5. List with format names for the table field 

1.5. Creating and modifying tables (Introduction) 
In access 2010, you can create tables in three ways: build a table manually, create a table based on a 

template, and build a table in design mode. Next, we will look at specific examples of these options. Of 

course, first of all, you should understand how these options differ. When creating a table manually, the 

developer can independently enter the name of the fields, and then fill the table with data. Creating a table in 

the design mode consists in the fact that the developer first creates a list of fields, defines their formats, and 

then fills the table with data in the table mode. However, in design mode, you can manage all the fields and 

properties of the table. Using table templates, the developer gets a specific set of fields that can be 

supplemented with new fields, rename the names of fields, and if necessary, delete or rearrange them in the 

table. The important thing is that when you select a template, the field formats are already set. 
  1.6. Rules for creating a table manually in table mode 

 Этот режим удобен тем, что разработчик задает имена полей, а затем может вводить данные. 

Кроме того, в Access 2010 при создании таблицы вручную можно указать типы полей. Для начала мы 

создадим простую таблицу, чтобы в будущем использовать полученные навыки при разработке 

более сложных таблиц. Предположим, что отдел кадров предприятия разработал градацию 

поощрений работников в зависимости от стажа их работы на предприятии, т. е. независимо от 

занимаемой должности каждый работник будет получать дополнительное денежное вознаграждение. 

Такие методы поощрения работников широко распространены на фирмах и предприятиях, что 

позволяет им быть заинтересованными в работе на данном предприятии. Разработанная градация 

поощрений работников используется в бухгалтерском учете при расчете общей заработной платы. В 

таблице 1, озаглавленной "надбавка за выслугу лет", приведены сведения о надбавке к заработной 

плате работника в зависимости от стажа его работы на предприятии. 



Table 1. Surcharge for seniority 

Allowances for company employees, depending on the length 

of service 

Employee work experience Surcharge (rub.) 

Less than a year 0 

1 to 3 years old 750 

From 3 years old to 5 years old 1200 

Over 5 years 1800 

You need to create the presented table in a new empty database. The procedure for creating a table manually 

is as follows: 

1. Open the created database "Employee Information". To do this, you can run Access 2010 (Start All

programs Microsoft Office Microsoft Access 2010 Open). Another way to open an already created 

database is to select a file name from the disk directory, for example, a file with the 

name::  was created earlier as an empty database. 

2. Click on the "Create" tab, and then click on the icon - , after that, a blank table will appear. the 

blank includes: header - ; one line and two fields (Fields:Code, click to add), as shown in 

Figure 6. 

Figure 6. Preparation of a new table that will be created manually  
When you create a table manually in Access 2010, a counter field is automatically created, which is used as 

a key, so there is no need to worry about creating a key field in the future. As a rule, the name of the field is 

created next to the "Code" field to store unique data (not repeated). 

3. Click on the tab named "Click to add", then a menu will open with a list of formats for the field to

be created (Figure 7). 

Figure 7. List for selecting the format of the field to be created 

4. select the line with the symbol:  - text field. 

5. Replace the word "Field 1" with - "Work experience" (in accordance with the original table 1), you

can change the name of the field header at any time, for which it is enough to right-click on the field, 

and then select the line with the name: . 



6.  Repeat the field creation operation (step 3), only select the format for the new field , а 

name the field: "Surcharge ».

7. Enter the data in the table created in the Access 2010 database from Table 1, which is shown above. As

a result, you will get a filled table with data, as shown in the figure 8.

Figure 8. Manually created table with data on seniority allowances 

8. close the table with the symbol  (the symbol is located in the upper-right corner of the table). The 

system will ask you whether it is appropriate to save the table, if you answer "Yes", the "Save" dialog 

box will appear, as shown in Figure 9. Replace the word "Table1" with "Seniority allowances" – and 

click OK. 

Figure 9. Dialog box for setting the table name 

You can change the table name directly in the navigation pane. Just remember that the table should 

be closed at this point. when you click on the right mouse button, a context pop-up menu appears, from 

which you should select the line with the name: . 

Control questions 

1. What is a Database?

2. The purpose of a DBMS?

3. What is a Relational database?

4. What are data models?

5. List the basic concepts of Microsoft Access?

6. How are Microsoft Access tables created?

7. What distinguishes the data types of Access?

8. What is a request?

9. What is a report and how is it created?

10. What are modules?

11. What needs to be done to run the regime – creating the table manually?

12. How do I set the format of a field in a table, can I change it for an already created field?

13. How is data entered into the table?

7-Topic: Computer networks and work in them. Information security. 

1.1. Model of technology training 

Duration of the lesson-2 hours        Number of students: 30-60 

class form Informational lecture 

Plan of the lecture 

1-basic concepts of computer 

networks. 

2-local and global networks. 

Computer networks, as a result of the development of modern 

technology, have emerged as systems for expanding the capabilities of 

computers and transmitting information over long distances. A 

Computer Network is a collection of computers connected by means of 

communication channels and means of switching into a single system 



for exchanging messages and accessing users to software, technical, 

information and organizational resources of the network. 

The Internet provides the ability to communicate between millions of 

computers distributed around the world. In 1961, the Defense Advanced 

Research Agency (DARPA), on behalf of the US Department of 

Defense, began a project to create an experimental packet transmission 

network. In 1975, ARPANET evolved from an experimental network to 

a working network.  

Purpose of the lesson: Familiarizing students with the basic concepts of computer networks. 

Explain and show areas of application of local and global computer 

networks. 

Training method Demonstration: lecture and interview 

Type of training Collective 

Tools training Tutorials, textbooks, lecture text, projector, computer 

Training conditions Methodically equipped audience. 

Monitoring and evaluation 

1.2. Technological map of the lecture 

stages of work and 

allotted time 

Stages of conducting a lesson by a teacher Students 

Preparatory stage. 1. Prepare an educational component of the topic.

2. Preparing presentation slides for the theme.

3. Make a list of literature used for the development of

the subject. 

1. Introduction to

the topic 

(10 min) 

It will introduce you to the purpose and task of the topic. Listen 

2. The main stage

(55 min) 

1. Explains the topic and demonstrates the presentation.

2. Applies the posters.

Слушают  

Записывают 

3The final stage (10 

min) 

Makes a final conclusion. Listen 

4. Self-study tasks

(5 min) 

Declares tasks of independent work  Records 

Basic concepts of computer networks.  

let's name the tasks that are difficult or impossible to solve without organizing information communication 

between different computers: 

* transfer of information over long distances (hundreds, thousands of kilometers);

• sharing expensive hardware, software, or information resources with multiple computers — a powerful

processor, a high-capacity storage device, a high-performance laser printer, databases, software, etc.; 

• working together on a large project when executed should always have the latest (up-to-date) copies of

shared data to avoid confusion, etc. 

There are three main ways to organize intercomputer communication: 

* connecting two adjacent computers via their communication ports via a special cable;

* data transfer from one computer to another via modem via wired or satellite communication lines;

* combining computers into a computer network.



Often, when organizing communication between two 

computers, one computer is assigned the role of a resource 

provider (programs, data, etc.), and the other is assigned the role 

of a user of these resources. In this case, the first computer is 

called the server, and the second is called the client or 

workstation. You can only work on a client computer running 

special software. 

A server is a high-performance computer with a large amount of external 

memory that provides service to other computers by managing the distribution of 

expensive shared resources (programs, data, and peripheral equipment). 

Client (otherwise, workstation) — any computer that has access to the server 

services. 

for example, the server can be a powerful computer that hosts a central 

database, and the client can be a regular computer whose programs request data from 

the server as needed. In some cases, the computer can be both a client and a server. 

this means that it can share its resources and stored data with other computers and 

simultaneously use their resources and data. 

A client is also an application program that receives server services on behalf of the user. accordingly, 

the software that allows a computer to provide services to another computer is called a server — just like the 

computer itself. to overcome the incompatibility of the interfaces of individual computers, special standards 

are developed, called communication protocols. 

Acommunication protocol is a consistent set of specific rules for the exchange of information 

between different data transmission devices. There are protocols for transfer rates, data formats, error 

control, etc.. 

To work with the network, you must have special network software that provides data transmission in 

accordance with the specified protocol. Communication protocols require that the entire volume of 

transmitted data be divided into packets — individual blocks of a fixed size. Packages are numbered so that 

they can then be assembled in the correct sequence. Additional information about the following format is 

added to the data contained in the package: 

The 

address 

of the 

recipient 

The 

address 

of the 

sender 

Length Data 

The 

checksum 

field 

The packet data checksum contains the information required for error control. The first time it is 

calculated by the transmitting computer. After the packet is transmitted, the checksum is recalculated by the 

receiving computer. If the values do not match, it means that the packet data was corrupted during 

transmission. Such a packet is discarded, and a request to retransmit the packet is automatically sent. 

When establishing a connection, the devices exchange signals to coordinate communication channels 

and protocols. This process is called handshake (handshake). 

Computer network (English Computer network, from net — network and work — work) — a set of 

computers connected by means of communication channels and means of switching into a single system for 

messaging and user access to software, technical, information and organizational resources of the network. 

A computer network is represented as a set of nodes (computers and network equipment) and 

connecting branches (communication channels). A network branch is a path that connects two adjacent 

nodes. there are terminal nodes - located at the end of only one branch, intermediate nodes-located at the 

ends of more than one branch, and adjacent nodes-such nodes are connected by at least one path that does 

not contain any other nodes. Computers can be networked in different ways 
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The logical and physical way to connect computers, cables, and other components that make up a 

network as a whole is called its topology. Topology characterizes the properties of networks that do not 

depend on their size. This does not take into account the performance and operating principle of these 

objects, their types, and channel lengths, although these factors are very important when designing. 

REFERENCE. Topology as a mathematical concept: 

Topology (from the Greek. topos-place and ... logy), a branch of mathematics that studies the 

topological properties of shapes, i.e. properties that do not change under any deformations produced without 

breaks and gluing. examples of topological properties of figures are the dimension, the number of curves 

that limit a given area, and so on. for example, a circle, ellipse, or square contour have the same topological 

properties, since these lines can be deformed into one another in the way described above; at the same time, 

the ring and the circle have different topological properties: the circle is bounded by one contour, and the 

ring by two. 

The most common types of network topologies: 

Linear network. contains only two end nodes, any number of intermediate nodes, and has only one 

path between any two nodes. 

Ring network. A network in which two and only two branches are attached to each node. 

Tree network. A network that contains more than two end nodes and at least two intermediate nodes, 

and in which there is only one path between the two nodes. 

Star-shaped network. A network that has only one intermediate node. 

Mesh network. a network that contains at least two nodes that have two or more paths between them. 

A fully connected network. A network that has a branch between any two nodes. The most important 

characteristic of a computer network is its architecture. 

Network architecture is the implemented structure of a data transmission network that defines its topology, 

the composition of devices and the rules for their interaction in the network. Within the framework of the 

network architecture, the issues of information encoding, addressing and transmission, message flow 

control, error control and analysis of the network operation in emergency situations and in case of 

deterioration of characteristics are considered. 



The most common architecture: 

Ethernet (English ether — ether) — a broadcast network. This means that all stations in the 

network can receive all messages. The topology is linear or star-shaped. Data transfer rate of 10 or 

100 Mbit / s.  

 FDDI — Fiber Distributed Data Interface) - network architecture for high-speed data transmission 

over fiber-optic lines. The transfer rate is 100 Mbit / s. Topology — double ring or mixed (including 

star-shaped or tree-shaped subnets). The maximum number of stations in the network is 1000.  

ATM (Asynchronous Transfer Mode) - a promising, yet very expensive architecture that provides the 

transmission of digital data, video information and voice over the same lines. Transfer speed up to 

2.5 Gbit / s. Optical communication lines. 

How do network devices connect to each other? 

Special equipment is used for this purpose:  

Network cables (coaxial, consisting of two concentric conductors 

isolated from each other, of which the outer one has the form of a tube; 

fiber-optic; twisted-pair cables formed by two intertwined wires, etc..).  

Connectors (connectors) for connecting cables to the computer; 

connectors for connecting cable segments.   

Network interface adapters for receiving and transmitting data. Access 

to the data transmission medium is controlled according to a specific 

Protocol. They are placed in the system blocks of computers connected 

to the network.  

Connect a network cable to the adapter connectors. 

 Transceivers improve the quality of data transmission over the cable, are responsible for receiving 

signals from the network and detecting conflicts.   

 Hubs (hubs) and switching hubs (switches) expand the topological, functional and speed capabilities 

of computer networks. A hub with a set of different types of ports allows you to combine network 

segments with different cable systems. You can connect a single network node or another hub or 

cable segment to the hub port.   

* Repeaters (repeaters) amplify the signals transmitted over the cable when it is long.

According to the degree of geographical distribution, networks are divided into local, urban, corporate, 

global, etc. 

A local area network (LAN) is a network that connects a number of computers in an area bounded by 

the boundaries of a single room, building, or enterprise. 

Network interface 

adapter 



Small office LAN 

A global network (GWS or WAN — World Area NetWork) is a network that connects computers that 

are geographically distant over long distances from each other. It differs from the local network by more 

extensive communications (satellite, cable, etc.). the global network combines local networks. 

Global network 

City network (MAN-Metropolitan Area NetWork) — a network that serves the information needs 

of a large city. 

How local networks connect to each other? 

To connect local networks, the following devices are used, which differ in their purpose and capabilities: 

* Bridge-connects two local networks. Transfers data between networks in batch form, without making any

changes to them. The figure below shows three local networks connected by two bridges. 

 Connecting local networks via bridges 

Here, bridges has created an extended network that provides its users with access to previously 

inaccessible resources. In addition, bridges can filter packets, protecting the entire network from local data 

flows and passing out only those data that are intended for other network segments 



  A router connects networks with a common Protocol more efficiently than a bridge. It allows, for 

example, to split large messages into smaller chunks, thereby ensuring the interaction of local networks with 

different packet sizes. 

The router can forward packets to a specific address (bridges only filter out unnecessary packets), 

choose the best path for the packet to pass through, and much more. The more complex and larger the 

network, the greater the benefit of using routers 

. 

  A bridge router — Brouter) is a hybrid of a bridge and a router that first tries to perform routing 

wherever possible, and then, if it fails, switches to bridge mode. 

  Gateway, unlike a bridge, is used in cases where the connected networks have different network 

protocols. A message received by the gateway from one network is converted to another message that meets 

the requirements of the next network. Thus, gateways do not just connect networks, but allow them to work 

as a single network. With the help of gateways, local networks are also connected to mainframes — 

universal powerful computers. 

How wireless networks work? 

Wireless networks are used where cabling is difficult, impractical, or simply impossible. For example, 

in historical buildings, industrial premises with metal or reinforced concrete floors, in offices obtained for 

short-term rent, in warehouses, exhibitions, conferences, etc.. 

The Topology Of The "All-With-All " 

In these cases, the network is implemented using network radio adapters equipped with 

omnidirectional antennas and using radio waves as a medium for transmitting information. Such a network 

is implemented by the "All-With-All" topology and is operable at a range of 50-200 m. 



For communication between the wireless and cable parts of the network, a special device called an 

entry point (or radio bridge) is used. You can also use a regular computer that has two network adapters 

installed — wireless and cable. 

Point-to-point topology " 

Another important area of application of wireless networks is the organization of communication 

between remote segments of local networks in the absence of data transmission infrastructure (public access 

cable networks, high-quality telephone lines, etc.), which is typical for our country. In this case, radio 

bridges with a directional antenna are used to establish wireless bridges between two remote segments. 

The topology of the "star" 

If you need to combine several segments into a network, then a "star" type topology is used. At the 

same time, an omnidirectional antenna is installed in the Central node, and directional antennas are installed 

in remote nodes. Networks of star-shaped topology can form networks of various configurations. 

A network backbone with wireless access allows you to avoid using slow modems. 

General information about the Internet. 

It has become customary that in the field of information technology, the innovation process is taking 

place at an unprecedented high rate. Against this background, the pace at which the transnational Internet 

network has been formed over the past three years is noticeably highlighted. Specialized publications have 

already called it a "Network of networks", and the popular business world magazine "Business week" has 

defined the near future as the "Internet era". The Internet opens up a new way of human communication, 

which can be called horizontal. Before its appearance, communication and dissemination of information 

was. Basically, vertical: the author writes a book - readers read it. Radio and television transmit something - 

viewers and listeners listen to it and watch it. The newspaper publishes news - subscribers read them. There 

was almost no feedback, although the need for it was exceptionally high. The Internet provides information 

for a virtually unlimited number of consumers, and they can easily join the discussion. The Internet also 

provides unique opportunities for vertical information communication: between the authorities and citizens, 

for the feedback of the latter with the former. There is no organization behind the widespread introduction of 

the Internet into our lives, the world wide Web as a phenomenon develops independently, the whole of 



humanity is the engine of the Internet. The main idea of the Internet is the free dissemination of information 

and the establishment of connections between people. The Internet is one of the most significant democratic 

achievements of the technological process. With its appearance, information becomes the potential property 

of most people on the planet. All global communications related to the Telegraph, telephone, radio, 

television and computer technology are now integrated into a single whole - the Internet.  

The history of the Internet begins in 1961. Immeno this year, the defense Advanced Research 

Agency (DARPA), on behalf of the US Department of defense, began a project to create an experimental 

packet transmission network. This network, called the ARPANET, was originally intended to study methods 

for providing reliable communication between different types of computers. Many methods of transmitting 

data through modems were developed in ARPANET. At the same time, data transfer protocols in the 

network - TCP/IP-were also developed. TCP / IP is a set of communication protocols that define how 

different types of computers can communicate with each other. 

The experiment with ARPANET was so successful that many organizations wanted to log in to it, 

with the goal of using it for daily data transmission. And in 1975, ARPANET evolved from an experimental 

network to a working network. The defense Communication Agency (DCA), now called the defense 

Information Systems Agency (DISA), assumed responsibility for network administration).  

In 1983, the first standard for TCP/IP protocols was released, which was included in the Military 

Standards (MIL STD), i.e. in military standards, and everyone who worked on the network was required to 

switch to these new protocols. After some time, TCP / IP was adapted into a regular, that is, a public 

standard, and the term Internet came into General use. In 1983, MILNET was separated from ARPANET, 

which became part of the defense Data Network (DDN) of the US Department of defense. The term Internet 

came to be used to refer to a single network: MILNET plus ARPANET. A host on the Internet is a computer 

running a multitasking operating system (Unix, Windows) that supports TCP / IP protocols and provides 

users with any network services. 

The Internet is a global computer network that covers the whole world and contains a huge amount of 

information on any topic, available on a commercial basis for everyone. 

The Internet offers virtually unlimited information resources, useful information, education, 

entertainment, the ability to communicate with competent people, remote access services, file transfer, email 

and much more. The Internet provides a fundamentally new way for people to communicate, which has no 

analogues in the world. 

The Internet is not like other common means of communication. Here, people of any age, color, 

religion, and nationality freely exchange their ideas, messages, data, and opinions. 

Everyone can access it. The great advantage of the Internet is that it is the most open network in the 

world. Anyone who has access to the Internet can use the resources of thousands of computers. This 

situation is unusual – most networks restrict the freedom of users, and special permissions and passwords 

are required to access a particular service. Despite the fact that some services are still paid ( and this is 

becoming more and more every day), the vast majority of Internet services are still free. If you do not have 

access to the Internet through your company, then you will have to pay for access using the services of an 

Internet provider. 

Thanks to the network, a huge amount of information has become available (for free or for a moderate 

fee). So, a user in any country can contact people who share their interests, or get valuable information in 

electronic libraries, even if they are on the other side of the world. The necessary information will be in his 

computer in a matter of seconds, going through a long chain of intermediate computers, through cables and 

radio, through mountains and seas, along the ocean floor and via satellite. 

The Internet is funded by governments, scientific and educational institutions, commercial entities and 

millions of individuals in all parts of the world, but no one specifically owns it. The network is managed by 

the "Internet architecture Council", which is formed from invited volunteers. 

The network was created in the mid-80s of the twentieth century, and now it is used by about 3 billion 

people. The Internet is changing all the time, because it has many qualified users who write programs for 

themselves and then distribute them to those who want to. 

In addition to receiving purely informational services via the Internet, you can make purchases and 

commercial transactions, pay bills, order tickets for various types of transport, book places in hotels, etc. 

The Internet is an Association of more than 40 thousand different local networks, for which it received 

the name Network of networks. Each local network is called a node or site, and the legal entity that provides 



the site is called a provider. The site consists of several server computers, each of which is designed to store 

information of a certain type and in a certain format. Each site and server on the site have unique names by 

which they are identified on the Internet. 

To connect to the Internet, the user must enter into a service contract with one of the providers in their 

region. After that, any work on the Internet begins with a connection to the provider's website, 

communication with the provider can be organized either via a dial-up telephone channel using a modem, or 

using a permanently active dedicated channel. In the first case, the connection to the provider is made using 

a modem and remote access tools, in the second case, simply by calling the appropriate program for working 

on the Internet. In both cases, after connecting to the provider, the user gets access to all sites and computers 

on the Internet. The opportunities that open up to the user depend on the terms of the contract concluded 

with the provider. Potentially, the Internet provides a General-purpose information service (figure 1). 

Figure 1. Internet Services 

Access to information resources. Information resources on the Internet differ in the way of organizing 

information, methods of working with it. Each type of information is stored on servers of the corresponding 

type, called by the type of information stored. Each information system has its own means of searching for 

the necessary information in the entire Internet by keywords. The following information systems are 

available on the Internet: 

World Wide Web (WWW) - the world information web. This is the most popular and dynamically 

developing system at the moment. The information in it consists of pages (documents). Pages can contain 

graphics, accompanied by animation and sound, played directly in the process of receiving information on 

the user's screen. Through WWW, you can watch videos, listen to music, play computer games, and access a 

variety of information sources. The information in this system is organized in the form of hypertext. This 

means that there are special elements in the document-text or pictures, called hypertext links (or just links); 

clicking on these links displays another document. In this case, the new document can be stored on a site 

located on the other side of the globe. 

When people today talk about traveling on the Internet, they most often mean viewing these same, 

located around the world, multimedia databases with hyperlinks. Actually, recently people are already 

talking not so much about the Internet, but about the Web. Is it the same thing? From a technical point of 

view, no, but in the minds of many people there is an equal sign between these concepts. 

The Web, unlike the early Internet service, combines text, pictures, sound, and even animation into a 

single whole. Moving through this information is done with simple mouse clicks. New Web sites (sets of 

Web pages) appear like mushrooms after the rain, and every minute there are more and more of them. In 

1993, there were 130 Web sites on the Internet. Now there are many millions of them, and statistics indicate 

that their number doubles every few months. 

Software for traveling on the Web is called a browser. The most popular browsers these days are 

Netscape Navigator and Internet Explorer. 

FTP-system (File Transfer Program). This system is used for sending files. Files become available for 

work (reading, execution) only after copying to the user's own computer. Although file transfer can also be 

done using WWW, FTP systems continue to be very popular due to their speed and ease of use. 

E-mail (E-mail). This is, without a doubt, the most widespread communication service in the world. 

You can exchange e-mail with many people in different parts of the world. People use e-mail instead of 



traditional letters, phone or Fax to exchange rumors, recipes, gossip, love notes… You can easily continue 

this list yourself. Some people use email for their work. Mailing lists allow you to engage in a dialogue with 

people with similar interests and get to know them better. Mail servers, or mail robots (programs that 

automatically respond to email messages), provide you with all the available information. 

B e-mail, each subscriber is assigned an e-mail address that represents some analog of a postal address. 

With the help of E-mail, the user can send and receive text messages and binary files of any kind. The 

information sent to the subscriber is stored in his "mailbox" on a special mail server of the site to which the 

subscriber is connected. At any time convenient for the e-mail subscriber, he can connect to his website 

(mailbox) to view and process the correspondence sent to him (save it on his PC, print it out, send a response 

to the author, delete it from the server). 

News (teleconferencing system-UseNet Newsgroups). This service contains a collection of documents 

(articles) grouped by specific topics. Currently, there are more than 15 thousand such groups on a variety of 

topics. The user, having specified the topics (groups) that interest him, can view the corresponding 

documents and create his own. New documents can be addressed either to all members of the group, or to 

the authors of specific articles. Since teleconferences are now used to host various thematic collections (for 

example, of an economic nature), participation in some conferences may require additional payment.IRC и 

ICQ. 

These systems provide the ability to exchange information in real time, i.e. the text typed by the user is 

immediately reproduced on the screen of one or several subscribers at once. On Windows, these functions 

are performed by the MS NetMeeting application, which allows you to create shared drawings and add text 

together with other users on remote workstations. If both subscribers have sound cards and microphones, 

you can use MS NetMeeting to organize voice exchange between them in real time. Special means of 

broadcasting make it possible to use the Internet for video conferences. For the organization of interactive 

communication via WWW, the ICQ system is now widely used. It introduces its own addressing of 

subscribers, organizes their convenient call and an easy way of interactive communication. 

 Search, management and control tools on the Internet

 WW WWW search systems designed to search for information organized by one of the

above methods (WWW, FTP). The search can be carried out by fragments of text, both 

contained in file names and being keywords that reflect the semantic content of the document; 

 Tel Telnet-remote control mode for any computer on the network, used to run the necessary

program on the server or on any computer on the Internet. The mode is similar to remote

control tools;

 Ping utility designed to check the quality of communication with the server;

 Whois Whois and Finger programs that allow you to find the coordinates of network users or

identify users currently working on a particular host. There are also numerous systems for

"finding people", or rather their email addresses, on the Internet.

The Advantages Of The Internet. 

Much has changed very significantly over the past year. During this time, the Internet has become 

even more important. Current news now appears on the Internet earlier than in other media, and users 

experience much less inconvenience during "walks" on the Internet. 

That's what the Internet is usually used for. 

Search for people. 

Search for companies, products and various services. 

Researches. 

Education. 

Journeys. 

Marketing and buying and selling. 

Acquaintances. 

Health care. 

Investment. 

Organization of events. 

Non-commercial activities. 



How do Internet search engines work? 

The main protocols used in the Internet (hereinafter also the Network) are not provided with sufficient 

built-in search functions, not to mention the millions of servers located in it. The HTTP Protocol used on the 

Internet is only good for navigation, which is considered only as a means of viewing pages, but not for 

searching them. The same applies to the FTP Protocol, which is even more primitive than HTTP. Due to the 

rapid growth of information available on the Web, navigation browsing methods are rapidly reaching the 

limit of their functionality, not to mention the limit of their effectiveness. Without specifying specific 

figures, we can say that it is no longer possible to get the necessary information immediately, since there are 

now billions of documents on the Web and all of them are at the disposal of Internet users, and today their 

number is increasing according to an exponential relationship. The number of changes that this information 

is subjected to is huge and, most importantly, they occurred in a very short period of time. The main 

problem is that there has never been a single complete functional system for updating and entering such a 

volume of information, which is simultaneously available to all Internet users around the world. In order to 

structure the information accumulated on the Internet and provide its users with convenient means of 

searching for the data they need, search engines were created.  

Search engines 

Search engines usually consist of three components: 

* an agent (spider or crawler) that moves around the Network and collects information;

* a database that contains all the information collected by spiders;

* a search engine that people use as an interface to interact with the database.

How search engines work 

Search and structuring tools, sometimes called search engines, are used to help people find the 

information they need. Search tools such as agents, spiders, crawlers, and robots are used to collect 

information about documents on the Internet. These are special programs that search for pages on the Web, 

extract hypertext links on these pages, and automatically index the information they find to build a database. 

Each search engine has its own set of rules that define how to collect documents. Some follow every link on 

every page found and then, in turn, explore every link on each of the new pages, and so on. Some ignore 

links that lead to image and sound files, animation files; others ignore links to resources such as WAIS 

databases; others are instructed to view, first of all, the most popular pages. 

Agents are the most "intelligent" of search engines. They can do more than just search: they can even 

perform transactions on Your behalf. Even now, they can search for sites with specific topics and return lists 

of sites sorted by their traffic. Agents can process document content, find and index other types of resources, 

not just pages. They can also be programmed to extract information from existing databases. Regardless of 

the information that agents index, they pass it back to the search engine database. 

The General search for information on the Web is carried out by programs known as spiders. Spiders 

report the contents of the found document, index it, and extract the final information. They also look at titles, 

some links, and send indexed information to the search engine database.  

Crawlers look at the headers and return only the first link. 

Robots can be programmed to click on various links of different nesting depths, perform indexing, and 

even check links in a document. Because of their nature, they can get stuck in loops, so they need significant 

Network resources when following links. However, there are methods designed to prevent robots from 

searching for sites whose owners do not want them to be indexed. 

Agents extract and index various types of information. Some, for example, index every single word in 

a document that occurs, while others index only the most important 100 words in each, index the size of the 

document and the number of words in it, title, titles and subheadings, and so on. The type of index 

constructed determines which search can be made by the search engine and how the information received 

will be interpreted. 

Agents can also navigate the Internet and find information, then put it in the database of the search 

engine. Search engine administrators can determine which sites or types of sites agents should visit and 

index. Indexed information is sent to the search engine database in the same way as described above. 

People can put information directly in the index by filling out a special form for the section in which 

they would like to put their information. This data is passed to the database. 



When someone wants to find information available on the Internet, they visit a search engine page and 

fill out a form detailing the information they need. Keywords, dates, and other criteria can be used here. The 

criteria in the search form must match the criteria used by agents when indexing the information they found 

while navigating the Network.  

The database searches for the subject of the request based on the information specified in the 

completed form and outputs the relevant documents prepared by the database. To determine the order 

in which the list of documents will be displayed, the database applies a ranking algorithm. Ideally, the 

documents most relevant to the user's query will be placed first in the list. Different search engines use 

different ranking algorithms, however, the basic principles for determining relevance are as follows: 

1. The number of query words in the text content of the document (i.e., in the html code).

2. Tags in which these words are located.

3. Location of the search words in the document.

4. the Specific weight of words relative to which relevance is determined in the total number of words

in the document. 

These principles are applied by all search engines. And the ones presented below are used by some, 

but quite well-known (like AltaVista, HotBot). 

1. Time - how long the page is in the search server database. At first, it seems that this is a rather

meaningless principle. But, if you think about it, how many sites exist on the Internet that live for a 

maximum of a month! If the site exists for quite a long time, it means that the owner is very experienced in 

this topic and the user is more suitable for a site that has been broadcasting to the world about the rules of 

behavior at the table for a couple of years than the one that appeared a week ago with the same topic. 

2. Citation index - how many of the links on this page leads to other pages is registered in the

database of a search engine. 

The database outputs a similarly ranked list of HTML documents and returns it to the person who 

made the request. Different search engines also choose different ways to display the resulting list - some 

show only links; others display links with the first few sentences contained in the document or the document 

title along with the link. 

When you click on a link to one of the documents that you are interested in, this document is requested from 

the server on which it is located. 

Classification of medical resources and Internet services 

Conditionally medical services on the Internet can be divided into several main areas: 

* Medical consultations. The bottom line is that a certain number of doctors of different

specializations are registered on the pages of the Internet resource. Registration means that the site 

organizers check the documents on the professional suitability of a particular specialist and only then enter it 

in the appropriate list. The site visitor can view the list of specialists, get acquainted with the description of 

their professional activities (experience, degree, practice in various medical institutions, etc.) And, 

depending on the trust of a particular doctor, ask him questions by e-mail. 

* Electronic stores of medical profile. This service is practically no different from any other

electronic store, except for the specifics of the product. Electronic pharmacies are also widespread. Often on 

such a site, the buyer has the opportunity to find the nearest pharmacy from his home, get information about 

medicines or order home delivery by courier. 

* Call a doctor at home. Usually, the client leaves information about the disease on the corresponding

server or indicates which specialist he needs. 

* Reference resources. This kind of resources help visitors to get information about various medical

and preventive institutions (polyclinics, hospitals, etc.), information about various types of medical and 

social services (care, rehabilitation, prosthetics, etc.), data on relevant companies, etc.. 

Professional resources. Such resources cover issues of medical education, distance medical 

education programs, contain databases of scientific papers and dissertations, literary reviews for researchers, 

medical reference books, etc. 

* Popular scientific online medical journals. It contains articles, tips, ratings of medical centers,

individual areas; provides advertising of medical services; promotes a healthy lifestyle; there are interactive 

discussions. 

* Socially oriented resources. This class includes resources on social and preventive advertising on

the Internet, for example, on the prevention of HIV infection, etc. This group also includes Internet schools 



(clubs, clubs, etc.) for maintaining health, addressed primarily to people with chronic diseases: bronchial 

asthma, diabetes, musculoskeletal disorders, etc.). 

This list can be continued (for example, to allocate a separate class of business resources on 

medicine), but we will stop here and draw your attention to the fact that many sites in the pursuit of a mass 

visitor are trying to make a site on the principle of "all-in-one". Usually, such sites focus on the most 

relevant issues for a wide range of people interested in their health, and at the same time, in an effort to 

embrace the vast, they provide information in one or another volume for more highly specialized groups of 

consumers. 

The Internet contains information on all branches of knowledge, including medicine, and there is 

medical information intended both for specialists of various levels, and for patients and people interested in 

health problems. Its search can be carried out very effectively with the help of the universal tools described 

above. However, there are special medical systems. For example: Medscape (www.medscape.com), 

BioMedNet (www.biomednet.comhttp://www.bmn.com), Medbot (http://medworld.stanford.edu / medbot/), 

a medical Club (http://www.medclub.ru). 

Special databases can be very useful. They can be reference, bibliographic, abstract and factual. 

Reference databases are designed to search for reference information about a particular object. Bibliographic 

- contains a bibliographic description of scientific publications on issues of interest. In abstract databases, 

bibliographic descriptions are supplemented with abstracts that briefly reflect the content of publications. 

Factographic-contains General information about the characteristics and properties of the objects under 

study. 

There are several hundred databases on medical topics. The most famous is the medical bibliographic 

search system Medline.ru (www.medline.ru), containing more than 7 million links from more than 3,500 

medical journals. 

Medline is an abbreviation MEDlars MEDLARS onLINE (MEDical Literature Analysis and 

Retrieval System). The Creator of the database is the US national library of medicine. It is the largest 

database of published medical information in the world, covering about 75 percent of all global publications. 

MEDLARS contains all the references presented in the three main medical bibliographic reference books: 

Index Medicus, Index to Dental Literature, International Nursing Index. International and cooperating 

organizations take part in the creation of the database. 

The main positive aspects of using the system include: 

- Ability to quickly select bibliographic data on articles on a given topic with coverage above 75%, 

which is not possible manually; 

- Ability to carry out searches for other terms in the shortest possible time; 

- Quick orientation in the problem based on abstracts; 

- Ability to contact the authors of the publication 

. 

The disadvantages of Medline include the absence and formal presence of an abstract in old 

publications. Medline is a bibliographic database, so the lack of full texts of articles is not a disadvantage of 

the system, especially since almost all modern publications already have links to external full-text sources. If 

you use the Internet and search for medical information, you are constantly faced with the need to use 

Medline. This is a source of up-to-date and reliable information. 

The easiest way to access Medline is from the address http://www.pubmed.com (it should be noted 

that addresses also work pubmed.org and pubmed.net). Of the most frequently mentioned in the literature, 

there is an address http://www.ncbi.nlm.nih.gov/pubmed/ or http://www.ncbi.nih.gov/entrez/query.fcgi 

If you have a slow Internet connection and do not plan to use any other PubMed services other than 

search, then follow the Text Version link from the main page of the system or type directly in the browser 

http://www.ncbi.nlm.nih.gov/entrez/queryd.fcgi in this case, the simple interface of the system will load as 

quickly as possible and save You time. Modern browsers (for example, IE version 4.0 and higher) 

Supplement incomplete addresses typed in the query string with different elements such as www, com, org. 

So you can just type pubmed in the browser's address bar ? and after a while You are at the goal. 

Medline device (MESH system). Search for information in Medline is simple, but for more effective 

work, you need to know some of the features of Its organization and the principles of the system's 

functioning. 



Information from such a large system should, first of all, be easily extracted. This is achieved by 

indexing, when any record can be accessed based on the information contained in it. Each record is divided 

into categories called fields, which contain different kinds of data. When you search for records that meet 

certain criteria, you need to search for information in the appropriate database field. For Medline, examples 

of fields can be the name of the journal, author of the article, title, page number, etc. 

All journal articles in Index Medicus and, accordingly, in Medline are indexed by certain keywords 

or terms that are included in a special dictionary called ?Medical Subject Headings? (MESH). The use of 

this approach ensures uniformity and continuity in the hierarchical structuring of biomedical literature. The 

terms MESH and the tree structure of their relationships are reviewed annually. You can learn more about 

MESH on a special page http://www.nlm.nih.gov/mesh/meshhome.html 

Another key field ? is this the unique identification number of the US national library of medicine ? 

NLM ID. The database of journals included in Medline can be viewed at 

http://www.ncbi.nlm.nih.gov/entrez/journals/loftext_prov.html From this page, you can select the desired 

journal, year and then view the abstracts in it and click on the link to the full text (if available). However, 

keep in mind that many journals require payment to access articles. 

You can get the log database as a file from the page or get it as a file from the page 

http://www.ncbi.nlm.nih.gov/entrez/citmatch_help.html a Short standard description of the journal in the 

database includes the journal name, NLM ID, abbreviation adopted by the international organization for 

standardization (ISO), ISSN. At the same time, the system supports such a way of searching for information 

as searching on a regular computer ?natural? language; Natural Language Searching (NLS). By default, the 

system automatically performs so-called term mapping.  

It consists in the fact that the terms entered by the user are compared with standard terms from four 

Medline reference books: the MESH index, the database of journal names, the index of phrases and 

authors.For example, when a phrase is entered in the query field ?Heart attack? the system maps the phrase 

and if the search query matches the term from the mentioned dictionaries, then fairly accurate results will be 

returned. 

Otherwise, documents will be issued that contain any word in this phrase and it is possible to return a 

large number of records that are not related to the requested phrase. In this case, it is necessary to enclose the 

phrase in double quotes and repeat the search in this form. If such a phrase exists in the database, then very 

accurate results will be returned. It makes sense to always request a phrase in two ways: both in quotation 

marks and without. 

In recent years, there are more and more full-text medical databases containing the full texts of the 

original publications. 

Do not forget about the possibility of obtaining valuable information from the websites of various 

medical and medical-educational institutions. 

However, the benefits of online resources depend on how well we know them. Therefore, to facilitate 

perception, it is better to start with their classification. So, medical resources (sites or individual pages) on 

the Internet can be divided by the type of visitors and the purpose of the visit. And since one site can provide 

visitors with information for different purposes (such as portals), we will not classify the entire sites, but 

separate thematic groups of information (thematic resources). 

E-mail (e-mail) 

Combining computers into a network made it possible to organize document flow in a new way both 

in small firms and in large organizations. There is no need to print on paper documents that a team of users 

is working on. With the help of appropriate software, a team of users can jointly create documents, 

presentations and databases and send them by e-mail to other project participants who may work in the same 

building or in another city, for addition and editing. One-by-one mailing allows you to specify the order of 

passing a message between project participants after its completion and editing. This method of collective 

work on the document saves a significant part of the working time, since you do not need to spend time on 

personal meetings for joint work. It is impossible to imagine a modern enterprise without data sharing and 

advanced means of guaranteed information protection. 

Organization of work and protocols. E-mail is one of the most common types of service on the 

Internet, which not only provides fast transmission of messages and files to a specific recipient or a list of 

recipients at once, but also makes it possible to access any other Internet resources. 

There are two groups of protocols that e-mail uses: 



* SMTP and POP (or POP3) protocols. Simple Mail Transfer Protocol (SMTP) supports the transfer of

messages between Internet destinations. It allows you to group messages to the address of one recipient, 

multiply copies of E-mail messages for transmission to different addresses. The POP (Post Office Protocol) 

Protocol provides the end user with access to electronic messages that have come to him. When requesting a 

user to receive mail, ROR clients require you to enter a password, which increases the confidentiality of 

correspondence; 

• the IMAP Protocol. This Protocol is becoming increasingly common. It allows the user to work with

emails directly on the provider's server and save time on the Internet. 

Mailers are used to send and receive messages by e-mail. As mentioned earlier, as part of IE, the 

Outlook program is designed to work with email and News. The same functions can be performed by the 

Outlook program included in MS Office. 

Email programs allow you to: 

* compose and transmit messages, both in the form of text messages and in HTML format,

which allows a variety of font and color design, as well as add directly to the message text in 

the form of graphics, animation, sound; 

* add files of any kind to messages (create attachments). Attachments are displayed as icons

placed in special areas of the email. The icons contain the names of the attached file and its 

size. When reading the received message, double-clicking on such an icon calls the program 

that created this file (if there is one on the recipient's computer), and loads the attached file into 

it (if the program is attached, it will start); 

* decrypt messages received in various Cyrillic encodings;

* manage the priority of sending messages - urgent, regular, at a cheap rate;

• in order to reduce the communication time when viewing received mail, first issue only the

headers (summary) of the message and forward in full only specially requested messages; 

* automatically check spelling and grammar of messages before sending;

• it is enough to simply remember the necessary e-mail addresses of the authors of messages in

the address book and then use these addresses when sending messages. 

Preparing and sending messages. When preparing and sending a message, the following fields 

are filled in on the mail client screen: 

• To field. In this field, enter the e-mail address of the main correspondent;

* Copy field. This field is filled with the addresses of correspondents who receive a copy of the

message. It is not necessary to fill in the field, but if the addresses are specified in it, the main 

correspondent is notified of the presence of a copy and their addressees; 

* the Hidden copy field. The field can be omitted and only appear on a special command. The

purpose of the field is similar to the previous one, but even if the addresses are present in it, the 

main correspondent is not notified of the presence of copies sent to these addresses. 

___________________________________________________________________ 

Note. Addresses in the three named fields can be entered from the keyboard or selected from the 

address book; 

___________________________________________________________________ 

the Subject field. A summary of the message is entered in this field. The text is displayed as a 

message header when the recipient views the received mail; 

field (window) Messages. The message text is typed directly in this field. There is a text editor for 

typing messages in mail programs. 

You can attach a file by using the menu command or the tool button; this opens the usual Windows 

window with a directory tree for selecting the file to attach. The icon with the name of the attached file is 

placed directly at the bottom of the message window or the names of the attached files are placed in a 

special field. 

The prepared message is sent by the command Deliver mail or by using the tool button; in this case, it 

goes to a special mail folder Outgoing. Sending a message directly to the network depends on the specified 

degree of urgency. An urgent message is sent immediately if communication with the provider has already 

been established. In some programs, sent messages end up in the Sent folder, where they can be viewed or 

deleted by mail readers. If the delivery of the message is not possible for any reason (for example, due to an 



error in the address), the sender is automatically notified of this. The notification is received in the form of 

an email in the Inbox, and it is viewed using mail readers. 

Reading mail. The mail client switches to the message View mode by following the appropriate 

command. In this mode, the screen of the mail program contains • 

* a field with a list of the main mail folders Incoming, Outgoing, Sent, and Deleted. The user can

create their own folders and group messages in them by topic. New messages are always placed in the 

Inbox, which is automatically set when you switch to read mail mode; 

* a window divided vertically or horizontally. In one part of the window - the header window-there is a

list of messages contained in the selected folder. For each message, the author, title (subject), date of 

sending are specified, and in some programs, a note is given about whether the message was read or not, as 

well as the size of the message in bytes. It is possible to exclude read messages from this list. In the lower 

part of the window - the viewport - the actual content of the message is displayed. 

The contents of both Windows are updated by the Deliver mail command. At the user's request, the list 

of received messages can be sorted in alphabetical order of authors ' surnames or topics, by date, by 

"read/not". 

The received messages, depending on the program settings, can be immediately copied to the user's 

computer or saved on the server. 

To view the message, double-click on its title. If the message contains an attached file, double-click on 

its icon to view it or run it in IE. To save an attachment, select Save attachments from the File menu. 

Mail programs contain simple means of responding to the author of the selected message: a special 

menu command or a tool button, conventionally called Reply to sender. This command automatically opens 

the screen mode of the email where the to field will be brought against the author of the message, and the 

message field will be the text of the message is sent response. Before sending a message, you should add 

your own text and, possibly, addresses for sending a copy. Similar means are provided for forwarding the 

received message to another address. The message selected in the list can be saved in the mail folder 

specified by the user or as a file in the directory specified by the user. Unnecessary messages are deleted. 

Currently, free e-mail systems organized through WWW have become very popular. In these systems, 

the user can obtain an e-mail address and password by registering on the corresponding page, which allows 

each employee of the office or family member to have their own e-mail address even if they all have a single 

account with the provider (user name and password to log in to the provider). In addition, this email address 

will remain unchanged, even if you change the provider. To access such an e-mail system in IE, the HotMail 

button is used in the link bar. Popular addresses of Russian-language email systems via WWW: win.mail.ru 

and www.chat.ru. You can work with the e-mail address received in the free mail system both with the help 

of the system itself and through regular e-mail programs. At the same time, for each email address of the 

sender of messages in the mail program, a separate Account must be created. If the owners of different email 

addresses use the mail program on the same computer, then they must first configure the mail program for 

their account. How to create mail accounts and work with them are described in the instructions on the 

WWW mail pages and in the help system for mail programs. 

NEWS, OR CONFERENCES 

Organization of work. Conferences are organized on a special network server NNTP, through which it 

is possible to organize collective discussions on any topic for all subscribers to the services of this service. 

Each conference has a name consisting of the names of several topics separated by a dot, such as 

Relcom.Commerce.food. Each title in the name, except the last one, details the topic whose name is to the 

right. For various topics, the conference title contains the following designations. 

So, conferences with the names Relcom. commerce. estate and Relcom.commerce, food are devoted to 

the purchase and sale of real estate and food products, respectively. Each conference is a collection of text 

messages-articles - of its subscribers; placing an article in a conference is called a publication. 



To work with news, either Outlook Express or MS Outlook is used. Conference programs provide: 

* an indication of the set of conferences that the PC user intends to participate in. This operation is

called a subscription, and the set of conferences that are subscribed to is called a subscription list. The 

subscription list can be changed (shortened or expanded) at any time); 

* view the names of authors and titles (topics) of articles in any particular conference from the

subscription list; 

* view the content of articles and, if necessary, save them in a file in the specified directory of the

user's PC; 

* publishing your own article in a specific conference;

* personal response to the author of any article to his E-mail address;

* a public response to the author of a specific article, which will appear as a conference article.

To work with conferences, the following parameters are specified: 

• DNS-name of the provider's server where the conference articles are stored. This server is called

NNTP, and its name must be specified in the contract with the provider; 

* user name to identify the author when viewing article titles;

• E-mail address of the user to enable personal addressing of the response to the article.

When you first access the Outlook Express program, a Wizard is launched that requests the listed 

information and configures the program accordingly. 

Programs for conferences are provided three kinds of Windows: 

• a subscription window in the conference;

* a view window that displays the titles and content of conference articles;

* article creation window. In the same window, a public response to the article is generated.

Each of the Windows is called by the corresponding menu command or by clicking on the tool button. 

The subscription window opens automatically the first time you access Outlook Express. 

The subscription window (called newsgroups in Outlook Express) can display either a complete list of 

all conference groups supported by the NNTP server, or only a list of conferences that have been subscribed 

to. In any of the lists, you can display a subset of conferences whose names contain the specified 

combination of characters. To add a conference to the subscription list, just double-click on the conference 

name; to exclude it from the list, you also need to double-click on its name in the subscription list. 

The view window appears when Outlook Express is called, and other Windows are called from it. The 

viewport includes the following elements: 

* drop-down list with a list of conferences from the subscription list, as well as the Outgoing,

Incoming, Sent, Deleted folders, which have the same meaning as in email; 

* title field, which displays a list of articles contained in the selected conference or folder in the

previous paragraph. For each article, its subject, author, date of creation, and volume are indicated. Articles 

can be sorted alphabetically by author's last name or by date. Headings of articles can be arranged according 

to the chain of discussions. In this case, the original article is placed first, and the answers to it are placed 

below. Only original articles can be displayed in the list. It is possible to exclude read articles from the list; 

* content field, which displays the content of the article whose title the cursor points to. The article

may contain attached files. 

For a marked article, you can use the appropriate command: save its content in a specified file, create a 

response article personally to its author, send a response to the article to one conference or several 

conferences at once. Although a personal response to the author is created from the Outlook Express 



program window, it is sent by e-mail, and is not included in conference articles. The article can be sent to 

the conference, and a copy can be sent by e-mail to any addressee. 

Mail services on the Internet are fast enough; as a rule, a letter from the sender to the recipient arrives 

in a matter of minutes. Sometimes, however, even such a transfer rate is disappointing. Therefore, they 

invented instant messaging systems (instant message systems). They allow you to send messages within a 

few seconds. You can also create so-called buddy lists, i.e. lists of users with whom you communicate. If 

one of your friends, listed in such a list, is logged in, then you will immediately know about it and can 

immediately send him a message. 

Such messaging systems are designed specifically for fans of frequent conversations on the network-

communication with their help can be compared to a conversation on the phone, only you do not hear your 

interlocutor, but read his messages on the screen of your monitor. The bad thing about these systems is that 

they are, among other things, capable of causing irritation 

Historical aspects of information security development 

Objectively, the category of "information security" arose with the emergence of means of information 

communication between people, as well as with the awareness of the presence of people and their 

communities of interests that can be harmed by influencing the means of information communication, the 

presence and development of which provides information exchange between all elements of society. 

Given the impact on the transformation of the ideas of information security, the development of 

information communication can be divided into several stages: 

• Stage I — before 1816 —during this period, the main task of information security was to protect

information about events, facts, property, whereabouts and other data with the person or community to 

which he belonged, vital. 

* Stage II-since 1816-is associated with the beginning of the use of artificially created technical means of

electrical and radio communication. To ensure the secrecy and noise immunity of radio communications, it 

was necessary to use noise-resistant encoding of the message (signal) with subsequent decoding of the 

received message. 

* Stage III-since 1935-is associated with the advent of radar and sonar facilities. The main way to ensure

information security during this period was a combination of organizational and technical measures. 

* Stage IV-since 1946-is associated with the invention and implementation of electronic computing

machines (computers) in practice. The problems of information security were solved mainly by methods and 

methods of restricting physical access to the equipment of the means of obtaining, processing and 

transmitting information. 

* Stage V-since 1965-is due to the creation and development of local information and communication

networks. The tasks of information security were solved by methods and methods of physical protection of 

the means of obtaining, processing and transmitting information combined in a local network. 

* Phase VI — since 1973-is associated with the use of ultra-mobile communication devices with a wide

range of tasks. Threats to information security have become much more serious. Communities of human 

hackers have formed, aiming to damage the information security of individual users, organizations and 

entire countries. Information resource has become the most important resource of the state, and ensuring its 

security is the most important and mandatory component of national security. Information law is being 

formed — a new branch of the international legal system. 

* Phase VII — since 1985-is related to the creation and development of global information and

communication networks using space-based support tools. It can be assumed that the next stage of 

information security development will obviously be associated with the widespread use of super-mobile 

communication devices with a wide range of tasks and global coverage in space and time provided by space 

information and communication systems. 

 The concept of information security 

Information security refers to the protection of information and its supporting 

infrastructure from any accidental or malicious influences, which may result in 

damage to the information itself, its owners or the supporting infrastructure.  

Information security of the organization – the state of security of the information 

environment of the organization, ensuring its formation, use and development. 



Information security of the state — the state of preservation of information resources of the state and the 

protection of the legal rights of the individual and society in the information sphere. 

In modern society, the information sphere has two components: information-technical (artificially created 

by man the world of technology, technologies, etc.) and information-psychological (the natural world of 

living nature, including the person himself). Accordingly, in General, the information security of society 

(state) can be represented by two components: information and technical security and information and 

psychological (psychophysical) security. 

Information security — all aspects related to the definition, achievement and maintenance of 

confidentiality, integrity, availability, non-repudiation, accountability, authenticity and reliability of 

information or its processing tools. 

 Information (data) security — the state of security of information (data), which ensures its (their) 

confidentiality, availability and integrity. 

 The security of information (data) is determined by the absence of an unacceptable risk associated 

with information leakage through technical channels, unauthorized and unintentional impacts on data 

and (or) other resources of the automated information system used in the automated system. 

 Security of information (using information technology) (eng. IT security) — the state of security of 

information (data) that provides information security for the processing which it applies, and 

information security of the automated information system in which it is implemented. 

 Security of an automated information system — the state of security of an automated system, which 

ensures the confidentiality, availability, integrity, accountability and authenticity of its resources. 

As a standard security model, a model of three categories is often cited: 

Privacy Policy (англ. confidentiality) – the state of information in which only the subjects who have the 

right to it have access to it; 

Integrity (англ. integrity)– the avoidance of unauthorized modification of information; 

Availability (англ. availability)- avoid temporary or permanent concealment of information from users who 

have received access rights. 

The protection procedures (mechanisms) themselves are divided into physical level protection, personnel 

protection and organizational level. 

Actions that can damage information security can be divided into several categories: 

1. Actions performed by authorized users. This category includes: purposeful theft or destruction of data

on a workstation or server; damage to user data as a result of careless actions. 

2. "Electronic" methods of influence carried out by hackers. Hackers are people who engage in computer

crimes both professionally (including in the framework of competition) and simply out of curiosity. These 

methods include: unauthorized access to computer networks; DOS attacks. 

The purpose of unauthorized penetration from the outside into the company's network can be causing 

damage (data destruction), stealing confidential information and using it for illegal purposes, using the 

network infrastructure to organize attacks on third-party nodes, stealing funds from accounts, etc. 

A DOS-type attack (socr. from Denial of Service – " denial of service») − this is an external attack on the 

nodes of the enterprise network that are responsible for its safe and efficient operation (file and mail 

servers). Attackers organize massive sending of data packets to these nodes to cause their overload and, as a 

result, for some time to disable them. This usually leads to violations in the business processes of the victim 

company, loss of customers, damage to reputation, etc. 

3. Computer viruses. A separate category of electronic methods of influence is computer viruses and

other malicious programs. They represent a real danger for modern business, which widely uses computer 

networks, the Internet and e-mail. The penetration of the virus on the nodes of the corporate network can 

lead to disruption of their functioning, loss of working hours, loss of data, theft of confidential information 

and even direct theft of financial resources. A virus program that has penetrated the corporate network can 

give attackers partial or complete control over the company's activities. 

4. Spam. In just a few years, spam has turned from a minor irritant into one of the most serious security

threats: e-mail has recently become the main channel for spreading malware; spam takes a lot of time to 

view and then delete messages, causes employees a sense of psychological discomfort; both individuals and 

organizations become victims of fraudulent schemes implemented by spammers; along with spam, important 



correspondence is often deleted, which can lead to loss of customers, disruption of contracts and other 

unpleasant consequences; the risk of losing correspondence is especially increased when using rbl blacklists 

and other "rough" spam filtering methods. 

5. "Natural" threats. The company's information security can be affected by a variety of external factors:

improper storage, theft of computers and media, force majeure, etc. can cause data loss. 

Thus, in modern conditions, the presence of a developed information security system becomes one of the 

most important conditions for the competitiveness and even viability of any company. 

Information security and the Internet 

Communication using the latest means of communication has absorbed 

the Internet. The world information network is developing rapidly, the 

number of participants is constantly growing. According to some reports, 

about 1.5 billion pages are registered on the network. Some "live" for up to 

six months, and some work for their owners in full force and bring a large 

profit. Information on the web covers all aspects of human life and society. 

Users trust this form with themselves and their activities. However, the 

experience of working in the field of computer technology is full of examples of unfair use of Internet 

resources. 

Experts say that the main reason for penetration into computer networks is carelessness and 

unpreparedness of users. This is typical not only for ordinary users, but also for specialists in the field of 

computer security. At the same time, the reason is not only negligence, but also the relatively small 

experience of security specialists in the field of information technology.  

According to experts, about 90% of the total number of malicious software penetrations on the computer 

is used via the Internet, via e-mail and web browsing. A special place among such programs is occupied by a 

whole class-the Internet worm. Self-propagating, regardless of the mechanism of work, perform their main 

tasks to change the settings of the victim's computer, steal the address book or valuable information, mislead 

the user himself, create a mailing list from the computer to addresses taken from the notebook, make the 

computer someone's resource or take part of the resources for their own purposes, or in the worst case, self-

liquidate, destroying all files on all disks. 

All these and other related problems can be solved by having a well-developed document in the 

organization that reflects the company's information security policy. Such a document should clearly state 

the following provisions: 

 how to work with the company's information; 

 who has access; 

 a system of copying and storing data; 

 PC operation mode; 

наличие availability of security and registration documents for equipment and software; 

выполнение meeting the requirements for the room where the PC and the user's workplace are located; 

 availability of instructions and technical documentation; 

наличие availability of work logs and the order of their maintenance. 

In addition, it is necessary to constantly monitor the development of technical and information systems 

published in the periodical press or to follow the events discussed at such seminars. 

Methods of ensuring information security 

According to experts, the task of ensuring information security should be solved systematically. This 

means that various security measures (hardware, software, physical, organizational, etc.) must be applied 

simultaneously and under centralized management. At the same time, the system components must "know" 

about each other's existence, interact and provide protection against both external and internal threats. 

To date, there is a large Arsenal of methods to ensure information security: 

 means of identification and authentication;

 шифрования means of encrypting information stored on computers and transmitted over

networks;

 firewalls;

 virtual private networks;

 content filtering tools;



 tools for checking the integrity of disk contents;

 anti-virus protection tools;

 detection systems network-based vulnerabilities and attacks network analyzers.

Each of these tools can be used both independently and in integration with others. This makes it possible 

to create information security systems for networks of any complexity and configuration that do not depend 

on the platforms used. 

Identification and authorization are key elements of information security. The authorization function is 

responsible for what resources a particular user has access to. The function of administration is to provide 

the user with certain identification features within a given network and determine the scope of permissible 

actions for him. 

Encryption systems allow you to minimize losses in the event of unauthorized access to data stored on a 

hard disk or other media, as well as interception of information when it is sent by e-mail or transmitted over 

network protocols. The purpose of this protection tool is to ensure confidentiality. 

A firewall is a system or combination of systems that forms a protective barrier between two or more 

networks to prevent unauthorized data packets from entering or exiting the network. The main principle of 

operation of firewalls is to check each data packet for compliance of the incoming and outgoing IP addresses 

with the database of allowed addresses. 

When talking about cryptography and firewalls, we should mention protected virtual private networks 

(VPNs). Their use allows you to solve the problems of confidentiality and integrity of data when they are 

transmitted over open communication channels. Using a VPN can be reduced to solving three main tasks: 

1. protection of information flows between different offices of the company (encryption of information is

performed only at the output to the external network); 

2. secure access of remote network users to the company's information resources, usually via the Internet;

3. protection of information flows between individual applications within corporate networks (this aspect

is also very important, since most attacks are carried out from internal networks). 

An effective means of protecting against loss of confidential information is filtering the contents of 

incoming and outgoing e-mail. Checking the email messages themselves and their attachments based on the 

rules established in the organization also helps protect companies from liability for lawsuits and protect their 

employees from spam. Content filtering tools allow you to check files of all common formats, including 

compressed and graphic ones 

All changes on the workstation or on the server can be tracked by the network administrator or other 

authorized user thanks to the integrity checking technology of the hard disk contents. This allows you to 

detect any actions with files (modification, deletion or just opening) and identify virus activity, unauthorized 

access or theft of data by authorized users. 

Modern antivirus technologies allow you to identify almost all already known virus programs by 

comparing the code of a suspicious file with samples stored in the antivirus database. In addition, behavior 

modeling technologies have been developed to detect newly created virus programs. Detectable objects can 

be treated, isolated (quarantined), or removed. Virus protection can be installed on workstations, file and 

mail servers, firewalls running under almost any of the common operating systems (Windows, Unix and 

Linux systems, Novell) on processors of various types 

Spam filters significantly reduce unproductive labor costs associated with spam analysis, reduce traffic 

and server load, improve the psychological background in the team and reduce the risk of involving 

company employees in fraudulent operations. In addition, spam filters reduce 

the risk of infection with new viruses, since messages containing viruses 

(even those not yet included in the databases of antivirus programs) often 

have signs of spam and are filtered out.. 

To counteract natural threats to information security, a set of procedures 

should be developed and implemented to prevent emergencies (for example, 

to ensure physical protection of data from fire) and minimize damage in the 

event that such a situation does occur. One of the main methods of data loss protection is backup with strict 

compliance with established procedures (regularity, media types, copy storage methods, etc.). 



To describe the information security technology of a particular information system, the so-called 

information security Policy or security Policy of the information system in question is usually constructed. 

Security policy (English: Organizational security policy) — a set of 

documented rules, procedures, practices or guidelines in the field of 

information security, which are guided by the organization in its activities. 

To build an information security Policy, it is recommended to consider the 

following areas of information system protection separately: 

* Protection of information system objects;

* Protection of information processing processes, procedures and

programs; 

* Protection of communication channels;

* Suppression of spurious electromagnetic radiation;

* Management of the security system. Software and technical methods and means of ensuring

information security 

 The literature suggests the following classification of information security tools: 

Means of protection against unauthorized access; 

Authorization tools; 

Mandatory access control; 

Selective access control; 

Role-based access control; 

Logging (also called auditing). 

Systems for analyzing and modeling information flows (CASE-

systems). 

Network monitoring systems: 

Intrusion detection and prevention systems (IDS/IPS). 

Confidential information leak prevention systems (DLP systems). 

Protocol analyzers. 

Antivirus tools. 

Firewalls. 

Cryptographic tools: 

Encryption; 

Digital signature. 

Backup systems. 

Uninterruptible power supply systems: 

Uninterruptible power supplies; 

Load redundancy; 

Voltage generators. 

Authentication systems:  

Password; 

Access key (physical or electronic); 

Certificate; 

Biometrics. 

Means of preventing hacking of cases and theft of equipment. 

Means of controlling access to premises. 

Security system analysis tools: 

Monitoring software product. 

Computer viruses and antivirus programs 

A computer virus is a type of malicious software that can create copies of itself and be embedded in the 

code of other programs, system memory areas, boot sectors, as well as distribute its copies through various 

communication channels. 

As a rule, the purpose of the virus is to disrupt the operation of software and hardware complexes: 

deleting files, disabling data placement structures, blocking users ' work or disabling computer hardware 

complexes, etc. Even if the author of the virus has not programmed malicious effects, the virus can lead to 

computer failures due to errors, unaccounted for subtleties of interaction with the operating system and other 



programs. In addition, viruses usually take up space on storage devices and consume some other system 

resources. 

In everyday life, "viruses" are called all malware, although in fact this is only one type of it. 

History of computer viruses 

The foundations of the theory of self-replicating mechanisms were laid by an American of Hungarian 

origin, John von Neumann, who in 1951 proposed a method for creating such mechanisms. Working 

examples of such programs have been known since 1961. 

The first known viruses are Virus 1,2,3 and Elk Cloner for the Apple II PC, which appeared in 1981. In 

the winter of 1984, the first antivirus utilities appeared-CHK4BOMB and BOMBSQAD by Andy Hopkins. 

In early 1985, guy Wong (eng. Gee Wong) wrote the program DPROTECT — the first resident antivirus. 

The first virus epidemics date back to 1986-1989: Brain. A [en] (spread in the boot sectors of floppy 

disks, caused the largest epidemic), Jerusalem[en] (appeared on Friday, may 13, 1988, destroying programs 

when they were launched), the Morris worm (over 6,200 computers, most networks failed for up to five 

days), DATACRIME (about 100 thousand infected PCs in the Netherlands alone). 

At the same time, the main classes of binary viruses were formed: network worms (Morris worm, 1987)," 

Trojan horses " (AIDS, 1989), polymorphic viruses (Chameleon, 1990), stealth viruses (Frodo, Whale, 2nd 

half of 1990). 

A computer virus (CV) is a program that can create copies of itself (not necessarily completely identical 

to the original), embed them in various objects or resources of computer systems, networks, and perform 

certain actions without the user's knowledge. 

KV got its name for some similarity with a biological virus. For example, in an infected program, another 

virus program reproduces itself, and the infected program can run for a long time without errors, as in the 

incubation stage. 

Distinctive features of computer viruses are: 1) small volume; 2) self-launch; 3) multiple code 

copying; 4) interference with the correct operation of the computer 

The program that contains the virus is called an infected program. 

After infecting a computer, the virus can activate and force the computer to perform any actions. The 

activation of the virus can be associated with various events (the onset of a certain date or day of the week, 

the launch of a program, the opening of a document, and so on). 

When an infected program starts working, the control first receives the virus. It infects other programs 

and also performs planned destructive actions. To disguise their actions virus aktiviziruyutsya not always, 

but only during certain conditions (after a certain time, completing a certain number of operations, the 

occurrence of a date or day of the week, etc.). Once the virus will perform the necessary action, it passes 

control to the program in which it is located. An externally infected program can work in the same way as a 

normal program. Like real viruses, THEY hide, multiply, and look for opportunities to switch to other 

computers. 

Despite the widespread use of antivirus programs, viruses continue to multiply. On average, about 300 

new varieties appear per day. 

Different viruses perform different actions: 

• Display disturbing text messages (greetings, political slogans, phrases with a claim to humor, etc.);

* Create sound effects (anthem, gamma, popular melody);

* Create video effects (flip or shift the screen, simulate an earthquake, cause the letters in the text to fall

off, display pictures, etc.); 

• Slow down the computer, gradually reduce the amount of free RAM;

* Increase wear and tear on equipment (such as disk drive heads);

* Cause individual devices to fail, freeze or restart the computer, and cause the entire computer to crash;

* Destroy FAT, format hard disk, erase BIOS, destroy or modify data, erase antivirus programs;

* Carry out scientific, technical, industrial and financial espionage;

• Incapacitate the system of protection of information, etc.

The main danger of self-replicating codes is that virus programs begin to live their own lives, almost 

independent of the program developer. Just like in a chain reaction in a nuclear reactor, the running process 

is difficult to stop. 

Symptoms of computer virus infection: 

* Slow down some programs



* Increase file sizes (especially executable files))

* Appearance of "strange" files that did not exist before

* Reduced amount of available RAM (compared to normal operation mode)

* Suddenly appearing a variety of video and sound effects

• The appearance of failures in the OS (including freezing)

• Writing information to disks at times when this should not happen

* Termination of work or incorrect operation of previously normally functioning programs.

There are a large number of different classifications of viruses: 

1. The habitat:

o  o Network-distributed over networks (Melissa). 

o o File-infect executable files with extensions .exe, .com. 

o . This class also includes macro viruses that infect non-executable files (for

example, in MS WORD or MS EXCEL). 

o o Bootable-embedded in the boot sector of the disk (Boot sector) or in the sector 

containing the system disk boot program (Master Boot Record-MBR). Some viruses write 

their bodies to free disk sectors, marking them as "bad" in FAT. 

o o File-boot-capable of infecting both boot sectors and files. 

o 2. By way of infection: 

o o Resident-leave their resident part in RAM, which then intercepts program calls to the OS 

and is embedded in them. Its destructive actions of the virus can be repeated many times. 

o o non-Resident – do not infect RAM and show their activity only once when running an 

infected program. 

o 3. According to the degree of danger: 

o o non-Hazardous – for example, a message appears on the screen: "I want CHUCHU." If you 

type the word "Chucha" on the keyboard, the virus temporarily "calms down". 

o o Dangerous-destroy part of the files on the disk. 

o o Very dangerous-they format the hard drive themselves. (CIH-is activated on the 26th of 

each month and is able to destroy data on the hard disk and in the BIOS). 

o 4. According to the features of the algorithm: 

o o companion Viruses-create new companion files for EXE files that have the same name but 

with the com extension. The virus is written to a com file and does not change the EXE file of 

the same name in any way. When running such a file, the OS will first detect and execute the 

com file, i.e. the virus, which will then run the EXE file as well. 

o o Parasitic – modify the contents of disk sectors or files. 

o o Replicators (worms) – spread on the network. They get into the computer's memory from 

the network, calculate the network addresses of other computers and send copies of 

themselves to these addresses. Worms reduce network bandwidth, slow down servers. They 

can reproduce without being embedded in other programs and have a" stuffing " of computer 

viruses. (The "Morris worm" in the late 80's paralyzed several global networks in the United 

States). 

o invisible (stealth) - disguise their presence in the computer, they are difficult to detect. They intercept

treatment to the affected OS files or sectors of disks and "substituted" non-infected parts of the file. 

o Mutants (ghosts, polymorphic viruses, polymorphics) - they are difficult to detect, because their copies

almost do not contain completely matching code sections. This is achieved by adding empty commands 

(garbage) to virus programs, which do not change the algorithm of the virus, but make it difficult to detect 

them. (OneHalf-local "epidemics" of it occur regularly). 

o Macro viruses-use the capabilities of macro languages built into data processing systems (Word,

Excel). 

o "Trojan horses" - masquerade as a useful or interesting program, performing during its operation also

destructive work (for example, erases FAT) or collects information on the computer that is not subject to 

disclosure. They do not have the property of self-reproduction. 

2. Integrity:

o Monolithic-the virus program is a single block that can be detected after infection.



o Distributed-the program is divided into parts. These parts contain instructions that tell the computer

how to put them together to recreate the virus. 

 Anti-virus programs are being developed to fight viruses. An antivirus program is a 

program designed to fight computer viruses. In medical terms, these programs can detect 

(diagnose), treat (destroy) viruses and vaccinate "healthy" programs. 

Types of antivirus programs: 

* Detection programs (scanners) – designed to detect specific viruses. They are based on

comparing the characteristic (specific) sequence of bytes (signatures or virus masks) contained 

in the virus body with the bytes of the programs being checked. These programs need to be updated 

regularly, as they quickly become obsolete and cannot detect new types of viruses. If the program is not 

detected by the detector as infected, it does not mean that it is "healthy". It may contain a virus that is not 

listed in the detector's database. 

* Doctor programs (phages, disinfectants) –not only find files infected with the virus, but also treat them

by removing the body of the virus program from the file. Polyphages - allow you to treat a large number of 

viruses. Detector programs that simultaneously perform the functions of doctor programs are widely 

distributed. Examples: AVP (author E. Kaspersky), Aidstest (D. Lozinsky), Doctor Web (I. Danilov). 

* Audit programs-analyze the current state of files and system areas of disks and compare it with the

information stored earlier in one of the files of the auditor. At the same time, the state of the Boot sector, 

FAT, as well as the length of files, their creation time, attributes, checksums (summation modulo 2 of all 

bytes of the file) are checked. An example of such a program is Adin f (D. Mostovoy). 

* Filter programs – watchmen, monitors) - resident programs that notify the user of all attempts by any

program to perform suspicious actions, and the user decides whether to allow or prohibit the execution of 

these actions. Filters control the following operations: updating program files and the system area of disks; 

formatting the disk; resident placement of programs in RAM. An example is the Vsafe program. It is not 

able to neutralize the virus, for this you need to use phages. 

* Immunizing programs-record the signs of a specific virus in the vaccinated program so that the virus

considers it already infected, and therefore does not re-infect it. These programs are the least effective and 

outdated. 

Measures to protect computers from infection with viruses: 

• Equipment of computer-to-date antivirus software and regular update versions.

* Installation of the filter program when working in a global network.

* Check the floppy disk for viruses before reading information recorded on other computers from floppy

disks. 

• When transferring files to your PC in archived form, check them immediately after unzipping.

* Protect your floppy disks from writing when working on other PCs.

* Create archived copies of valuable information on other media.

* Do not leave the floppy disk in the drive when turning on or restarting the PC, as it may be infected

with boot viruses. The presence of an emergency boot floppy disk from which you can boot if the system 

refuses to do so in the usual way. 

• When installing a large software product, first check all distribution files, and after installing the

product, re-check for viruses. 

For normal operation on the PC, each user must monitor the update of antivirus programs. 

Archiver programs 

The purpose of archiver programs is to save disk space by compressing (packing) one or more files into 

an archive file. Archiver programs are used to store large amounts of information in a packaged form that 

will be needed in the future; transfer information between computers using floppy disks or e-mail; create 

compressed backup copies of files; and protect against computer viruses. As a result of the work of archiver 

programs, archive files (archives) are created. 

At the heart of the work of archiver programs is the procedure for searching and transcoding identical 

fragments of file content. Compression of information in files is performed by eliminating redundancy in 

various ways (by simplifying codes, eliminating constant bits, replacing their repeating sequence with a 

repetition factor, etc.). there are many data compression algorithms. For example, the entropy coding 

method. You can compress one or several files that are compressed and placed in the archive. 



The archive file includes a table of contents containing the following information about files stored in 

the archive: file name; directory information, in which he was; the date and time the file was last modified; 

the file size on disk and in the archive; .loop control code for each file used to check the integrity of the 

archive. The name of the corresponding archiver program is set as extensions to archive files by default. 

Most archiver programs allow you to create multi-volume archives. A multi-volume archive is a 

sequence of archive files that do not exceed the specified volume size. It is usually created when you need to 

transfer an archive on floppy disks, if the archive size exceeds the capacity of the floppy disk. When creating 

such archives, the archiver pauses to change the floppy disk. A multi-volume archive has a common name, 

while the extension of each multi-volume archive file specifies the volume number. 

A self-extracting archive is a specially processed archive file that is an executable file. Executing such a 

file causes the files contained in it to be unpacked. Typical functions of archiver programs are as follows; 

1. Archive the source files.

2. Extract files from the archive.

3. Delete files from the archive.

4. View the table of contents of the archive.

5. Versioning (check) archive.

For each file from the archive, the cyclic control code (CRC) is stored in the table of contents of the 

archive file. When you extract a file, the loop control code for it is calculated and compared with what is 

written in the archive table of contents. If they do not match, an error message is displayed. 

Currently, the most widely used archiver programs focused on working under the Windows operating 

system. These are WinRAR and WinZip, which are characterized by a high compression ratio, work 

with long file names and a user-friendly interface. 

WinRAR has a particularly user-friendly interface. This archiver supports processing of many archive 

formats and uses an original packaging algorithm, especially effective for executable and text files. 

Important additional features of the program include: protecting the archive with a password; restoring 

damaged archives; creating multi-volume and self-extracting archives; saving comments to archives. The 

WinRAR user interface contains the main menu, toolbar, and workspace that shows all the files in the 

current folder. When working with WinRAR, archives are perceived as folders, the contents of which 

can be viewed in traditional ways. 

The "Problem" Method. Students are divided into subgroups. Teams are given or shown a specific 

situational problem. Team members will have to identify the problem, find out the reasons for its 

occurrence, and they will also have to find ways to solve this problem. 

The "Resume" Method. Students are divided into subgroups. The teacher explains the purpose and 

course of the lesson, as well as distributes material where various ways to solve a particular problem or 

problem are given. The participants of the groups will have to identify the positive and negative aspects 

of ways to solve the problem. Each group explains their answers. All groups will have to participate in 

the discussion of the answers. At the end of the lesson, the teacher supplements the answers of the teams 

and inserts grades. 

Control questions 

1. What is the purpose of intercomputer communication?

2. Describe the client-server technology.

3. What is a communication protocol?

4. Why is data transferred using packets?

5. Describe the main types of network topologies.

6. What are the characteristics of common network architectures.

7. What is a hub?

8. How are computer networks classified according to the degree of geographic distribution?

9. In what areas and for what purpose are local networks used?

10. How are local networks interconnected?

11. How do wireless networks work?

12. What is a router and a bridged router?

13. What is the Internet and how is access to it organized?



14. What are "provider" and "site"?

15. What information systems are available on the Internet?

16. What is an Internet IP address and what is it for?

17. What is a domain name?

18. How do Internet search engines work?

19. What is Medline network?

20. What is the purpose and principles of e-mail?

21. What are the steps required to prepare, send and receive a message by email?

22. What are Internet conferences?

23. What are the main elements of working with conferences.

8-  Theme software oriented to the creation of Web sites. 

1.1. The model of technology training 

Duration of the lesson-2 hours        Number of students: 30-60 

Class form         Informational lecture 

Plan of the lecture 

1. General information about

the HTML language 

2. The structure of the HTML

document 

3. Formatting the text

4. Creating hyperlinks

The world Wide Web (WWW) consists of many interconnected 

electronic documents described using special technological rules. These 

rules are compiled in the hypertext markup language (HTML). 

Purpose of the lesson: Give General information about the hypertext markup language. 

Training method Demonstration: lecture and interview 

Type of training Collective 

Tools training Tutorials, textbooks, lecture text, projector, computer 

Training conditions Methodically equipped audience. 

Monitoring and evaluation 

1.2. Technological map of the lecture 

Stages of work and 

allotted time 

Stages of conducting a lesson by a teacher Students 

Preparatory stage. 1. Prepare an educational component of the topic.

2. Prepares presentation slides for the topic.

3. Make a list of literature used for the development of

the subject. 

1. Introduction to

the topic 

(10 min) 

Will introduce you to the purpose and task of the topic. Listening 

2. Main stage

(55 min) 

1. Explains the topic and demonstrates the presentation.

2. Applies the posters

. 

Listening 

They record it 

3. The final stage

(10 min) 

Makes a final conclusion Listening 

4. Self-study tasks

(5 min) 

Declares tasks of independent work.  Records 



1. 1. General information about the HTML language 

The world Wide Web (WWW) consists of many interconnected electronic documents described using 

special technological rules. These rules are compiled in the hypertext markup language (HTML). 

Many people call HTML a programming language. This is not entirely true, since in the traditional 

sense HTML is a markup language for electronic documents, only indicating to HTML page viewers the 

form of presentation of the information described in the document. 

Special programs for viewing electronic documents created according to the rules of the HTML 

markup language are called browsers. The main function of the browser is to interpret the HTML code and 

display the visual result on the user's monitor screen. Today, there are a large number of different browsers, 

but the most popular are only three programs: Internet Explorer, Netscape Navigator and Opera. 

2. HTML document structure

As mentioned earlier, the HTML language is a set of special rules. Each rule has its own name, property, 

and value. For example, to set a bold rule for plain text, use the following HTML construct: 

< B>Plain text< / B> 

As you can see from the example, the text that should be displayed in bold is separated by groups of 

characters <B> and </B>. Such groups are usually called tags. Immediately it should be said that tags can be 

single and paired. In the case of our example, the </B > tag is paired, because it closes the HTML construct 

along with the " / " character (a straight slash). Sometimes tags that need to be closed with a paired tag are 

called container tags. 

The structure of any tag implies specifying the tag itself, its parameter, and the value of this parameter. In 

this case, the name of the parameter and its value can be written in both lowercase and uppercase letters. The 

parameter value is enclosed in quotation marks. 

In addition, parameters and their values can either be omitted from any particular tag at all, or they can be 

considered optional and set only if the standard tag characteristics are changed: 

<TABLE WIDTH= "100%" BORDER> 

In the given example, for the <TABLE> table construction tag, one parameter (WIDTH) is specified with a 

value, the other (BORDER) does not contain one. 

Some tags can be specified without any parameters at all (for example, forced line wrapping <BR>). Other 

tags may include multiple values for the same parameter. 

Any HTML document contains three main mandatory sections: HTML, HEAD, and BODY. Let's take a 

closer look at each of them. 

The HTML section 

The HTML section defines the specifics of the document, the content of which will be interpreted by 

the browser. The section is described by the <HTML> </HTML > container tag and gives the browser 

information that the document is designed using the HTML markup language. 

Head section 

The HEAD section serves as the working title of an HTML document and is, in fact, a "fighter of the 

invisible front" - the tags specified inside this section are extremely important and can greatly affect the 

appearance of the document, but they themselves remain invisible to the user's eye. This section is 

associated with the paired tag <HEAD> </HEAD>. 

Consider the HTML tags that are specified inside the HEAD section. 

Document name <TITLE> 

The paired tag <TITLE> </TITLE> is used to specify the name of the created electronic document. It 

should be remembered that the document name in this case does not mean the file name, but the visual title 

of the HTML page. 

Specifying the <TITLE> </TITLE> construct is optional, but it is recommended for a number of 



reasons: 

o the absence of the document title tag will cause the browser to display a phrase like Untitled 

Document in the window title when interpreting the HTML code, which does not correspond to the subject 

of your electronic document or its content; 

o if you try to add an HTML document you created (without the <TITLE> </TITLE> container tag) to 

the browser's "bookmarks", the user will have to enter the name of the page being added independently; 

o search engines, when faced with an unnamed page, will enter it in their databases under the heading 

Untitled, which will make the HTML document faceless and similar to millions of other electronic 

documents posted on the Internet. 

The BODY section 

The BODY section is one of the most important components of any HTML document, because it 

contains the content part that is displayed by the browser on the user's monitor screen. 

The section is described by the paired <BODY> </BODY> tag, which contains most of the existing 

HTML tags. The <BODY> tag has a number of parameters (see table). 1), which can be divided into four 

main groups (background parameters, document borders, text and hyperlinks). 

Parameter Function 

BGCOLOR Determining the background color 

BACKGROUND Specifying the background image 

BGPROPERTIES Changing the background properties (for example, 

fixing the background image) 

LEFTMARGIN,   

RIGHTMARGIN,  

MARGINWIDTH,    

MARGINHEIGHT 

Determining the size of margins 

TEXT Defining the color of the main text 

LINK, ALINK, VLINK Determining the color of hyperlinks 

Table 1 

Background parameters 

The background settings of the document are BGCOLOR, BACKGROUND and BGPROPERTIES. 

BGCOLOR sets the background color, the value of which can be entered in character equivalent, hexadecimal 

code, or RGB color model format. The color indication system in HTML is based on three primary colors: red, 

green, and blue (the RGB model is Red, Green, and Blue). Any RGB value can be converted to hexadecimal 

format (from 00 to FF with the prefix # (read "sharp")). Some values of the mentioned models correspond to 

the symbolic name of the color. Thus, the same color can be specified in three possible ways. 

The following shows three options for setting the background color (white): 

<BODY BGCOLOR="white"> 

<BODY BGCOLOR="#FFFFFF"> 

<BODY  BGCOLOR="255,255,255"> 

The names of the colors, as well as their hexadecimal format, are presented in Appendix No. 1. 

The BACKGROUND parameter allows you to apply a graphic image to the background of the 

document: 

<BODY BACKGROUND="images/bg.gif"> 

The bgproperties parameter is only supported by Microsoft Internet Explorer and allows you to change 

the background properties of the document. For example, the construction 

<BODY BACKGROUND="images/bg.gif "BGPROPERTIES=" fixed " > will 

allow you to scroll through the content of the document, leaving the background graphic image in a 

fixed form. 

The described parameters are not mandatory, but the use of BGCOLOR is recommended for the 

following reason: the user can set any background color in the settings of his browser, and the developer, 

believing that white is the main default color, may not specify this parameter. As a result, instead of the 

implied white color, the background may turn out to be black, green, etc., which can lead to a violation of 

the document design. Also, along with the graphic image of the background, it is recommended to use color 

parameters in case the drawing does not load (then the browser will display the color). 

The border options of the document 



The border parameters of an HTML document create margins of the specified size from the top, 

bottom, left, and right edges of the document. These margins correspond to the parameters TOPMARGIN, 

BOTTOMMARGIN, LEFTMARGIN and RIGHTMARGIN. Their values are set in pixels: 

< BODY TOPMARGIN="5" BOTTOMMARGIN="5" LEFTMARGIN="10" 

RIGHTMARGIN="10"> 

Text parameters 

Of the document text parameters, only one is actually used — TEXT. It sets the color of the main text 

on the page (the parameter value can be entered in the same way as the background color of the document): 

<BODY TEXT= "black"> 

Hyperlink parameters 

The parameters of hyperlinks (links to internal or external documents) determine the color of active 

(ALINK), unvisited (LINK) and visited (VLINK) links: 

<BODY LINK= "#OOOFF "ALINK=" #OOOFF "VLINK= "blue"> 

First HTML document 

So, we have considered the main sections of any HTML document. In General, the code of the 

simplest page is presented in the example 1. 

Example 1. An example of a simple HTML document 

<HTML> 

<HEAD> 

<TITLE>My first НТМL document</ТIТLЕ> 

</HEAD> 

<BODY BGCOLOR="#FFFFFF" TOPMARGIN="30" TEXT="black" LINK="#00FF00" 

ALINK="#00FF00" VLINK="blue"> 

This is my first HTML document! 

< / BODY> 

</HTML> 

Now save the code under any name, without forgetting to assign the file extension html or htm. Open 

the file in the browser. 

Figure 1. Formatting text 

It is safe to say that the text is not the last place in the structure of the HTML document. In most cases, 

we visit Internet sites in search of textual information: articles and works of art, news and technical 

documentation, etc. Therefore, much depends on how the text is designed, how it is presented to the visitor, 

in the fate of any Web site. 



The field of working with text in HTML includes a large number of various tags that make up two 

main groups-logical formatting tags and physical formatting tags. 

The logical formatting tag group includes tags that display document elements on the monitor screen 

in the way that is set by default in the HTML markup language specification. You can't override their 

parameters or properties, except in situations where CSS style templates are used and physical formatting 

tags are separated. The result of different logical formatting tags can visually coincide, because their main 

purpose is to logically highlight individual HTML elements. 

Physical formatting tags allow the developer of an HTML document to visually change the appearance 

of text by varying its parameters and values. In other words, physical formatting tags are designed to 

highlight individual text fragments in various ways set by the author of the document. 

Let's take a closer look at the most used tags from each group. 

2.1. Tags of logic formatting 

The <ACRONYM> tag is used to decipher abbreviations. It is implemented via the TITLE parameter 

(example 2) and is displayed in the browser when the cursor hovers over the abbreviation word (figure 2). 

Example 2. Using the <ACRONYM> 

<HTML> 

<HEAD>tag 

< TITLE>Decrypt abbreviations using the ACRONYM</TITLE>tag 

</HEAD> 

<BODY BGCOLOR="FFFFFF" TEXT="black" LINK="#OOFFOO" ALINK="#OOFFOO" 

VLINK="blue"> 

<ACRONYM TITLE="HyperText Markup Language">HTML < /ACRONYM> is one of the most 

popular and widespread text markup languages used to create Web sites today. 

</BODY></HTML> 

Figure 2 

In addition to <ACRONYM>, the <ABBR>tag has the ability to display the word in abbreviated form 

and hints to it. 

The <CITE> tag is designed to highlight various quotes and statements, names of bibliographic 

sources, etc. Text placed between the <CITE> and </CITE> tags is italicized by the browser. Visually 

similar to the <EM> and <I>tags. 

The <CODE> tag is used to visually highlight small fragments of program code. The code placed in 

this paired tag is displayed in a monospaced font. 

The <DEL> tag is used to indicate the deleted text. It has optional DATETIME and CITE parameters 

(the first one shows the date of deletion, the second one refers to the source of the reason for deletion). The 

text enclosed between the <DEL> tags is displayed strikethrough and is similar to the action of the <S> or < 

STRIKE>tags. 

Tag <EM> - used for intonation selection of a certain text fragment (example 3). Browsers display it in 



italics (just like the <CITE> and <I>tags) 

Пример 3 

<HTML> 

<HEAD> 

<TITLE> Select the text in italic </TITLE> 

The < / HEAD> 

< BODY> Tag is used for < EM>intonation highlighting of a certain text fragment< / EM>. 

Browsers display it in italics. 

</BODY></HTML> 

Figure 3 

Tags <HI>, <H2>. .. <H6> - the <H> tag with one of the digits (from 1 to 6) specifies a certain size of 

the title of the entire text or its specific fragment (example 4). Accordingly, the header <H6> will be 

minimal, and <H1> — the largest (Fig. 4). the Peculiarity of <H> tags is that they already imply indentation 

from the text part and developers of HTML documents do not have to indent themselves. 

Example 4. Using the <H1> - <H6>tags 

<HTML> 

 <HEAD> 

< TITLE>H1 - H6 Headers </TITLE> 

</HEAD> 

<BODY> 

< H1>Header 1 </H1> 

< H2>Heading 2</H2> 

< NZ>Heading 3</NZ> 

< H4>Title 4</H4> 

<H5>Heading 5</H5> 

<H6>Heading 6</H6> 

</BODY> 

 </HTML> 

Figure 4 



The list of logical formatting tags considered is given in table 2. 

Тег Function 

ACRONYM Explanation of abbreviations 

CITE Quote indication 

CODE Specifying a piece of program code 

DEL Designation of deleted information 

ЕМ Italics 

Н1-Н6 Creating headers 

STRONG Bold text selection 

Table 2 

2.2. Tags of physical formatting 

Tag <B> - the function of this tag is similar to the action of the <STRONG> tag, namely, the visual 

selection of the text fragment that should be emphasized is displayed in bold. 

The <BASEFONT> tag is used to determine the type of font, as well as its color and size, which will 

be considered the default for the entire HTML document. The parameters of the <BASEFONT > tag are 

similar to the parameters of the <FONT> tag and can be changed in the course of the text by additional 

formatting using the <FONT>tag. 

Note that the <BASEFONT> tag is used in two sections of the document: HEAD and BODY. It does 

not require a closing <BASEFONT> tag. 

The <BIG> tag is used if you want to highlight a part of the text by slightly increasing the font size 

relative to the rest of the words. However, it should be noted that the HTML specification does not approve 

of this approach and recommends using <H>header tags. 

The <FONT> tag is one of the main physical text formatting tags that displays font properties. The 

following parameters can be used for it. 

FACE-the parameter by which the browser displays the text in the font specified in the HTML code. In 

this case, the value of the FACE parameter must correspond to the font installed on the user's computer. If 

there is no such font, the text will be displayed in the standard (default) font. 

COLOR-a parameter used to select the color that the text will be written with. the HTML construction 

looks like this: 

<FONT COLOR="red">This text will be written in red.</FONT> 

SIZE function this parameter is to define the font size, which occurs at the conventional scale of 1 to 7. 

The sizing can be carried out at a relative rate (+1), and absolute (1). The average font size is considered to be 

the indicator 3. However, the final form of a font based on the properties of its size may differ depending on 

the model and version of the browser. 

Tag <I> — a tag similar to the logical formatting tags <CITE> and <EM> (highlights the desired part 

of the text in italics). 

The <SMALL> tag is designed to set the font size slightly smaller than the rest of the words (by 

placing the desired fragment between the paired <SMALL> tag, we get the opposite effect of the <BIG>tag). 

The <SPAN> tag is used when the selected text fragment needs to be assigned certain properties, and 

no logical tag can be used. 

<S> and <STRIKE> tags — in the latest version of the HTML specification, these two tags were 

called canceled. Instead, we recommend using the <DEL> tag, which also crosses out the selected text 

fragment. 

Tag <SUB> - positions the text fragment relative to the bottom line of the line. A very convenient tool 

for writing mathematical and chemical formulas. 

Tag < SUP> - places the text fragment relative to the top line of the line. Also suitable for inclusion in 

a variety of formulas. 

Tag < TT> - the specification defines it as a tag for displaying a teletype or text typed in a monospaced 

font. In some cases, it can be replaced with the <CODE>tag. 

<U> tag - makes the text underlined. 

2.3. Structural formatting 



As you know, any text has its own structure. The books are divided into parts, chapters, and sections. 

Newspapers and magazines have separate headings and subheadings, which, in turn, include fragments of text 

that also have their own internal structure — paragraphs, indents, paragraphs, etc. 

The <P> tag is paired, but the closing tag is not required according to the latest HTML specification. 

Since <P> belongs to the category of structural tags, it cannot include other structural formatting elements. It 

can only contain text formatting tags (logical and physical). 

The <P> tag can contain the ALIGN parameter, which is responsible for the type of horizontal 

alignment of text in the browser window (example 9): 

o o ALIGN= "LEFT" — the text is aligned to the left (the default value of the parameter). If this type of 

alignment is required, you do not need to specify the ALIGN parameter; 

o o ALIGN= "CENTER" — the text is located in the middle of the browser window. The use of this 

value is not recommended when working with large fragments of text, because due to the different 

length of words, the perception of the paragraph is difficult; 

o o ALIGN= "RIGHT" - align the text to the right edge. Ideal for the creation of epigraphs, signatures, 

headers, etc. Use when working with large text fragments is undesirable; 

o o ALIGN= "JUSTIFY" - align to the width of the browser window. The JUSTIFY value has been 

supported by browsers relatively recently, but in many cases this type of alignment is suitable for 

working with text.  

Centering 

Centering any elements of an HTML document can be done using the <CENTER>tag. All data 

placed inside the <CENTER> </CENTER> container tag must be horizontally aligned in the middle of the 

browser window. In essence, the <CENTER> tag is an analog of the ALIGN="CENTER" value of the tag 

whose display result will be centered on the monitor screen. For example, the result of displaying a snippet 

of table code 

<CENTER> <TABLE> <TR> <TD> </TD> </TR> </TABLE> 

< / CENTER> 

and the code snippet 

<TABLE ALIGN="CENTER"> <TR> <TD> < /TD> < /TR> </TABLE> 

it will be exactly the same. In the first case, the structural centering tag is used, in the second-the 

corresponding type of alignment of the entire table relative to the browser window is specified 

4. Tabular representation of data

One of the most powerful and flexible means of presenting information data in HTML is rightfully 

tables. In everyday life, when solving certain tasks, we often encounter tables. However, in HTML, tables 

are not limited to a convenient means of structuring information. Today, the table becomes the basis of most 

electronic documents, the structure of which can include a wide variety of HTML elements. Tables, 

originally chosen as a visual way of presenting data, now have a much more important function-managing 

the structure of the HTML document as a whole. The convenience of placing data in a table is undeniable, 

and the advantages over other means of presenting information (for example, lists) allow us to consider 

tables as the fundamental structural element of any HTML document. 

However, the primary task of the table is still the representation of information data. Therefore, next 

we will talk about how to create tables correctly (for more information about tables used as the structural 

basis of HTML documents, see the section "Nested tables"). 

4.1. Creating simple tables 

The HTML structure of a table can contain many different tags and parameters, some of which are 

common, and some are used only in rare cases. 

The main container tag of the table is the <TABLE> tag, which requires the presence of a closing 

tag. Any table consists of a row (container tag <TR>, Table Row) containing a certain number of cells 

(container tag <TD>, Table Data). In principle, the <TD> tag is used to specify data in a table, and the 

<TN> tag (Table Header) is used to place headers in a cell. The difference between these two tags is the 

visual representation of data inside the table: by default, the text placed in the <TH> tag is displayed in bold 

with the center alignment type, and the text of the <TD> tag is displayed in a normal font with left 

alignment. 



The <TR>, <TD>, and <TH> tags may not have their own closing tags. However, it is still 

recommended to specify them to prevent errors that can occur when creating complex nested tables. The 

<TABLE> tag, as already mentioned, must have a closing tag. 

A table can consist of any number of rows (<TR>), each of which can include any number of cells (<TD>, 

<TH>). In this case, one row of the table cannot contain cells of another row. 

You can assign a title to a table using the <CAPTION> container tag, which is specified immediately 

after the <TABLE> tag (in principle, the location of the <CAPTION> tag is possible anywhere in the main 

table tag, except for the description areas of the series and cell tags, but this approach is not welcome in the 

specification). An example of the simplest table is given in example 5, respectively. 

Example 5. Example of a simple table 

<HTML> 

<HEAD> 

<TITLE >Example of a simple table< / TITLE> 

</HEAD> 

<BODY > 

<TABLE BORDER> 

<САРТION>Example of a simple table</CART > > 

< TR> 

<TN>Cell with title< / TN> 

<TD>Cell with plain text< / TD> 

</TR> 

</TABLE> 

</BODY> 

</HTML> 

§ 5. The creation of hyperlinks 

Reading books, we often see how the author, revealing a particular topic, refers to another section or 

even to a completely different printed source. There are millions of electronic documents on the Internet, 

often similar in subject matter and aimed at the same user audience. Switching to other documents is only 

possible due to the ability to link one HTML document to another using hypertext links. 

In fact, any hypertext link is a pointer to an address in the global network, which can be instantly 

accessed from the browser window. However, a successful click on the link is possible in two cases — if the 

resource referenced by the document exists and if the hyperlink structure is correct from the HTML point of 

view. 

The first factor is objective, independent of us, because the developer of an electronic document, 

once putting a link to an external resource in it, may not know that this resource has ceased to exist, or has 

moved to another address, or is temporarily closed, etc. 

The second factor belongs to the category of subjective, because only the Creator of the HTML 

document can depend on whether the user will be able to click on the link or it is made incorrectly. To avoid 

the latter, consider the structure and rules for describing hypertext links. 

5.1. The structure of hyperlinks 

Any hyperlink consists of two important parts: the reference pointer ("anchor" — from the English," 

anchor") and the address of the resource to which you want to make the transition. Externally, it is very easy 

to distinguish a hyperlink from normal text: when you hover the mouse cursor over the link, the pointer 

takes the form of a hand with an index finger, as if indicating that this text contains a hyperlink. The link 

itself is underlined (if the pointer is text). 

Text (a single word, phrases, or even entire pages of text) and graphic images can act as a link 

pointer. In some cases, it is possible to combine graphics and text within a single link pointer. 

The link pointer is described by the <A> tag, and the transition address is implemented using the 

HREF parameter, the value of which is the path to a particular Internet resource (the closing </A> tag is 

mandatory). The simplest hyperlinks are shown in figure 5 and example 6. 

Example 6. Example of the simplest hyperlink 

<HTML> 



<HEAD> 

<TITLE>Example of the simplest hyperlink< / TITLE> 

</HEAD> 

<BODY BGCOLOR="#FFFFFF" TEXT="black" LINK="#FFOOOO" ALINK="#FFOOOO" VLINK="blue"> 

<FONT COLOR="gray" SIZE="6"> Adobe Photoshop</FONT> 

<HR COLOR="#003366" WIDTH="90%" ALIGN="left"> 

<P> <FONT FACE="Tahoma", "Verdana" SIZE="4"> 

One of the most popular and widespread image editors is the program for working with bitmap graphics Adobe Photoshop, 

developed by the Corporation <a HREF="http://www.adobe.com" ><B>Adobe 

Systems</B></A>. The program version 7.0 is currently available.< / FONT> < / P> 

</BODY> 

</HTML> 

Figure 5 

In the case where the link pointer is a graphic image, the path to the image that acts as a hypertext link is specified inside the 

container tag <A> (example 7). 

Example 7. An example of a hyperlink using a graphic as a pointer 

<HTML> 

<HEAD> 

<TITLE>Example of a hyperlink using graphics as a pointer< / TITLE> 

</HEAD> 

<BODY BGCOLOR="#FFFFFF" TEXT="black" LINK="#FFOOOO" ALINK="#FFOOOO" 

VLINK="blue"> 

<P ALIGN="CENTER"> 

<A HREF="http://www.adobe.com/"> 

<IMG SRC="http://www.adobe.com/images/adobe.gif" WIDTH="24" HEIGHT="31" 

ALT="Adobe Systems" BORDER="0"> </A> 

</P> 

</BODY> 

</HTML> 

Please note that the value of the border parameter of the picture BORDER is zero, otherwise the 

browser interprets the image as a link pointer and puts a frame around the picture. 

Graphics 

It is difficult to overestimate the possibility of using graphics in an application to any type of 

publication, including for Web documents. Without illustrations, the document is monotonous, sluggish and 



boring. Carefully selected and correctly placed graphics in the document make it visually more attractive 

and, most importantly, conveys one of the main ideas of the document. 

Images help to better convey the essence and content of the document. However, everything needs a 

sense of proportion. This rule is once again confirmed when viewing a number of Web pages. Quite often 

there are Web documents cluttered with background images, expressionless graphics and annoying 

animation. When planning to place an image on your page, make sure that it is really necessary. If you can 

easily turn the page when viewing printed materials, then Web documents often have to wait for the end of 

its loading in order to move on. Cluttering up graphics is just as bad as not having it at all. 

Images on Web pages can be used in two ways: as a background image that contains elements of the 

main document, and images that are embedded in the document. Next, we will consider the features of using 

these and other images. 

Ways to store images 

Looking at the image on the monitor screen, you actually see a large number of colored dots (pixels), 

which, when put together, form a certain picture. It follows that the image file should contain information 

about how to represent this set of points on the screen. There are many ways to describe graphic 

information, respectively, there are a significant number of formats for storing graphic files-about several 

dozen. 

All formats for storing graphic information can be divided into two types: vector and raster. 

Vector graphics files contain mathematical data on how to redraw an image using segments (vectors) 

when displaying it on the screen. The output process requires additional processing, but this representation 

of graphical information has an important advantage: the image scale can be changed without loss of quality, 

since there is no fixed relationship between how it is defined in the file and the output of points on the 

screen. When scaling bitmap graphics, there is usually a loss of resolution, which degrades the image 

quality. 

Vector graphics are usually used for images with clear geometric shapes. An example of its application 

is computer-aided design (CAD) systems. Information for some font types is stored in vector format. Raster 

graphics involve storing data about each point in the image. To display raster graphics, no complex 

mathematical calculations are required, just get data about each point and display it on the screen. 

<BODY BACKGROUND=texture.gif BGCOLOR=gray> 

In the vast majority of cases, web pages use raster graphics in two formats: GIF and JPG. These two 

formats are directly supported by popular browsers, and you will need special tools to use most other image 

formats. 

The BMP format is an MS Windows standard and is supported by the Internet Explorer browser, but its 

use cannot be recommended, since this format does not support data compression. 

Background images 

Web page developers can control the background color of the document, as well as specify the images 

used as the background. The idea of using background images is well known to users of the Windows 

system, which provides a number of options for changing the parameters of the desktop (desktop). In this 

system, both a solid color and a background pattern or pattern can be specified as desktop display 

parameters. 

In many ways, the background settings for HTML documents are configured in the same way. To set 

the background color, the BGCOLOR parameter of the <BODY> tag is used, and the background image is 

included in the document using the BACKGROUND parameter. The value of the BGCOLOR parameter is 

the name of the color or its components in hexadecimal code. A GIF or JPG graphic file should be used as 

the background image. 

The background image for an HTML document always fills the entire viewport (unlike the Windows 

desktop, where the image can not be replicated). If the image size is smaller than the size of the viewport, it 

will be multiplied by the mosaic principle. Therefore, background images should be created so that when the 

borders of the crosslinking of repeated images appear on the screen, they are invisible. This task resembles 

the selection of a drawing when wallpapering the walls of a room. 

Usually, a small image is taken as the background image, which does not take much time to load over 

the network. There are huge collections of images (textures) that you can use when developing your own 

HTML documents. 



Another commonly used option is a background image in the form of a pale embossed logo. Such 

graphics clearly identify the site and do not interfere with the perception of the material. 

Here is an example of writing a <BODY> tag with a background color and a background image: 

Note that setting the BACKGROUND and BGCOLOR parameters at the same time is not necessary. 

Any of them, as well as both together, may be missing. 

At first glance, it may seem that specifying a background color is unnecessary when setting a 

background image. In reality, the opposite is true. You can recommend that you always specify the 

background color of the document if you are setting a background image. The fact is that when loading a 

document, the text part is displayed first, and the next pass will load images, including the image used as the 

background. Until the background image is loaded and displayed, the background color of the document will 

be determined by the value of the BGCOLOR parameter or set by default. Experience with HTML 

documents received over the network shows that sometimes a sufficient amount of time passes before the 

background image is loaded, during which the user gets acquainted with the already loaded text. At some 

point, the background image appears, changing the color gamut of the document. To prevent sudden changes 

in the color gamut, set the background color value close to the background image colors. 

When choosing the background color and the nature of the background image, you should not forget 

about the need for contrast between the text and background color. An unfortunate color ratio can make it 

difficult to read the text. 

There is another reason why setting the background color of a document should be recommended. 

The user can disable the uploading of pictures. In this case, the background image will also not be loaded. 

Background images can be used not only for the entire document. For example, many browsers allow 

you to set background images for individual table cells. 

Embedding images in HTML documents 

To embed images in an HTML document, use the <IMG> tag, which has the only required SRC 

parameter that defines the URL of the image file. The simplest example of embedding an image: 

< IMG SRC=picture.gif> 

This tag can have a number of parameters, which are discussed below. 

The alignment of the images 

Value of the ALIGN 

parameter 
The influence of the parameter 

TOP 
The upper border of the image is aligned to the highest element of 

the current row 

TEXTTOP 
The upper border of the image is aligned with the highest text 

element of the current line 

MIDDLE Aligns the middle of the image to the baseline of the current line 

ABSMIDDLE Align the middle of the image to the middle of the current line 

BASELINE или 

BOTTOM 

Aligns the lower border of the image to the baseline of the current 

line 

ABSBOTTOM 
Aligns the lower border of the image to the lower border of the 

current line 

LEFT 
The image is pressed against the left margin of the window. Text 

wraps around the image on the right side 

RIGHT 
The image is pressed against the right margin of the window. Text 

wraps around the image on the left side 

 

Table 3 

Let's explain the effect of the alignment parameters given in the table. Immediately make a reservation 

that all the values of the image alignment parameters can be divided into two groups according to their 

principle of operation. Two parameter values belong to the same group — LEFT and RIGHT. When using 

any of these parameters, we get a so-called "floating" image. In this case, the image is pressed against the 

corresponding edge of the browser viewport, and the subsequent text (or other elements) "flow around" the 

image from the opposite side. Here, the text placed next to the image can take up several lines. 



The other group of parameter values includes all the others. When using them, the image is embedded 

in a line of text, and the alignment parameters set the location of the image relative to the line of text. Thus, 

in contrast to the floating images, here the image is a normal line item. This is easy to understand if you 

imagine that the image is just one letter of a line of text, although it is quite large (like a letter cap). 

Here is an example of HTML code in which images are used as a string element (example 31, figure 

27). 

Example 31 

<HTML> 

<TITLE> Image alignment < / TITLE> 

<BODY> Alignment <IMS SRC=bouquet.gif ALIGN=top> no top edge 

< P> Alignment no < IMG SRC=bouquet.gif ALIGN=BASELINE> baseline 

</BODY> 

</HTML > 

Figure 6 

Here is an example of a floating image.(example 32, figure 28). In the example, the image is pressed to 

the right edge of the browser viewport, and the subsequent text is located on the left side of the image. The 

number of lines placed next to the image may vary depending on the font size of the text, as well as the size 

of the viewport. Text that doesn't fit next to the image automatically continues below.  

The "mind Map" method. Students are divided into subgroups. A topic is announced and each team 

is given a separate concept related to this topic. Each team will have to describe this concept in the form of a 

diagram and one or more team members will have to explain their scheme to the auditor. 




